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Welcome

Welcome to Allplan 2014, the high-performance CAD
program for civil engineers.

In this tutorial workbook you will learn about the most
important functions in Allplan 2014’s main modules.

You will find that within a short time, you will be in a
position to use Allplan 2014 effectively in your daily
work.

This chapter covers the following:

Content of this tutorial
Documentation for Allplan 2014
Additional help on Allplan 2014

Where to turn for training, coaching and project
support
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Introduction

The Engineering Tutorial expands on the Basics Tutorial. Based on 6
examples, the Basic Tutorial explains the principles of 2D drafting
and design. In addition, you learn how to get started in 3D modeling.
The aim of the Engineering Tutorial is to guide you with easy to
follow steps from floor plan design to key plan generation to fully
automatic creation and management of reinforcement drawings in
3D. It consists of 9 exercises, which are divided into 5 units.

This tutorial will provide you with a sound introduction to Allplan
2014. As it only touches on the possibilities of some of the tools,
please consult - especially later when you work with Allplan 2014 -
the F1 help as an important source of information.

You can download two projects from the Allplan Connect website:

e A project with the structures and settings (but not the design!)
used in this tutorial.

e The finished project with all the data so that you can compare the
model you created yourself with the model provided.

Please refer to Unit 1: Basics, Installing the Project (see "Installing
the project” on page 8) for information on installing. To find out
how to download the projects from Allplan Connect, see the section
Training projects on the Internet (on page 316), which you can find
in the appendix.

This tutorial also assumes that you have a working knowledge of
Microsoft® Windows® programs. Basic CAD-knowledge is helpful;
however, this tutorial will provide both the experienced CAD user as
well as newcomers to CAD with a solid foundation in the methods
employed by Allplan 2014.
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Sources of information

The Allplan documentation consists of the following:

The help is the main source of information for learning about and
working with Allplan.
While you work with Allplan, you can get help on the current

function by pressing the F1 key, or activate (E Help on the
Default toolbar and click the icon on which you require help.

The Manual consists of two parts. The first part shows how to
install Allplan. The second part is designed to provide an
overview of basic concepts and terms in Allplan as well as
introduce approaches for entering data in Allplan.

The Basics Tutorial guides you step by step through the most
important tools for designing and modifying elements in Allplan.

The Architecture Tutorial guides you step by step through the
process of designing a building. In addition, you learn how to
analyze the building data using reports and to print the results.

The Engineering Tutorial guides you step by step through the
process of creating key plans, general arrangement drawings and
reinforcement drawings and shows you how to print the results.

New Features in Allplan provide information on what’s new in
the latest version.

Each volume in the Step-by-Step series deals with a specific
concept or series of tools/modules in Allplan in detail. The areas
covered include data exchange, system administration, geodesy
modules, presentation modules, 3D modeling etc. As a
Serviceplus member you can download these guides as PDF files
in the Learn - Documents area of Allplan Connect
(http://connect.allplan.com).


http://connect.allplan.com/
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Additional help

Tips on efficient usage

The ? menu includes Tips for efficient usage. This topic provides
practical tips and tricks showing you how to use Allplan efficiently
and how to carry out operations with ease.

User forum (for Serviceplus customers)

Allplan forum in Allplan Connect: users exchange information,
valuable tips relating to everyday work and advice on specific tasks.
Register now at

connect.allplan.com

On the Internet: solutions to frequently asked questions

You can find solutions to numerous questions answered by the
technical support team in the comprehensive knowledge database at
connect.allplan.com/faq

Feedback on the help

If you have suggestions or questions on the help, or if you come
across an error, send an e-mail to:
Dokumentation@nemetschek.de
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Training, coaching and project support

The type of training you are given is a decisive factor in the amount
of time you actually spend working on your own projects: a
professional introduction to the programs and advanced seminars for
advanced users can save you up to 35% of your editing time!

A tailor-made training strategy is essential. Nemetschek’s authorized
seminar centers offer an extensive range of programs and are happy
to work out a custom solution with you that will address your own
needs and requirements:

e Our sophisticated, comprehensive seminar program is the
quickest way for professional users to learn how to use the new
system.

e Special seminars are designed for users who wish to extend and
optimize their knowledge.

e One-on-one seminars are best when it comes to addressing your
own particular methods of working.

¢ One-day crash courses, designed for office heads, convey the
essentials in a compact format.

e We are also happy to hold seminars on your premises: These
encompass not only Allplan issues but include analysis and
optimization of processes and project organization.

For more detailed information on the current training program,
please consult our online seminar guide, which can be found on our
homepage (http://www.nemetschek-training.de).

You can also contact us for full details

Phone: 0180 1 750000
Fax: 0180 1 750001


http://www.nemetschek-training.de/

6 Feedback on the documentation Allplan 2014

Feedback on the documentation

We are always trying to improve the overall quality of our program
documentation. Your comments and suggestions are important to us
and we welcome feedback on the manuals and online help.

Please do not hesitate to contact us to express criticism or praise
concerning the documentation. Feel free to contact us as follows:

Documentation

Nemetschek Allplan Systems GmbH
Konrad-Zuse-Platz 1
81829 Munich, Germany

Phone: 0180 1 750000
Fax: 0180 1 750001
Email: Dokumentation@nemetschek.de
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Unit 1: Basics

In this unit, you will install the Engineering Tutorial
(without model) project, start Allplan and make a few
basic settings.

The Engineering Tutorial (without model) project, which
you can download from Allplan Connect, comes with a
fileset structure consisting of structural levels and
assigned drawing files.

The project provides four print sets that control the
visibility of different layers. While editing the project,
you will use the different print sets in various places.

Thanks to this project you can start designing the
building at once without any preparatory work.

If you want to create the project along with the fileset
structure and print sets yourself, you can find a detailed
description of the necessary steps in the appendix (on
page 279) to this tutorial. The appendix also provides
further information on various interesting topics such as
"Using layers”, "ProjectPilot”, "Palette configuration” and
much more.

If you do not want to work through the entire tutorial
step by step, you can download the data of the finished
project - Engineering Tutorial (with model) - from
Allplan Connect. This project contains the drawing files
at different levels of completion so that you can get
started wherever you want. For example, you can
immediately start placing the reinforcement.

You can find information on how to download the
projects in the appendix; see "Training projects on the
Internet (on page 316)”.
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At the end of this unit, you will find a short
troubleshooting section which can be helpful in using
Allplan.

Installing the project

After having installed and configured Allplan 2014, you can install
the Engineering Tutorial project (with or without model).

To install the project

S Allplan 2014 must be installed, registered and correctly
configured. After having installed Allplan, you need to start it at
least once and check whether it works properly.

2 You have downloaded the Engineering Tutorial project data from
Allplan Connect (http://connect.allplan.com) into a folder of your
choice and extracted there.

1 Close any applications that are running.

2 Double-click the extracted application and click Run in the dialog
box.

3 Click Next > to acknowledge the Welcome screen.

4 Read the license agreement carefully and accept it. Click Next >.


http://connect.allplan.com/
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Setup for Training project Allplan 2014 Tutorial Engineering

License Agreement
Please read the following license agreement carefully.

General

Systems GmbH, Munich [hereinafter "Nemetschek"). The conditians are final. Other
shall not be used for interpreting the conditions.

1. Temes of Use

secret,

1.2 Software iz only left to acquirer as object code on machine-ieadable data carriers
Memetschek shall not be obliged to surmender the source cods to acquirer,

presenting, demonstrating and publishing it

The subject matter of the conditions is the licensing of software from Memetschek Alplan

conditions that are applied tagether with theze within the scope of the contractual relationship E

1.1 Acquirer acknowledges that the software and the user documentation can be protected
by copyright. &part from that, acquirer acknowledges the software as Memetschek s rade

1.3 Memetschek grants acquirer the simple, non-exclusive and temporarily unlimited right to
duplicate the acquired software within the scope of the legal admissible limits if the relevant
duplication is necessary for using the software. The necessany duplications of a single-user
license include the installation of the software on the mass storage of the hardware used as
well a2 loading the software inta the relevant random access memory. IF acquirer changes the
hardware, they shall delete the saftware from the hardware used until naw. Nemetschek
particularly reserves the right to sub-icensing alzo within the scope of reselling the software,
processing - except for the regulations in points 3.1 and 3.2 -, letting, distributing, exhibiting,

o ) (¥ | accept the terms of the license agresment Erint:
L.+ Allplanzo1
" | do ot aceept the terms of the license agreement
< Back. Next » Cancel
5 Enter your name and that of your company.
Click Next > to confirm.
Training project for Allplan 2014 Engineering Tutorial - Setup @
Customer Information
Please enter your information.
Pleage enter your name and the name of the company for which you work.
User Narne:
Company Mame:
|
%, Allplanzo14
£ Back Nest » Cancel
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6 Finally, click Finish.

Training project for Allplan 2014 Engineering Tuterial - Setup

InztallS hield Wizard Complete

The training project for the Allplan 2014 Engineering Tutorial has been installed successfully.

Wi wish you much success when working with the
training project Allplan 2014 Tutorial Engineering.

{ #Allplan2z014

Cancel

< Back

Starting Allplan and opening the project

You have installed Allplan 2014 and the training project on your
computer. Now you want to start working on the project.
First start Allplan 2014.

To start Allplan and open the project

1 Open the Windows start menu and point to All programs,
Nemetschek, Allplan 2014 and click i:h Allplan 2014.

Or
Double-click the desktop icon.
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2 After having started Allplan 2014, you can open the project
straight form the Welcome screen. Click the corresponding tool.

5 #Allplan 2014

MOST RECENT PROJECTS

l . Engineering Tutorial {with model) @,

CREATE PROJECT

PROJECT COPY . I .
OPEN PROJECT . .

= = B First Steps @ Hotinfo - Support Tool
ik MIE_I.?.!,’_,EL o Allli'-_l_ﬁ-_',—"_._.‘=_-i blm * New Features in Allplan Archite..C  Updates - Settings
% MNew Features in Allplan Engine...

Show this window at startup Aliplan MAIN_Localisation | Customer number; 123456789 | Seat 068

If you have switched off the Welcome screen, click 6% New
Project, Open Project on the Default toolbar.

3 In the New Project, Open Project dialog box, select the
Engineering Tutorial project and click OK.

The project opens. This can take some time ,as Allplan first needs
to update some project settings.
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Allplan 2014

Initial Settings

Start by making the following toolbar settings:

Settings in the Tools palette

For the first exercises, you will use the tools in the Basic: Walls,
Openings, Components module. Select this module in the Tools

palette.

Settings in the Tools palette for the following exercise

1 Select the Tools tab in the palette.

2 Select the (o) Architecture family on the drop-down menu.

3 On the right-hand side of the palette, select the tab for the

L Basic: Walls, Openings, Components module.

The Create and Change areas present the tools provided by the
Basic: Walls, Openings, Components module.

Toaols 1 x

Toals || Properti...| | Wizards | | Library | Connect | |Layers

@Ar(mtedure - p

Create Family

e @0 1
ﬁ Basic Walls, Openings, Components l

oz 4 0B |°

B ome - & %
>

& o B #F g

Abe 128 J&8f Ak 5

‘Change

A &l =l 2

¥ % B ¢ oA

e T

B ob
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4 There are different options for arranging the palettes on screen.
To reposition the palette window, click its top border with the left
mouse button and keep it pressed down:

File Edit View [nsert Format Tools Create Change Repeat Window 2

FEHLBEP H|&-4-

miEsXEE RS Qs e As

1

|~ 1NN - oEFAULT

\-geg\ E L

Tools

-
x

Tools [ Properties | [ Wizards || Ubrary |[ Connect |[ Layers |

(@ Architecture

Create

o
)

=

-

=
Change

" K
f» 4

B R E S

5

& ® & F

B K

= E
=

2

=

& e

=
le=

B¢

i23

d B W

& [

i

FwEnl| == v

J Click left to select, Ctrl+click to add, Shift+click to select entity group

k4w

He=2 A

1
=

w [ KEBSBERL S

i

[ < ME)al | &

Press F1 to get Help.

L% Mode: 7Menu  Drawing type: Scale definition

Scale: 1:100

Length: m

Angle: 0.000

deg

%

1
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5 Drag the window to one of the positions displayed.
An example:

File Edit Yiew Insert Format Jools Create Change Repeat Window I
|PELBEHR B 42 | —=aXBEED @|Fw Fos—I[:]1 [-| - oeralT - & §am
X = —
Tools | Properties || Wizards || Library || Comnect || Layers | El $
(@) Architecture [# %
Create 1%
Ot @ID s "i
_ g] i
I B IR BE - &S g I
i
S EF v o m i e 8l
» &
Hw & a @ W £
= At
&
[ 2
Rl 2% %S =
= &2 e P T B -
% ¥,
Ta,
&,
=,
=
v
i x|
J Click left to select, Ctil+click to add, Shiftsclick to select entity group 1
Press F1 to get Help. L% Mode: ?Menu  Drawing type: Scale definition Scale: 1:100 Length: m Angle: 0000 | deg % 1




Engineering Tutorial Unit 1: Basics 15

6 Release the left mouse button.

The palette window appears at the selected position.

- Engineeril al (wi - <No filesets ==
e
File Edit View Insert Format Tools Create Change Repeat Window 2

$ELRBSEE B &4 | onsXEBEPQ Ql$® Los—I | |- V|- oeFaT - &Y § s
Tools 7 x'?
Tools It Properties [ Wizards e Library 1l Connect [ Layers 1,
() Architecture -|& _1;
L=
Create Ik
PRIl sy I BOBEIEF &SI BEF ¢ ez m*‘-‘a‘
(Y
= EAHP S~ W a W 5
@
crange @l
%A = 2 YA RSEFATC GG j’;a
&
&
St
A
X
s
I
i
T,
,
=
=
v
@ =
J Click left to select, Ctri+click to add, Shiftsclick to select entity group ]

Press F1 to get Help. b Mode: 7 Menu Drawing type: Scale definition Scaler 1:100 Length: m Angle: 0000 deg %1

Note: You can use Hide automatically to show (@) and hide (@
) the palettes.

7 Position the palette window as you need.
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Track tracing

5+ Last paint

15?3 Additional point for offset

A Lock coordinate

¥ Point of intersection
# Midpoint

7 Center of arc

f Division point

h Base of perpendicular
< Offset by line

47 Offset by radius

K Point snap options
¢ Track tracing options

L

»

Track tracing facilitates the intuitive design process. As you will not
use this option in the following exercises, start by switching off track
tracing (which is on by default).

To switch off track tracing
1 Click 7 Line (Create menu - Draft module).

2 Click in the workspace with the right mouse button and select
£ 4 Track tracing options on the shortcut menu.

3 Switch Track tracing off.

Options

Paoint snap
Track tracing

==l
Track tracing
Track tracing (F11) %
Extension P
Qrthogonal track lines /"
Palar track lines e
b
Parallel line /
Assumed point of intersection b
Track tracing representation
Time limit for track point
Size of CursorTips for track points + 7z X
f CursorTips
Switch be

Note: You can quickly enable and disable track tracing at any
time while entering points by pressing the F11 key or clicking the

A" Track line icon in the dialog line.

4 C(Click OK to confirm the settings and press ESC to quit the tool.
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Layer settings

Tip: As Match is selected on
the Format Definition tab
(this is the default setting),
you can select the From
layer, line style check boxes
in the Layers' format
properties area.

The layer structure of this project is set to Project. All the settings
you make, therefore, will apply to this tutorial project only.

The office standard is thus unaffected by any changes. You will
probably use the office standard in your daily work. The office
standard’s settings are defined by the Allplan administrator and
apply to the entire office.

Allplan 2014 provides a very extensive layer structure designed to
meet a broad range of requirements.

You can also define your own layer categories/hierarchies and
layers. For this guide you will be using the layers in the main
architectural and engineering categories.

You can specify whether the format properties (pen, line, and color)
are based on your custom settings, whether these properties are
proposed by the program and displayed on the Format toolbar (you
can modify them at any time) or whether these attributes are always
taken from the relevant layers (from the line style or the setting
assigned to the layer).

For the exercises in this tutorial, you will configure Allplan to select
the layer automatically with the tool. Furthermore, you will work
independently of the predefined layer format properties and define
these settings while drawing.

To check the basic settings for layers
1 Click 2 Select, Set Layers (Format menuy).
The Select Layer/Visibility tab is open.

2 If necessary, clear the check boxes in the Layers’ format
properties area.

3 Make sure that the Auto-select layer with tool check box is
selected in the Settings area.
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4 In addition, make sure that Display elements on frozen layers
using a fixed color and color 25are selected.

Layer - 8 %

Select Layer/Visibilty || Print Set | | Privilege Set | | Format Definition | | Layer Structures

i =2 5l || 4 | Priviege set: 5 ALLPLAN -

| Status Short name Drawing type: Scale definition -
e DEFAULT )

»  ARCHITECTURE Contents of st bax

b ENGINEERING List layers assigned to cumently selected tool

b BUILDING USING EXISTING STRU

b PRECAST ELEMENTS List layers used in open documerts

b HALLS (®) List entire layer hisrarchy

b STEEL CONSTRUCTION

b TIMBER CONSTRUCTION | Show modffiable layers

b CAD AUTHORITY BAVARIA ] Show visible, frozen layers

b ALLPLAN INTERNAL ’

| Show hidden, frozen layers

Layers format properties (project setting)

= Pen From layer, line style

&= Lne From layer, line style

( Calor From layer. line style
Modify status Settings
D Cument | Auto-select layer with tool
| Modfiable

+ | Display elements on frozen
D Visible, frozen layers using a fixed color

D Hidden, frozen
25 | = Color

Vg @ Q} Cancel

iy

Note: You can use the db, = and ¢~ buttons at top left to expand
and collapse the tree structure of the layers and to find specific
entries.
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Sometimes, things will not immediately work out as required. This
list helps you succeed.

What if ...

e ... I have selected the wrong tool?
Press ESC and click the correct icon.
e .. I make a mistake as I go along?
Press ESC to quit (several times if necessary).
Click <A Undo.
e ... I have inadvertently deleted the wrong elements?
If 2& Delete is still active, press the right mouse button twice.
If no tool is active, click 4"'\ Undo.
e ... I have unintentionally opened a dialog box or entered wrong
values?
Click Cancel.

And what if..

e ... the workspace is empty but you are sure the drawing file
contains design data?
- Click 2% Zoom All at the bottom of the viewport.
- Click 2! Plan.

e ... the workspace is suddenly divided into a series of different

Tip: Check whether the
relevant layer is set so that it
is visible.

viewports? o
On the Window menu, click EUR Viewport.

e ... specific kinds of elements such as text or hatching do not
appear in the workspace?

Click El Show/Hide (Default toolbar) and check that the
elements in question are selected.
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Allplan 2014
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Unit 2: Floor Plan and
General Arrangement

Drawing

In this unit, you will learn how to create general
arrangement drawings quickly and efficiently.

You will use the tools in the U Basic: Walls,
Openings, Components module to create a 3D
building model of a basement. You will also learn
about viewports.

As an alternative, you will create a floor plan of a
basement in 2D using the tools in the Uk Draft
module.

Using the tools in the ® 3D Modeling module, you
will create a three-dimensional general arrangement
drawing of an elevator shaft.

As an alternative, you will create the same 3D general
arrangement drawing using the tools in the Lt Basic:
Walls, Openings, Components module.

You should work your way through these exercises step
by step These form the basis for subsequent exercises in
units 3 and 4.
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Overview of exercises

Exercise 1: floor plan of basement and viewports
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You will draw a basement in 3D using the tools in the L Basic:
Walls, Openings, Components module and in 2D using the tools in

the 1N Draft module.
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Exercise 2: 3D elevator shaft
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You will draw an elevator shaft for the basement created in exercise
1 using the tools in the ﬁ) 3D Modeling module. As an alternative,

you will use the tools in the e Basic: Walls, Openings,
Components module.
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Exercise 1: floor plan of basement

Requirements:

Allplan 2014 Engineering comes in different module packages.

Open the Tools palette and check whether the (@ Architecture
family includes the following module(s):

L Basic: Walls, Openings, Components

In this exercise you will create a floor plan for a basement.

You will mainly use the tools in the L Basic: Walls, Openings,
Components module. You can access these tools in the Tools palette,
Create and Change areas.

You will also learn about viewports.

Finally, as an alternative, you will create the walls of the basement
in 2D.

Start by selecting fileset 1 with the following drawing files:

Fileset Drawing Drawing file name
file number

1 101 3D floor plan
102 2D floor plan
103 2D stair
104 Dimensions and labels
105 Hidden line image
110 Key plan

You can find the fileset in the 'Engineering Tutorial’ project (see
”Appendix: creating the training project”).
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Creating the 3D model using the Basic: Walls, Openings, Components
module

If you have not licensed the (e Basic: Walls, Openings,
Components module, create the floor plan in 2D (on page 75),
dimension (see "Dimensions” on page 62) it and create the stair (on

page 66).
Tools Objective:
[ wal A TIPSR

S0, 10 ww, F s, up hn w, 2e
@ s @ )

#l| Join Linear Components

2 1w
3 100
1

Column

593

14
5%

6%

Downstand Beam,
Upstand Beam

Lk Door
,[El Window

fJ Hidden Line Image,
Wireframe

Slab -
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Recess, Opening in Slab

[al 3 Viewports

View Type: Hidden Line
Image

7= Save, Load View
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Settings

Start by making initial settings.

To select a drawing file and set options

> Open the Tools palette and check that the L Basic: Walls,

Openings, Components module (Architecture family) is selected.

Click sl Open on a Project-Specific Basis (Default toolbar),
open the drawing file tree for fileset 1 by clicking the triangle
symbol beside the name of the fileset and double-click drawing
file 101.

Check the current Scale (1:100) and Length (m) in the status bar.
If necessary, enter these values.

Click 9{ Options (Default toolbar) and select the Components
and architecture page on the left.

Check that the Fixed pen for surface elements of archit.
elements check box is selected in the architectural settings across
modules and click OK to confirm the dialog box.

Options

Desktop environment

Animation
Pen colors
Import and export

Catal

Srr

t symbols and symbols
Planes

Compoenents and architecture
Rooms

Reinforcement

£ Architectural settings across modules

Components

Element interaction [l | Dynamic -
Intersect architectural elements Despite different height settings

Properties from the Format toolbar [} In addition to settings in dialog box

Also apply to multi-layer components
Fixed pen for surface elements of archit. e\e‘rent( 018 } -

Labels Update automatically

Components in 3D Display with line type 1
Lines where components intersect [ Display

Display junction lines, division lines between [ Different material names
®) Different surface elements

5 Select Show/Hide (Default toolbar) and select the Color

stands for pen option.
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Walls

Note: When you are working with the tools in the architectural
modules, you are effectively working in three-dimensional space. To
define the position of a component (wall, door, window etc.) in
space, you require the height of the component’s top and bottom
levels. Here, you will use absolute values to specify the height.

You will use the following settings for the basement in the building:
The finished floor covering of the floor slab is at a height of -2.70
m. You are working with unfinished dimensions. As a result the
unfinished floor is at -2.79 m and the bottom of the floor slab at -
0.31 m.

Note: You define the position of a wall by entering its start and end
points. In addition, you need to specify its offset direction relative to
an imaginary line between the start and end points.

You need to enter a wall thickness, which is important for the wall
to be displayed to scale. A hatching style, fill or style area can be
applied to intersected walls.

You need to enter the height so that Allplan 2014 can generate a
three-dimension model based on the floor plan. You can also specify
additional parameters such as a material and building trade.

This exercise involves creating the walls in the basement. Quantity
takeoff is ignored. It is therefore enough if you just define the
thickness and height of the wall and select a style area.
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Tip: When setting the wall's
Priority rating:
thickness of wall in mm.

Start by defining wall parameters.

To set wall parameters
1 Click Ej:] Wall (Tools palette, Create area).

2 On the Wall Context toolbar, click M Properties. The Wall
dialog box opens.

3 Enter the following information:

e In the Setup, number of layers area, enable wall type 1: wall
with a single construction layer.

e In the axis preview, move the component axis to an edge of
the wall.

Note: The position of the component axis controls the wall’s
offset direction. The component axis can be on a side of the wall
or anywhere within the wall.

4 Enter the following information for layer number 1 in the
Parameters, attributes tab:

e The Thickness is set to 0.300. Do not change this value.

o C(lick the value displayed for Priority, click =F in the list box,
enter 300 and click OK to confirm. (This selects 300’ and
adds it to the list.)

Note: The priority rating controls the manner in which
components intersect. Components with a lower priority rating
have a ’hole’ cut in them where they are intersected by other
components. This ensures that these areas are not counted twice
in subsequent quantity takeoff operations.

e For the calculation mode select: volume.
e Set Interaction to dynamic.

e Enable the Auto-Join check box.
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The Wall dialog box should now look like this:

Wall

Setup, number of layers

) ([ (5 @ (s

Modification mode

Preview

Layer no. ThicknessPosition
0.3000 I : 10,3000

B
Tot. thidkn.: 0.3000 [~

Height of layer 1: 2.5000

Cmmd ® =

Parameters, attributes | (Format properties | [ Surface elements | | Total |

Alllayers same settings: [ |Height [ |Trade [ |Priority [ ] Calculation mode Interaction [+ Auto-join

Mumber Thi...  Hei.. E Material jqualities Trade Priority | Calc. m... = Interaction Auto...
1 0.3000 2.5000 T_?_ Concrete - 300 m3 dynamic ]

Catalog assignment: Total wall: Attributes...

P |' Reduce << H Cancel

5 Set pen 0.50 in the Format Properties tab:

Parameters, attributes || Format properties |[Surface elements | | Total |

All layers same settings: | |Pen [ |Line [ |Color [ |Layer

Number = Pen E Line O color 2 Layer

B surface (animation)
1 0.50

1 — 1 I AR _VALL a -—-

Note: The settings on the Format toolbar have no effect on the
format properties of walls.

6 Enter the following information in the Surface elements tab:

o Select the Style Area option.
301 Reinforced concrete is selected. If it isn’t, click the name
of the style area and select number 301.
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The Surface elements tab should now look like this:

Parameters, attributes | [Format properties || Surface elements |[ Total

+'| Show surface elements in plan view

MNumber % Hatching E‘E‘ Pattern &y Fil Bitmap Area ;/4{ Style Area
1 [m] J— [m] J— [m] J— O -—— 301 Reinforced concrete

Tip: The parameters you set in 7 Now click the Height... button and set the height. Enter the top
this dialog box are valid until and bottom levels of the wall as absolute values. Click the
you change them. relevant elevation icon.

. e Top level of wall (= bottom of slab): -0.31.

e " Bottom level of wall (= top of floor slab): -2.79.

Height (=234

Top level Preview
RN " 2
iT|€‘|? A Default TL 25000
Elevation point -0.3100

™ = +
[N | r-\
:
‘; BL

Bottom level

2 IMF=E

=\,

Elevation point -2.7900 Default BL 0.0000

Cancel

8 C(lick OK to confirm the Height and Wall dialog boxes.

Entering data in property sheets

Tip: For more information on To enter a value, click in the data entry box. Enter the value at the
the Wall tool, press keyboard and press ENTER.
F1 To enter and add values in custom list boxes, click '=II]:' first.

This will display the relevant To apply entries, click OK.

topic in the Allplan help. To discard entries, click Cancel or press ESC.
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Component axis

Components are entered along their component axis. The wall’s
direction of extension depends on the position of the component
axis, the direction in which the wall is entered and the position of
the first construction layer in the wall.

Click e e Rotate about axis (Wall Context toolbar) to change the
wall’s direction of extension.

You can position the component axis as follows:

e Centered in or on the sides of the entire component (wall as a
whole)

o Centered in or on the sides of the each construction layer
e At a freely definable distance to a component edge (wall edge)

Small boxes in the preview indicate the positions you can select.

+® ©

% :

A Component axis
B Possible positions on the sides of/centered in the layer or entire wall
C Number of layers

You can place the component axis in several ways:

e Intuitive
Use the mouse to move the axis: the cursor becomes a double
arrow, and the component axis will snap to the positions marked
by small black boxes. The values displayed on the left of the
preview show the distance to the edges.
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Tip: Using the offset
direction, you can quickly
toggle between inner and
outer dimensions when
entering walls.

e Centered in or on the sides of a construction layer or of the
entire wall/upstand
In the Position column, click the icon of the construction layer or
of the entire wall/upstand in which you want to position the axis
and select a position. The values displayed on the left of the
preview show the distance to the edges.
"+ Left edge of component or layer
£ Right edge of component or layer

Center of component or layer

3L Custom (with Total wall only)

e Custom position based on numerical value
Click one of the data entry boxes on the left of the preview area
and enter any value defining the offset of the axis to the wall
edge. The program automatically calculates the value for the

other side and displays the al Custom icon in the Total
thickness area.

Offset direction of components, single-layer walls

Components are entered along the component axis. Depending on
the axis’ position within the component, you can use the offset
direction to specify on which side of the component axis (relative to
the direction in which the component is entered) the component is

drawn. With ¥%7= Reverse offset direction, you have the option to
"tilt” the wall or to reverse the setup of the construction layers.

The direction is indicated by an arrow and the position of the first
construction layer. You can activate and deactivate these symbols

using the Symbols when entering walls option in the 2 4 Point snap
options, Point snap representation area.
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Depending on the position of the component axis, the following
options are available:

e Single-layer wall, lateral component axis:
®

a1
/’/QD

e

©

Start point of component

End point of component

Component axis

Offset direction

Direction in which component is entered

NwW»N ~—

After clicking ==%= Reverse offset direction:

Start point of component

End point of component

Component axis

Offset direction

Direction in which component is entered

D= TSN

o Single-layer wall, centered component axis:
Clicking === Reverse offset direction does not make any
difference.
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Tip: You can change the
component axis at any time
while entering elements using

shortcut keys or #%% in the
dialog line.

When all the parameters have been set, you can draw the walls. In
this exercise, the values are outside dimensions. Therefore, the wall’s
offset direction is towards the inside.

To draw exterior walls
1 Choose the wall type by clicking / Straight Component.

2 Set properties, place start point
Click where you want the wall to start.

The wall is attached to the crosshairs. Check that track tracing is
off. If it isn’t, the start point is marked with a cross. If necessary,
switch track tracing off by pressing the F11 key.

3 Check and define the wall’s offset direction:

e In the Wall dialog box, you have defined a lateral wall axis.
The axis of a straight wall is simply the line you enter.

e The values are outside dimensions (see illustration below).
Start by drawing a horizontal wall at bottom left.  As the
start point is on the outside, the wall’s offset direction is
upwards (= towards the inside).

e Check the preview displayed with the crosshairs. The small
arrow should point upwards (= towards the inside).

e If this is not so, click == Reverse offset direction on the
Wall Context toolbar to reverse the wall’s offset direction.

Enter a value of 3.51 for the &% X coordinate in the dialog line.

The other walls will join automatically when you create them in
the same way as polylines by entering dX and dY values in the
dialog line.
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5 Enter the following values:

Ayay. 10 Axgx . 519

Ay gy —10 Axgx . 4505

Ay gy . 16.45 Ax gx . _3.205

A&yay: 10 Ax gx . _3.275

Ay gy —10 Ax gx . _3.275

Ayay. 10 Ax gx . _3.45

Ay gy . _g.375 Axgx . _1.2

Ay ay . 30 Axgx . 1.2

Ay gy . -6.075
Tip: If you can't see the whole R 345 4 327 ; 1275 4 10—t
drawing, click + — +
E Zoogm All at the bottom ‘ ”””””‘;’””””””Ilj’””””””:””””””
of the viewport.

+1204:' :

3.00

<

NN

6.07°
NNANS

N

A

LTI 77 7
pe Lz ””m Vﬂz I ‘bmmmm Z

2 + 351 + 5.19 + 4L.50° +

A Wall’s offset direction

6 The wall polyline closes automatically.
Press ESC to quit the i Wall tool.

+ 100+

16.45
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Draw the interior walls using different thickness and priority rating
settings than those of the exterior walls. The height of the wall is the
same.

To draw interior walls
2 The L Basic: Walls, Openings, Components module is open.
1 Double-click an exterior wall with the right mouse button.

This activates the i Wall tool and gets the element’s properties
at the same time. The association with the planes (for the height,
for example) is no longer necessary.

2 Choose the wall type by clicking i Straight Component.
3 Change the Properties as shown.

e In the Parameters, attributes tab:
Thickness (m) = 0.24
Priority = 240

e In the Format Properties tab:
Pen thickness (2) = 0.35 mm

Then click OK to confirm.

4 Set properties, place start point
Draw the first horizontal interior wall by placing the start point
on the bottom left wall corner (see illustration below) of the
stairwell area. Check the wall’s offset direction in the preview

and, if necessary, change it by clicking =%~ = Reverse offset
direction.

5 Enter a value of 5.815 for the 2% X coordinate. Then enter 2.40
for the &Y Y coordinate.

)

dY = 2.40

% dX = 5.815
4

7
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Tip: Instead of pressing ESC,
you can also quit tools by
clicking a toolbar with the
right mouse button.

6 Close the wall outline by clicking the corner of the exterior wall
at the top.

7 Click the point at top right to set the start point for the elevator
walls (see illustration below).

8 Enter a value of 1.78 for the Ax X coordinate.

9 Enter -2.48 for the 2 Y coordinate and then -1.00 for the
AX X coordinate.

7

7z

—~ 7,

10 Press ESC to close the wall polyline and to quit the i Wall tool.

You will use the il Join Linear Components tool to design the next
wall. This tool can be used to extend a wall to the point where it
intersects another wall.

To join walls

1 Click the elevator wall to be lengthened with the right mouse
button.

2 Select | Join Linear Components on the shortcut menu. Check
that the joint width is set to 0.00 and change this setting in the
dialog line, if necessary.
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3

4

Click the exterior wall through to which the wall is to extend.

b
4

zz ) f E

Using the same approach, lengthen the elevator wall by joining it
with the wall of the stairwell. Then quit the tool.

You will design more interior walls based on the reference point of
existing walls and using the 'enter at right angles’ option, which
creates elements at right angles to existing elements. After you have
drawn the interior wall at top left, which is described in this section,
you should be able to create the other walls yourself using the
information provided below.

To draw more interior walls

1

2

Click Ef'] Wall (Tools palette, Create area).
Choose the wall type by clicking / Straight Component.

Click the first interior wall corner at top right (see illustration
below) and specify the offset direction towards the right/bottom.

Enter the length of the wall as follows: AX X coordinate = 0 and
AY Y coordinate = -7.78.

Click [ Enter at right angles in the dialog line.

If necessary, confirm the value dy = 0 in order to enter a value in
the x direction and define the end point of the wall by clicking
the point where the interior wall you just created and the exterior
wall intersect.

To set the start point of the horizontal wall at the top, click the
line to the right of the vertical wall you just created. The
reference point is displayed.
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8 If required, move the reference point onto the bottom left corner
and enter the offset between the reference point and the start of
the wall: 1.40.

9 1o Enter at right angles is still active in the dialog line.
Check that the offset direction is towards the top and click the
wall corner at bottom right.

10 Now draw the other interior walls yourself.

s Z 77
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11 The wall polylines close automatically. Press ESC to quit the i8]
Wall tool.
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A note on views and viewports

When working with walls and other components, you can get an
impression of how the building looks in 3D space at the click of a
mouse button. Each viewport has its own set of viewing tools at the
bottom of the viewport.

“u 4
JH -
A LS

+

In Allplan 2014 you can have a number of different views open
simultaneously and work in any view you choose. You can set a
different view in each viewport. For example, you can display a
section, the entire design or an isometric view.

Changes you make to the design in one viewport are immediately
reflected in all the others. You can define your own viewports or use
one of the five standard views and adjust it for your needs.

Select the viewport arrangement you want to use on the Window
menu. You can choose to arrange the additional viewports to the left
or right.

O [T 1]

]

@]\w %

]

0]
Al
i (%
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Tools for controlling on-screen display

In Allplan you can zoom in on any section of the design as exactly
as you need. Using the tools at the bottom of the viewport, you can
navigate freely on screen. These tools are known as ‘transparent’
tools; in other words, you can use them while a another tool (e.g.
Line) is active.

So that the maximum amount of workspace is available to you on
screen, the tools are not displayed until you move the cursor to the
bottom of the viewport. If you are working with multiple viewports,
you can find tools in each viewport.

Icon Function Use
+ v Standard Views flyout You can choose between plan view and any of the standard views.
+
s
- -l
E Zoom All a'= Refresh sets the display scale so that all the elements in the

visible files can be seen. But if you have loaded a view using

[£7 save, Load View, only this view is displayed.
Press ESC to cancel the process.

Tip: You can also double-click the middle mouse button.

N

¥

fa
&

r

Zoom Section “» Zoom Section zooms in on a section. To do this, press and hold

down the left mouse button and enclose the elements you want to
zoom in a selection rectangle.

Note: If several viewports are open, the zoomed section is displayed
in the viewport in which you clicked the button. The section itself,
however, can be defined in any of the viewports. Requirements: you
have not selected a perspective view and the same view is displayed
in both viewports.

Tip: You can also use the right mouse button to define the section

o
without activating the % Zoom Section tool.

o, Navigation Mode In a viewport: sets a perspective view. When dragging, the cursor
behaves in the same way as in animation windows (sphere mode,
camera mode).

In an animation window: when switched off, you can draw in
animation windows as you would in isometric windows.
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= Previous View o Previous View displays the previous view.

(2 Next View (2 Next View displays the next view.

= Save, Load View = Save, Load View saves the view currently set or loads a view

Off | =

100,00 | =

Wireframe model

3D View

Always on Top

Section Display

Display Scale

View Type - hidden
line/wireframe

you have saved. This way, you can set views that you require time
and again.

Note: As long as the (£ icon is active (pressed in), clicking

o
a'm. Refresh does not refresh the entire drawing but just the saved
view. To deactivate the icon, click it again.

'3 3D View opens the 3D View dialog box, where you can set
views.

More information can be found in the help. See the topic 3D view.

a2l Always on Top places the viewport so that it is always on top
(i.e., in front of) the other ones. This tool is only available when the
Connected option is not selected and the viewport is not
maximized.

Activate Section displays an architectural section that you have

241
defined with =24i Clipping Path. You can identify the section by
selecting it on the dropdown menu or by clicking it in the

workspace. @ switches the section display off.

Sets the display scale. You can select from a list of default values or
enter any value in the data entry box. Then press ENTER to confirm.

Hidden line image displays the contents of the current viewport as

a hidden line image.

Note: You can define settings for the hidden line representation in

the % Options - Desktop environment - Display - Accelerated
hidden line representation area.

Note: Using @ Hidden Line Image, Wireframe, you can save a 2D
hidden line image in a separate document.
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In addition, the following tools are provided in the layout editor. You can use these tools to switch between
the design view and a preview of the layout to be printed.

Design View The Design view displays the elements of the layout as you have
created them. Any superordinate pen, line or color defined is taken
into account. You can use the options provided by the

El Show/Hide tool to specify the type and scope of the elements

displayed. The settings in the Print Layouts tool are not taken
into account.

Color Preview The color previews display the layout as it is printed by a color
printer and the grayscale preview shows the layout as it is printed
when you use a monochrome printer. The elements you have
Grayscale Preview selected in the Elements to print area and the parameters you have

defined on the Print profile tab of the ﬁ Print Layouts tool define
the on-screen display. Only a few options are available in

El Show/Hide.

or

Note: So that you can work quickly and easily, the preview also
displays elements that are outside the page, the margins of the page
and, if selected, the printable area of the output device although
they are not included in the final printout. The selection color and
detection color are also used in the preview so that you can see
better what you are doing.

Note: You can find more tools for controlling the on-screen display
on the View menu:

Icon Function Use

o Pan o Pan Pans the section that is visible in the active viewport by a
vector you specify. To enter a vector, press and hold down the left
mouse and then drag. You can also pan in the active viewport by
pressing and holding down the middle mouse button and then
dragging. Alternatively, use the cursor keys.

& & . S
& Refresh # Regen regenerates the section that is visible on screen. Press
ESC to cancel the process.
(=} i = . . . .
e Reduce View ‘= Reduce View Reduces the section displayed on screen in

incremental steps. (The display scale doubles.)

Enlarge View

fa
Lt

@ Enlarge View Enlarges the section displayed on screen in
incremental steps. (The display scale halves.)
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The following exercise will help you understand how the viewports
work.

How to set viewports: detailed view and full view

1 On the Window menu, click E 3 Viewports.

2 Click 527 Plan View in the viewport at top left.

3 C(lick £ Zoom Section at the bottom of the viewport on the
right.

4 Zoom in on a section in the viewport at top left.
This section is displayed in the viewport where you clicked
2 Zoom Section (here: in the viewport on the right).
This way, you can work on details and still see your entire design
in plan, perspective and elevation.

[ Allplan 2014 - Engineering Tutorial (with model) - Basement:DF101 - 3D floor plan - 8 %

File Edit View Insert Format Jools Create Change Repeat Window 7
|PEGBEE G-P- CmEAXEEIED | Gl § @ A -1 [-| 1N - oerauLT
m : — LX ey P\anMB —
Tools |[Prope.. | [Wizar... | [Library| [Conn... | [Layers|
() Architecture [-lp
Create
IV 1= U || T Q
=
cze 0@ | u
DwE L & %
Va
& I & @ o
Abc 128 E %E @
M® 8 =
Change
& Wl =l 2
Y% & i om
T
o I
J-Elick left to select, Ctrl+click to add, Shift+click to select entity group
Press Fl to get Help. b Mode: ?Menu  Drawing type: Scale definition Scale: 1:100 Length: m Angle: 0000 | deg % 1
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To create a hidden line representation

1 Click Hal 3 Viewports.

2 Click | Mireframe medel [~/ ot the bottom of the viewport at top left
to set the view type to Hidden line image. This creates a hidden
line representation.

Note: You can define settings for the hidden line representation

in the X Options on the Display page, Display area.

3 To hide the division lines between the exterior and interior walls

of varying pen thickness, open [=] Show/Hide (Default toolbar)
and select the Use color 1 for all elements options.
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Tip: Using Save, Load
Arrangement on the Window
menu, you can save the entire
arrangement in the same
manner and load it again
with a single click.

To save a view

1 Use “ Zoom Section to choose a section where the design is
displayed in plan (viewport on the right).

2 Click &7 Save, Load View.

Save, Load View x
Name New
Replace
Rename
Delete
Close

3 In the Save, Load View dialog box, click New, enter a name for
the view and click Load.

The view is now active (the (& icon is pressed in); in other words,

when you click % Zoom All, it is displayed.

4 Switch off E‘ Save, Load View (icon is not pressed in) and then
click

e
a'= Zoom All.
Now the whole drawing is displayed again.

5 On the Window menu, click i1 Viewport. This also switches
off the hidden line representation.
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Columns

Tip: You can also use the
Column tool to make any
column-shaped element - for
example, round and
rectangular columns as well
as flush piers of small size.

Now you will place a column in the basement.

To draw a column

< Drawing file 101 is current and plan view is active. Line type 1 is

selected.

1 On the Format toolbar, select pen thickness (3) 0.50 mm and

click m Column (Tools palette, Create area).

Check that the layer AR_COL is selected. If it isn’t, activate it on

the Format menu or toolbar.

2 On the Column Context toolbar, click Properties.

Column

Cutline

Weeon2
Parameters

Width 0
Thickness 0
Angle

Height 2
Relative height

Relative to TL, BL

Attributes

Trade

Priority

Caleculation mode m
Material selection

Material / qualities

Catalog assignment nem_ava

& &

L2500

L4000

0.00

2800

Height...

.Av

250

Preview
&
Surface elements
Display surface elements in plan

% Hatching 'E'E Pattern & Fill

303 5 EXH 5
Bitmap Area %E Style Area EE Surface (ani...
301 Rein...
oK Cancel

3 Set the parameters in the Column dialog box as shown above:
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Type: ] Rectangular column
Width: 0.25 m

Thickness: 0.40 m

Priority: 250

Style area: 301 Reinforced concrete

4 (Click the button marked Height... and enter the height of the
column as absolute values:

. &= Top level: -0.51.
e ™ Bottom level: -2.79.
5 Confirm the two dialog boxes.

6 On the Column Context toolbar, set the 4 Anchor point for
preview to bottom right.

Z. Z.
7 7,
./,
/)
7/
3T[a
¢ "2
o
o~
/,
7 ]
/ 7 4 7
/)
] 7z 77

7 Move the crosshairs to the interior corner (see above).

This point now serves as the reference point for further entries,
and the data entry boxes in the dialog line are highlighted in
yellow.

8 Enter 0.00 for the 3% X coordinate and 2.85 for the
AY Y coordinate in the dialog line and press ENTER to confirm.

The column is positioned.

9 Press ESC to quit the tool.
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Tip: selecting layers
Always proceed as follows:
- First select a tool..

- Check the layer's short
name on the Format toolbar.

- Switch layer if necessary.

Tip: To see which layers have
already been assigned, click
< Select, Set Layers on the
Format menu and select the
List layers used in open
documents option in the
Contents of list box area.
Alternatively, open the Layers
palette and the shortcut
menu and click List layers
used in open documents.

Assigning layers
You assign layers and other format properties (pen, line and color) to
walls and upstands in the M Properties dialog box.

Note: If you set the layers as described in unit 1, the appropriate
layer for the selected tool is activated automatically.
If it isn’t or you want to use a different layer, do the following.

To select the current layer

S The 1l Column tool is active.
The dialog box with the properties is closed.

1 Click in the Select, Set Layers list box (Format toolbar).

]

Ty

AR_COL - &
Select...

Print set...

Privilege set._.

Set...

DEFAULT

4

tAA_GEN Architecture. general
tkA_COL Column

iA_COL_C Column, concrete [}
A_COL_T Column, timber

2 If the layer AR_COL is available for selection in the quick access
list, click it.

3 Ifitisn’t, click Select... and double-click the AR_COL layer in the
Single layer selection dialog box.
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Downstand beam

The next step involves creating a beam over the column.

To draw a beam

1 Click @ Downstand Beam, Upstand Beam (Tools palette, Create
area). On the Downstand Beam, Upstand Beam Context toolbar,

click Properties.

Downstand Beam, Upstand Beam *
Shape of cross-section Preview
Rectangle: ™
Section:
B g
o~
=1
Mirror: h
Rotate: £
Modification mode
Axis
ThicknessPosition
0.0000 I - 0.2500
0.2500
]
LR
Thickness | Height ﬂ Material/qualities Trade Prigrity | Calc. mode Interaction AutoJoin
0.2500 0.2000 a— - 250 m3 dynanmic =
= Pen = Line (0 color £ Llayer EEf surface (animation)
0.35 1 ———— 1 I ‘R_EEAM a -—-
Show surface element in plan view
% Hatching EEEE Pattern &y Fil Bitmap Area % Style Area
[m] -—- [m] -—- [m] -—= [m] -—= [ 301Reinforced concrete
Catalog assignment, material selection: nem_ava Settings for compenent axis and profile: %
;& . ) (o

2 Set the parameters for the beam as shown above:
Thickness: 0.25 m
Priority: 250
Pen thickness: (2) 0.35 mm
Style area: 301 Reinforced concrete

3 Check that the layer AR_BEAM is selected. If it isn’t, activate it.
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4

Click EE to define the absolute height of the beam:
o &= Top level: -0.31.

e 7 Bottom level: -0.51.

Confirm the two dialog boxes.

Click the start point (see below).

Click oW Enter at right angles and enter 0 for dX.

Check the beam’s offset direction in the preview and, if necessary,
change it by clicking === Reverse offset direction.

To define the end point of the beam, click the horizontal wall.
As you have selected 'Enter at right angles’, you can also click a
corner of the wall.

The beam is drawn.

Vrrzrrzmzzrm777
E 7, e
T ITd A
9 7
,
e_ 7
.
]
6 ’
7 )
7, LI 7
Z '// e

10 Press ESC to finish entering the beam.

11 To check its position, select an isometric view on the View menu

or open multiple viewports.
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Openings

Tip: You can enter names for
combinations of parameters
and save them as favorites.

You can use #ﬁ to match the

settings from an existing
component.

Note: The procedure for creating an opening - be it a door, window,
niche or recess - is always the same. The differences lie in the
property settings you can make.

Like in the 'real’ world, there is an inherent association between
walls and openings in Allplan. When you move a wall, for example,
its openings will move too.

All the doors in the basement are single doors of a size of
0.885/2.10 m (except for the doors to the stairwell and elevator).
Smart symbols are not used. You will draw the door opening without
a door swing. To display the door lintel, the reveal option will be
used.

The procedure for creating door openings also applies to all other
kinds of openings.

Entering openings
e Click the first point of the opening.
o Enter properties and set the height.

o Enter the width of the opening.

You only have to make the settings for the opening once if you want
to create a series of identical openings. The properties and the height
information are stored by the system until you redefine them.

creating door openings
o The Basic: Walls, Openings, Components module is still open.

1 Click L Door (Tools palette, Create area).
The door opening is attached to the crosshairs.

The program suggests the layer AR_SMSY for the smart symbol
inserted in the opening. Openings always have the same layer as
the component into which they are inserted, regardless which
layer is currently active.

Here, the layer setting is irrelevant.
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2 Set the 4 Anchor point for preview to bottom right on the
Door Context toolbar and check that : Enter offset directly is
switched off in the dialog line. If it isn’t, enter 0.00 for the Offset

to reference point. Now you can enter a reference point.

3 Click a point on the outside of the stairwell wall roughly where
you want to insert the door (see the following illustration).
The reference point is displayed as an arrow and the offset
between the reference point and the point clicked is displayed in
the dialog line.

3828 + ;% + 3.00

-

Z 7]

7,
7] ¥

4 If the reference point is not displayed on the inside corner at top
left, click on the corner to move it there and enter 3.825 m for
the offset in the dialog line.
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5 Click Properties.

Door

J Opening H Reveal |

Shape

Waae

Parameters

Width of opening
Height of sil

Opening height

Opening dir.

D

Representation

Opening
height

Opening
width

Relative height

= @X

Relative to TL, BL

["] French door

Smart symbol 1 to n

Height.. |

]

Sill: format properties

= Pen £ Line ) color 2 Layer
035 1 1 - AR_WALL
Sill representation Reveal
© None 1 C Create reveal element
) Qutside I
Retrieve reveal
) Inside -
=]
@ Onbothsides 11 E

6 Select the L] rectangle for the type.

7 Asyou do not want to display the door swing, click the icon
below Opening direction and then click O] Off.

Door swing symb... g

Double lines: door leaves

Offset 0.0000

T L= 06

N M D= DG
Up DN e
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8 C(lick Height... and enter the height of the top and bottom levels
of the door as absolute values. Enter
-2.79 The top level is obtained from the door height to which the
thickness of the floor is added (0.09 cm). Enter -0.69.

Height (==
Top level Preview

s 7|§\'§! o Default TL 25000

Elevation point -0.6500

< = +
| I . -
|E_ BL

Bottom level

2 IRFF&E

&

—
r

Elevation point -2.7900 Default BL 0.0000

v

| Cancel

9 C(lick OK to confirm the dialog box.

10 In the Door sill area, select the Both sides option. Select pen 0.35
mm for the sill; leave the line and color settings as they are.
Select the AR_WALL layer.

Disable the Create reveal element option.

11 Click OK to confirm the dialog box.

12 Enter 1.01 m for the width of the opening in the dialog line. The
door opening is drawn.
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Tip: You can set the anchor
point (left, right or centered)
on the Door Context toolbar.

You can also switch off the
'Prompt for opening width' to
create several doors of the
same width.

Tip: To quickly check the
design visually in 3D space,
you can select a standard
isometric view (View menu)
and create an accelerated
hidden line representation by
setting the view type to
Hidden line image.

13 Now draw all the other door openings yourself. You only need to
enter the width of the opening in the dialog line (except for the
elevator door which is 2.25 m high). Make sure that the offsets
are correct. Change the height of the elevator door in the dialog

box:

bottom level = -2.79; top level = -0.54.

R 885 ;5
2.10

3.60

14 Press ESC to quit the tool.

X
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"
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Tip: If necessary, change the
anchor point (Window
Context toolbar) and the
position of the reference
point.

The next step is to insert window openings in the walls. Some of the
window openings will be wider and higher than others and the
height of the sill in each opening is also different. Here, too, the
windows are displayed with a sill.

You are already familiar with the approach. Set the height, define the
shape of the window and place the opening in plan.

To create window openings
1 Click 2 Window (Tools palette, Create area).

2 Set the 4 Anchor point for preview to bottom right on the

Window Context toolbar and check that ¢ Enter offset directly
is switched off in the dialog line or that 0.00 is set for the Offset
to reference point.

3 Click the line representing the exterior of the wall at top left and
enter the offset to the reference point in the dialog line.

4 C(Click Properties.

Window

Opening || Reveal

Shape

Parameters

Width of opening
Height of sill

Opening height

Relative height

Relative to TL, BL

Heoeoamor®

Representation

1.0100

-1.1100

0.6000

Opening
height

[

I Height of
sill

Opening
width
Sill: format properties
Height... il —
= Pen = Line . Color 3 Layer

4

0.25

1 - AR_WALL
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5 The dimensions of the window openings are 80 by 60 cm. When
the lintel is 20 cm, the top level of the opening is at
-0.51 and the bottom level at -1.11. Click Height... and enter the
height as absolute values.

6 In the Sill area, select the Both sides option. Do not change the
pen, line and color settings of the sill. Select the AR_WALL layer.
Disable the Create reveal element option.

7 Click OK to confirm the dialog box.

55
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Design check

8 Now draw the windows as shown. Do not forget to change the
settings for the windows in the exterior wall on the left.

You can do this in two ways:

e Enter -1.31 for the height of the sill and 0.80 for the height
of the opening

e or click Height... and set the bottom level to -1.31.

9 Press ESC to quit the tool.

Defining the Reference Point

To change the position the small arrow representing the nearest
significant reference point, you can

e click a point on the wall or

e click a point beyond the wall. The reference point will move to
the point on the wall that is perpendicular to the point you
clicked.

You can generate a hidden line image to check the design. This way,
you can see whether the window and door openings are placed
correctly. The hidden line image can be saved to a drawing file.

To copy the 3D view to a different drawing file

1 Click “-# Front Right, Southeast Isometric View at the bottom of
the viewport.

2 Click @ Hidden Line Image, Wireframe (Default toolbar).

Hidden Line Image, Wireframe @

Hidden Line Image
Update Hidden Line Image
Wireframe

OK Cancel




60

Exercise 1: floor plan of basement Allplan 2014

Tip: To save the hidden line

3 Click Hidden Line Image in the Hidden Line Image, Wireframe
dialog box.

Hidden Line Image in Destination Document @

Surface elements Representation
*) No surface elements

Only fills from colors

Create bitmaps from textures, fills from colors

Surfaces...
Consider light o o
Light angle in view (left / right)
Light angle to visible axis (length of shadow)

Light intensity

Fill-in light intensity -

Elements
*® Display all elements

Display selected elements anly

Adjacent edges Special settings
Remove adjacent edges Arch... For architectural sections

25.00 Max. angle (degrees)
Adjacent edges for archit. components

Display adjacent edges hetween different surface elements

Display adjacent edges for round components (wall, celumn, chimney)

Result = Pen ( Color @ Layer
Display visible edges 0.25 1 DEFAULT
Display hidden edges ¥ 018 25 DEFAULT

[ﬁ gf @ OK Cancel

4 Select the Display hidden edges option and confirm the dialog

image as an NDW file, click box and the following message box by clicking OK.

Save as ... on the File menu.

The hidden line image is displayed in a separate window.

5 Close this window by clicking the X in the top right corner.
Acknowledge the prompt by clicking Yes.

- 83 % Allplan ®

Would you like to save the changes in Result of hidden line image
JL8%  2012-08-27 10-35-567
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6 Select drawing file 105 in the Select the destination drawing file
dialog box.

7 Click Open on a Project-Specific Basis and double-click
drawing file 105 to make it current.

As the isometric view is still active, nothing is displayed in the
workspace.

8 C(lick way Plan View at the bottom of the viewport.

9 Your workspace should now look like this. You can also print the

image by clicking = Print (File menu).
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Dimensions

Now you will dimension the floor plan using the approach described

in exercise 6 in the Basics Tutorial. Select the I Basic family in the

Tools palette and open the Il Dimension Lines module.

e Make drawing file 104 current, open drawing file 101 in edit

mode and close all the other drawing files.

e Check the current Scale in the status bar and set it to 1:100, if

necessary.

e Place the dimensions for the doors, windows and beam on the
layer DL_GEN and the wall dimensions on the layer DL_100.
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Turning layers on and off

Tip: If you change the status

of the current layer, the

DEFAULT layer becomes the

current one.

Tip: When no tool is active,
you can also open the Layer
dialog box by double-clicking
with the right mouse button

in the workspace.

You can check that the dimensions are assigned to the correct layers
by setting the layer DL_GEN containing the dimensions of the
openings to visible, frozen.

To turn layers on and off
1 Open the Layers palette.

2 Open the shortcut menu of the Layers palette and click List
layers used in open documents.

3 Using the right mouse button, click the
DL_GEN Dimension line, general layer and choose Visible,
frozen.

| Layers 3 X

Tools ||Properties| Wizards| Library | Connect| Layers

| o)
&= g 95 %)L
Status Short name Full name
i | DEFAULT DEFAULT
¥ Dimension line
CJOC.DLGEN_ Dimension line, general
[JOC] pLioo Current
¥ Architecture Modifiable
\:Dlz AR_WALL Visible, frozen
\:.DI:. AR_COL Hidden, frozen I}
CI1O[] AR_sLes

EDE AR_BEAM Select all (Ctrl=A)
Cancel selection (Shift+Ctrl=A)

Isolate selected layers (Shift+Ctrl+double-click]
Scroll to current layer

List layers assigned to currently selected tool
& List layers used in open documents
List entire layer hierarchy

' Show modifiable layers
W Show visible, frozen layers
' Show hidden, frozen layers

Customize...

The dimensions on layer DL_GEN are displayed in color 25,
which you selected for frozen layers.

You can also use the % Select, Set Layers tool on the Format menu
to turn layers off. The shortcut menu of the Select Layer/Visibility
tab provides the options you require.
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To set the frozen layer to modifiable again, use the right mouse

button to click any frozen dimension line, select < Modify Layer
Status on the shortcut menu and click Modifiable.

Modify Layer Status *

Elemert layer: DL_GEN Dimension line, general
| Cumert
Modifiable

Hidden. frozen

Isolate layer - set all other layers to hidden
Cument layer - set all other layers to visible, frozen

Cument layer - st all other layers to modifizble

Beww @D

Set all layers to modffiable - retain curent layer

O
a

104142013 10:44 AM DL_GEN visible, frozen

Cancel

What to do when elements are no longer visible?

o Use the Layers palette or the dialog box of the = Select, Set
Layers tool (Format menu) to set all the layers to visible.

o If the elements are still not visible, the selected privilege set may

not have the necessary privileges. Select the = Select Layer
Privilege Set tool at the bottom of the Layers palette and select
an appropriate privilege set or ask your administrator for help.
You can also select a privilege set in the Layer dialog box -
Select Layer/Visibility tab - Privilege set list box.
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Which layer is the element on?

When you point to an element (without clicking it), a box with
information on the element appears. According to the settings in

the 4 Options on the Selection page, the Element name and
Layer are displayed by default.

You can find out which layers individual elements are on by
turning each individual layer on using the Layers palette or the

& Select, Set Layers tool on the Format toolbar.

You can find out which layer a single element is on by clicking
the element with the right mouse button and selecting Format
Properties.

All the properties including the layer are displayed and can be
changed directly.

You can also change the layer of the current element. The layers
of linked components (e.g. window openings in walls), however,

do not change. It is usually better to use & Modify Format

Properties.

You can change the layer assignments of one or several elements

using the & Modify Format Properties (Edit toolbar). This tool
also modifies the layers of linked elements.

Meodify Format Properties @
Type of medification
* Madify Format Properties

Convert 2D entities to construction lines
Convert construction lines to 2D entities
Change "From layer" for pen, line and calor

Format properties
Pen thickness 025 — | =
Line type 1 — | =
Line calor 1 I -
Group number 876

Layer | DE_GENOL |
Sequence (+ is in front) o

f‘: | OK | Cancel
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Stair outline

Tip: To select a tool you have
already used beforehand, you
can activate it on the Repeat
menu.

You can choose from the 30
tools you have selected most
recently.

You can create stairs in two ways:

e You can model it in 3D using the tools in the = Stairs module
or

e You can draw it in 2D using the tools in the B Draft module.

As half-space landings and flights of stairs are usually produced as
precast elements, you do not need to design or reinforce them. You
will therefore draw the outline of the stair using the tools in the

1N Draft The following exercise has a "rough design guideline”.
Tools that you have already encountered are no longer explained in
detail.

To draw the stair outline

1 Make drawing file 103 current, open drawing file 101 in edit
mode and close all the other drawing files. Select pen thickness
0.13 mm.

2 Select the 1N Draft module in the Tools palette.

3 Use 7 Line, D Rectangle and i" Parallel Lines (Tools palette,
Create area) to draw the stringers and the steps.
Check that the layer DE_GENO2 is selected. If it isn’t, activate it
on the Format menu or toolbar.

4 Use /7 Line and J_ Perpendic. Bisector (Create area) to draw
the line of travel.

5 Use v Line to draw two section lines.

6 Use M Auto-Delete Segment (Change area) to delete redundant
line segments.
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7 Click @ Modify Format Properties.

Type of medification
*) Modify Format Properties
Convert 2D entities to construction lines
Convert construction lines to 2D entities

Change "From layer" for pen, line and color

Format properties

Pen thickness 0.13 =

Linet}fpe S ——

Maodify Format Properties @

8 The Modify Format Properties dialog box opens. Select the Line
type check box and choose line type 2. Then click OK to confirm.

9 Select the element(s) you want to modify: click the elements to

which you want to apply the new line type. Then press ESC to
quit the tool.

10 Make drawing file 104 current, open drawing files 101 and 103

in edit mode and close all the other drawing files.

11 Dimension the outline of the stair and modify the dimensioning

of the door. Double-click a frozen opening dimension line with

the right mouse button.

This selects the Dimension Line tool and automatically activates

the DL_GEN layer.
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Slab

Tip: You can also use the

& Slab tool to create floor
slabs.

A separate set of tools is
provided for designing
foundations.

The basement now needs a slab. You can create slabs using the

& Slab tool. As with walls, start by entering the properties and then
draw the outline of the slab using the polyline entry tools.

To set the slab’s properties
1 Make drawing file 101 current and set 103 to edit mode.

2 In the Tools palette, select the b Basic: Walls, Openings,

Components module. Click & Slab (Create area) and select pen
thickness 0.50 mm.

Check that the layer AR_SLAB is selected. If it isn’t, activate it on
the Format menu or toolbar.

3 On the Slab Context toolbar, click Properties.

Slab (5|
Outline Preview
|}
Parameters
Height 0.2000
Relative height Height...
Relative to TL, BL A
Attributes
Trade =T
ar
Priority 200
Surface elements
Calculation mode m2 =
Material selection Display surface elements in plan
Material / qualities % Hatching E‘E‘ Pattern a Fill
Catalog assignment nem_ava 303 5 5
Bitmap Area ;/4{ Style Area EE Surface (ani...
301 Rei..

[,3 é’ Ok Cancel
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4 Click Height... and enter the height of the slab as absolute values.
The unfinished floor of the ground floor = top level of the slab
above the basement = -0.11. As the slab is 20 c¢m thick, the
bottom level = -0.31.

Height @
Top level Praview
3 T|é.| =H e Default TL 25000
Elevation point -0.1100
N7 11

= 7 = +
I | A,
:
|: _ BL

Eottom level

2 IMF=S

Elevation point -0.3100 Default BL 0.0000

Cancel

5 Click OK to confirm the height settings, define the priority rating
and select a style area. Do not close the Slab dialog box.

To avoid entering the same properties again and again, you can set
them as you need and save them as favorite files. You can do this for
any component.

To save component properties as a favorite file
2 The & Slab tool is still active and the dialog box is open. If it
isn’t, select this tool and click Properties.

1 In the bottom left corner of the dialog box, click = Save as a
favorite.

2 Select the Favorites - project folder, enter a name and click Save
to confirm.
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Save as a favorite

Savein: . Favorites - project - L€ ] T

|
Mo iterns match your search,
Favorites - off... ¥

[
Favorites - pri..

[
Favorites - pr..

LY

Computer
.
W
Metwork
File name: Slab t=20cm. BM

Save as type: Slab favorite (*.defanfx)

> -

MName Date modified

Type

Save

Cancel

3 C(lick OK to confirm the Slab dialog box.

The next time you need a slab with these settings, click & Load

favorite and select the file:

The values in the dialog box will change automatically.

You will now define the position of the slab using the polyline entry
tools. Using these tools, you can polygonize the outline in a single
step. The only requirement is that you click an element in the

polyline and do not snap a point.

Polyline entry tools

elements check box.

the entire boundary.

You can use these tools to enter any outline. To use the following options, select the Polygonize

4 Polygonize entire element: the start point also serves to specify the direction. You can specify
the number of segments for circles and curves.

#  Define area of element to polygonize: generates a polyline based on a portion of an element.
The portion is defined using a ‘from’ and a ‘to’ point.

/% Enter reference point: identifies a point on the element as the start point for the new element.
This start point is determined by clicking a point on the element and entering an offset value
between it and the nearest significant point (displayed as an arrow).

&% Area detection using additional point: click a point on a polyline and the system will detect
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To create the slab using the polyline entry tools

1 Set properties, place polygon point 1, element or offset: click a
line representing the outside of a wall. Make sure that you do not
click the line near a point.

2 Click G Area detection using additional point in the input
options.

3 Click a point (near to the first point) beyond the floor plan. The
system automatically detects the outline of the entire floor plan.

) L

%
M\
<

4 Press ESC to quit the tool.

You will now insert an opening in the slab in the area of the stair to

provide access to the ground floor. You can use the = Recess,
Opening in Slab tool to pierce slabs in their entirety. Height settings
are not required - all you need to do is define the shape of the
opening. You can choose between rectangular, circular, polygon and
freeform openings.
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Tip: Slab openings are created
in the same way as slab
recesses. The parameters are
also identical. The only
difference is that height
settings are required for
recesses as they do not pierce
the slab in its entirety.

As with door and window
openings, slab openings have
the same layer as the
component into which they
are inserted, regardless which
layer is currently active.

You will also insert a slab opening for the elevator shaft. To define

the outline, you will use the

Area detection tool. Using this tool,

you can detect a closed polyline simply by clicking within its

boundaries.

To create a freeform slab opening

—
1 Click =# Recess, Opening in Slab (Tools palette, Create area).

2 Click the basement slab.

3 On the Recess, Opening in Slab Context toolbar, click

Properties.

Recess, Opening in Slab
Type
*) Opening

Recess

Cutline

= OOD\%IB

Parameters

Top level = TL slab
Bottom level = BL slab
Height

Relative height

Relative to TL, BL

& &

Preview

Smart symbaol

Smart symbol @ X

| QK | Cancel

4 Select the Opening type and the % Freeform outline.
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5 Click the corners of the stair outline one after the other.

g

7

/ A .7z
i REEEERR
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I >
L/ 5 N\ 5
7 77 7

6 To close the outline, click the first point again or press ESC after
the last point.
This defines the slab opening for the stair. The next step is to
define the slab opening for the elevator shaft.

7 Switch on ¥ Area detection in the input options (icon must be
pressed in).

8 C(lick in the elevator shaft. The system automatically detects the
area.

9 Press ESC to quit the tool.

10 Click ':-r' Front Right, Southeast Isometric View at the bottom of
the viewport.
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11 Select the Hidden line image view type at the bottom of the

viewport, open [=] Show/Hide and temporarily select the Use
color 1 for all elements option again.

The design should look like this:

Printing layouts is covered in exercise 9.
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Walls in basement as a 2D design using the Draft module

As an alternative to the L Basic: Walls, Openings, Components
module, you will now create the walls in the basement in 2D

using the tools in the 1N Draft module. You can access these tools in
the Tools palette, Create and Change areas.

Tools: Objective:

Offset Polyline e e

oo, o 0 m, wm 15w G b w0 126
@ @ @ @

120
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Start by making initial settings.

To select a drawing file and set options
1 Select the I\ Basic family in the Tools palette and open the
B Draft module.

2 Click Open on a Project-Specific Basis (Standard toolbar)
and double-click drawing file 102.

3 Check the current scale (1:100) and unit of length (m) in the
status bar.

4 On the Format toolbar, select pen thickness 0.50 mm and line

type 1.
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Tip: When you enter a
negative offset, the offset
polyline is created on the side
opposite the one you clicked.
The direction in which it is
entered, however, does not
change.

Now draw the exterior walls.
Approaches

You can enter a floor plan in 2D in various ways:

e Create the walls using the /" Line and il Parallel Lines tools.
You should already be familiar with this approach as you used it
to draw the title block in the Basics Tutorial.

o C(reate the walls using the D Rectangle tool. By snapping to
points and entering offset values, you can take openings into
account. You will draw the interior walls in this way.

o C(Create the walls using the ¥ Offset Polyline tool.

Instead of using these tools to create a drawing in 2D, you can also

use the L Basic: Walls, Openings, Components module to create
the floor plan without taking the height into account (top level =
bottom level = 0.00). This approach is equivalent to the one
described above.

To draw exterior walls as offset polylines

2 The Lmy plan view is active and the Hidden Line Image view type
is switched off.

If it isn’t, click a1 Viewport on the Window menu.
1 Click IIF Offset Polyline (Tools palette, Create area).

2 Select the layer DE_GENO2. This way, you can use the 2D floor
plan for the key plan and the slab reinforcement.

3 Number of parallel offset lines: enter 2.

4 Enter the offset for the parallel lines in the dialog line: 1st offset
= 0; 2. Offset: = 0.30

5 Click to place the start point at bottom left.

6 Click left in the input options to define the offset direction, use

A% ¥ coordinate and ¥ Y coordinate in the dialog line to enter
the values in the x and y directions as shown below. Then press
ESC to quit the tool.
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Tip: If you have entered an
incorrect value or made an
error, press ESC and

2 delete (Edit toolbar) the
error. You can then resume
your work.

Tip: If you want to create a
floor plan with different wall
thickness, you can enter the
offset values each time you
place a point or you can use
the 5 Modify Offset tool to
correct the offset after you
have entered the floor plan.

Use the TAB key to switch between the data entry boxes.
Ay
Ay
Ay
Ay
Ay
Ay

dY = 1.00
dY =-1.00
dY = 16.45
dY = 1.00
dY = -1.00
dY = 1.00
dY = -8.375
dY = -3.00
dY = -6.075

Ax gx - 3.51
Ax gx - 5.19
Ax gx - 4505
Ax gx - 3.205
Ax gx - 3.275
Ax gx - 3.275
Ax gx - 345
Ax gx - -1.20
Ax gx - 1.20

+ 3.45

+-120—4

3.00

6.07°

+ 1004

+ 100+

16.45
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Draw the interior walls using the L] Rectangle tool. This way, door
openings can be taken into account. Start with the horizontal walls
near the stairwell.

To draw the interior walls as rectangles
1 Click D Rectangle (Tools palette, Create area).

2 Start point: click the re-entrant corner of the exterior wall on the
left (see below).

=1

—d
3 Diagonal point: enter 6.055 (= length of wall) for the

AX X coordinate and -0.24 (= thickness of wall) for the
Ay y coordinate. Then press ENTER to confirm.

4 To create the vertical wall, click the top right corner of the wall
you just created and enter A% X coordinate = -0.24 for the
length and AY Y coordinate = 2.40 for the width.

5 Click -él' Delete Double Lines (Tools palette, Change area) and
delete the two superimposed lines in the corner (generated by the
two rectangles).
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6 Click 1 Rectangle and draw the exterior wall at the top of the
stairwell. The start point is the interior edge of the corner (see
illustration below), length = 3.825, width = 0.24.

|

7 The O Rectangle tool is still active. To define the start point of

the next rectangle, use the options to snap to points and to enter
offset values.

8 Move the crosshairs to the bottom right corner of the wall you
have just drawn (see below). The data entry boxes in the dialog
line are highlighted in yellow.

Tip: Bear in mind that you 9 Enter a value of 1.01 for the 2% X coordinate in the dialog line
can select a wide range of and press ENTER to confirm.

tools simply by clicking the
element in question with the
right mouse button (when no

function is active).

10 Enter 3.00 for the length and 0.24 for the width.

8 11

Moreover, you can activate
tools you have already used
on the Repeat menu.

11 You can delete the superimposed lines at the point where the

horizontal and vertical walls intersect using the £+ Delete Double
Lines tool (Tools palette, Change area).
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Draw the other interior walls by snapping to points and entering
offset values. Experiment with the 1l Parallel Lines tool.

When you have drawn all the walls, delete the redundant lines in the
areas where the walls intersect. You can also delete the lines in the
region where the interior walls and the exterior walls meet as the
same material is used for all walls.
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Use the # Line tool to complete the door lintels and the beam near
the column. To do this, select pen thickness 0.25 mm.
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Now the window openings in the exterior walls are missing.

To draw window openings

1

Select pen thickness 0.50 mm and click /" Line (Tools palette,
Create area).

Move the crosshairs to the top left corner of the exterior wall. The
data entry boxes in the dialog line are highlighted in yellow.

Enter a value of 0.55 for the 3% X coordinate in the dialog line
and press ENTER to confirm.

Enter a value of -0.30 for the Ay Y coordinate.

Click i" Parallel Lines (Tools palette, Create area) and draw a
line to the right of the existing line. Enter an offset of 0.80.

Use {xl Auto-Delete Segment (Tools palette, Change area) to
delete the lines representing the lintels and complete the lintels
for the windows using a pen thickness of 0.25 mm.

55
+—+-80+

2] 6
I |
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Tip: Use & Area detection
when you create the style
area.

Using the same approach, you should be able to to draw all the other
window openings yourself (see figure).

Experiment with the numerous tools provided on the Edit toolbar,

such as Ty Copy and i Copy and Resize.

55
+—4-804——2.10——+604- 80 +— 1.87° —4 1.054-804— 1.42° —4 1.1 <480+ 126+

1 [

1004+——333——4 1004+—253—+
|
6.74

EEL
20—+
1
480+

30

26—+ 1.004+——246
|

| [ | [ 4

130480 4— 141—4——230——+-80+— 209 ——4+— 190 —+80+— 180° —+

Use the % Style Area tool (Tools palette, Create area) to apply
hatching to the walls of the floor plan as described in exercise 6 in
the Basics Tutorial. Set the pen thickness to 0.18 mm, select the style
area 301 Reinforced concrete and check that the layer SU_STYL is
active when you create the style area.
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To finish, you will check the layers used, move the 2D floor plan in
such a way that the 2D and 3D floor plans are congruent, add the
opening for the stair and check the entire design using the Key plan
and General arrangement drawing print sets.

To check the layer settings

1

Open the Layers palette.

As the List layers used in open documents option is selected,
you can only see the layers DE_GENO2 and SU_STYL.

| Layers 1 x |

Tools | | Properties | | Wizards | | Library || Connect || Layers

&= & Qs %)L
Status Short name Full name
| DEFAULT DEFAULT
* Design
[JO[C] DE GEMOZ Generald2
¥ Surface elements
O] su st Area style

Click the SU_STYL layer with the right mouse button, choose
Visible, frozen.

The style area is displayed using color 25, which you selected for
frozen layers.

If necessary, correct the layer assignment and set the status of the
SU_STYL layer to Modifiable again.

To move the drawing in the workspace

1

Drawing file 102 is current. In addition, open drawing file 101 in
reference mode.

Click =l Move (Edit toolbar).

Select the entire 2D floor plan and place it in such a way that the
2D and 3D floor plans are congruent.

Use the Ve Line tool to draw the edge of the slab in the stairwell.
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- 5 1 Basement

30 floor plan

2D floor plan

20 stair

Dimensions and labels

5 Result of hidden line image

To check the design using print sets

1

Set drawing file 101 to edit mode. In addition, open drawing files
103 and 104 in edit mode.

Click #* Expand at the bottom of the Layers palette and select
the List layers used in open documents option.

Click in the layer structure with the right mouse button and select
Match visibility from print set....

Layer - B X
Select Laysr/Visbilty | Print Set | [ Privilege Set | | Format Definition | [ Layer Structures
|| = = Q= 1| & | Friviege set: 5 aLLPLan -
Status Short name Full name Drawing type: Scale definttion -
= DEFAULT DEFAULT "
ITECTURE Contents of list box
*  Design List layers assigned to tool selected last
EEE g::gg:g; g:::::g; (®) List layers used in open documents
Suface elements Current v
IO su_sTrL Modifiable
~  Dimension line Visible, frozen
[JCIC] DLGEN Hidden, frozen irs
CJEIC] oL_1o0
Architecture Select all [Ctrl=A) ers
[CIEI[] AR_WALL Cancel selection [Shift+Ctri<A)
EEE 22—2&8 Isolate selected layers (Shift=Ctri=double-click) jiect setting)
OE0 AR:BEAM Scroll to current layer From layer, line styls
Match visibility from print set... I} From layer, line style
Save current setting as a print set... .
From layer, line style
Cut...
Rename... Settings
New layer... | Auto-select layer with tool
[ 1] Modfiable
«| Display elements on frozen
I:l Visible, frozen lzyers using a ficed color
Hidden, fi
I:‘ idden, frozen 25 I~ | Coler
Tip: The design exists twice 4 Select the Key plan print set and click OK twice to confirm.
when you select the General . . .
Y td - it All you can now see is the 2D floor plan with the main
arrangemen rawin rin . . . s
w .
set 9 gp dimension lines but without style areas
If you want to display one 5 Repeat steps 2 through 4 for the General arrangement drawing

floor plan only, you can
define visibility settings for
layers or open/close the
relevant drawing files.

print set. Select the Set all layers visible in print set to
modifiable option when you select the print set.
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Exercise 2: elevator shaft

Requirements:

P 3D Modeling:

Allplan 2014 Engineering comes in different module packages.

Open the Tools palette to check whether the [ Bonus Tools family
includes the following module(s):

This exercise involves designing an elevator shaft for the basement

you created in exercise 1.

You will mainly use the tools in the P 3D Modeling module. You

can access these tools in the Tools palette, Create and Change areas.

Start by selecting fileset 2 with the following drawing files:

Fileset Drawing
file number

Drawing file name

2 101
201

202
203

204
205

3D floor plan

General arrangement — 3D modeling
module

Concrete component

General arrangement — walls, openings,
components module

Associative views

Reinforcement drawing with 3D model

You can find the fileset in the

"Engineering Tutorial’ project (see

”Appendix: creating the training project”).
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4
I
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201 ' 20
430t H34+ | |
470430 154 30470

+— 10—+

i -— 20 20
S— i — ~ AR 15—+

i o 254 .
T

2.00
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Creating the 3D model using the 3D Modeling module

If you have not licensed the ﬁj 3D Modeling module, you can use

the e Basic: Walls, Openings, Components module to design (on
page 97) the elevator shaft.

Tools Objective:

o) Box
= 3D Surface

>~ 13D Line

£% Polyline Sweep Solid
fi** Change Archit.
Properties \

-P|:| Move
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Note: By default, the layer
AR_GEN is used with the
tools in the P 3D Modeling
module. As sections with their
own layers will be created
later using the &
Associative Views module,
the layer setting is irrelevant.

Start by making initial settings.

To select a drawing file and set options

1

Select the & Bonus Tools family in the Tools palette and open
the P 3D Modeling module.

Click Ledl Open on a Project-Specific Basis (Default toolbar),
open the drawing file tree for fileset 2 by clicking the triangle
symbol beside the name of the fileset and double-click drawing
file 201.

Check the current scale (1:100) and unit of length (m) in the
status bar.

On the Format toolbar, select pen thickness 0.50 mm and line
type 1.

On the Window menu, click Ll 3 Viewports.
This way, you can always see the design in plan, perspective and
elevation.

Start by designing the floor slab using the % Box tool.

To draw a cube

1
2

Click el Box (Tools palette, Create area).

In plan view (viewport on the right), click a point in the
workspace. The start point is to be the bottom left point of the
box.

Enter the following values in the dialog line:

Diagonal point: enter 2.54 for the Ax ¥ coordinate and 3.00 for

the &% Y coordinate. Then press ENTER to confirm.
Click point on parallel surface or enter height = 0.30

On the Window menu, click Ll 3 Viewports again to refresh the
view in all the three viewports.
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In the next steps, you will create the polyline sweep solid consisting
of vertical walls which are joined with the floor slab in the
basement. This involves three basic steps:

o C(Create the outline as a planar polygonal surface.
e C(Create the path using 3D lines.

o Generate the polyline sweep solid.

To create the outline as a planar polygonal surface

1 Click = 3D Surface (Tools palette, Create area).

2 Check that &l Polygonal 3D Surface is selected on the 3D
Surface Context toolbar.

3D Surface *

Bﬂlﬂi’b noe
| Polygonal 30 Surface

3 In isometric view (viewport at top left), point to the top front
corner of the box, so that the data entry boxes in the dialog line
are highlighted in yellow.

4 Enter 8% X coordinate = -0.20 and
AY Y coordinate = 0.50 and press ENTER to confirm.

The start point is attached to the crosshairs.
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5 Enter values in the Az Z/ Ax x coordinate data entry boxes as
shown below.

Use the TAB key to switch between the data entry boxes.

+—100—+

+304—T70—4

] %
T Az 47 - 1.10
e = Ax gx - 0.70
N l Az 47 _ 030
i Ax gx - _1.00

Q ¥ AZ 47 - 140
20 Ax _
4 dX = 0.30

The design should now look like this in isometric view:
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The next step involves drawing the path for the polyline sweep solid
as a 3D line.

To draw the path for a polyline sweep solid as a 3D
line
1 Click R 3D Line (Tools palette, Create area).

2 In isometric view, click the top left point of the outline (see
below).

3 Use the 3 v/ 8% X coordinate data entry boxes in the dialog
line to enter the dimensions of the shaft:

Ay qy - 2.00
Ax gx = -1.54
Ay qy = -2.00
Ax gx = 1.54

4 Press ESC twice to quit the tool.
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Now you will create the polyline sweep solid. The 3D line will serve
as the path; in other words, the polygonal surface will be moved
(‘swept’) along this line.

To create a polyline sweep solid

.....

1 Click &3 Polyline Sweep Solid (Tools palette, Create area).

2 Click path for sweep solid: Click to the left of the 3D line and
enclose it in a selection rectangle without releasing the left
mouse button.

3 Click profile for sweep solid: click the polygonal surface.

2.2

The surface is swept along the profile.
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Your display should now look like this:

To finish, you will assign a surface element to the volume model.
This surface element will be used later when you create associative
sections. After this, you will move the volume model so that it is
congruent with the 3D floor plan created in exercise 1. In addition,
check that the top of the elevator shaft and the bottom of the
basement walls are flush.

To assign a surface element

1 Click ﬂ?‘! Change Archit. Properties (Architecture family, Basic:
Walls, Openings, Components module, Change menu).

2 In the Surface elements area, select style area 301 Reinforced
concrete.
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Change Archit, Properties 7 x
-+ Format properties

- ¥ Surface elements
% Hatching

.... Pattern
& Fil
Bitmap Area
v ﬁ Style Area 301 Reinforced concrete
75 Show in plan

ffﬂ" Hatching in component
B for Component -

A Ew - Apply

3 Select the entire volume model and click Apply in the Change
Archit, Properties dialog box.

4 Press ESC to quit the tool.

To move the volume model

1 Make drawing file 201 current and open drawing file 101 in
reference mode.

2 El 3 Viewports should still be active. Click ::"[l Move (Edit
toolbar).

3 In plan view (viewport on the right), select the entire volume
model.

4 On the Window menu, click Hal 3 Viewports to restore the full
view in all the viewports.

5 Position the volume model on the 3D floor plan in such a way
that they are congruent. In addition, the shaft dimensions must
match.

6 The bl Move tool is still active.
Select the volume model again by double-clicking the right
mouse button and move it by
dz = -4.49.
This value is based on the absolute height of the basement walls
(= -2.79) and the overall height of the elevator shaft including
the floor slab (= 1.70).
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Front Right, Southeast Isometric View:3 Plan:1 Ox

Front, South Elevation:2

e Fm i HDD i

This elevator shaft and the floor plan of the basement will serve as
the basis for exercise 4 that shows you how to create sections using

the tools in the b Associative Views module and apply
reinforcement using the tools in the £ Bar Reinforcement module.

Printing layouts is covered in exercise 9.
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A note on concrete components

- 3 2 Elevator shaft

101 3D floor plan

201 General arrangement
202 Concrete component
i 203 General arrangement
204 Associative views

Note: Only the All catalog
comes with the program.

In addition, you can define
your own component-specific
catalogs (consult the Allplan
Help).

Using the =2 Concrete Construction - 3D Object tool in the P 3D
Modeling module, you can create three-dimensional engineering
components quickly and easily.

This tool, which requires a separate license, contains predefined
components whose dimensions can be customized in component-
specific dialog boxes. All entries you make are immediately
displayed in a preview on screen.

A number of tools are provided to assist you when you place these
components.

Now you will create the floor slab and the walls of the elevator shaft
using a concrete component.

To create the floor slab and the elevator shaft as
concrete components

1 Click Lzl Open on a Project-Specific Basis (Default toolbar),
close drawing file 201 and open drawing file 202.

2 Click B Concrete Construction - 3D Object (Tools palette,
Create area).

T Select Component

=) Catalog selection

11

Enlargement

N
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3 The Select Component dialog box is displayed. Select Sleeve
foundation type 2.

4 Select the Place sleeve on foundation axis check box.

5 In the section view, click the overall height of the foundation,
enter 1.40 and press the TAB key to go to the next data entry
box. Enter the dimensions of the component as shown below.

Z Sleeve foundation type 2 - = %

M =

1.540 0.300°

3.000°

2540

[t

6 Click OK to confirm the settings.
A preview of the component is attached to the crosshairs. Click
the bottom left corner of the elevator shaft to specify the drop-in
point. The bottom center of the foundation plate serves as the
component’s reference point.

7 Enter half the length of the opening in the dialog line.
o AXx coordinate = 0.77

o Ay coordinate = 1.00

Dialog line

PAE]

<Concrete Construction - 3D Object> Enter reference point Ax | 0.770 Ay | 1.000 Az | Doog [x] oA 2 oo |- B -
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8 Point to the bottom left wall corner of the elevator shaft, right-

click in the workspace and select i Component dialog on the
shortcut menu.

m Delete track points

K Point snap options
‘\K Track tracing option

|B Mirror about ¥ axis

= Mirror about X axis

7% Rotation angle 3
— E‘ Resize component
_"E Component dialog I}

The component’s dialog box is displayed so that you can modify
the data.

9 C(lick == Enter elevation points and enter -4.49 for the
reference elevation of the component. Check the height by
moving the crosshairs in the workspace.

Tip: Any changes you make
are displayed directly in the
workspace. 1 @h

Z sleeve foundation type 2 - = =%

1.540 0.300

-7.580
-4.150

10 Click OK to confirm the dialog box and place the component.
Then press ESC to quit the tool.

11 Select the i Change Archit. Properties tool and assign the style
area 301 Reinforced concrete to the concrete component. Use the
procedure previously described.
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Creating the 3D model
module

using the Basic: Walls, Openings, Components

As an alternative to the P 3D Modeling module, you can also use

the tools in the e Basic: Walls, Openings, Components module to
create the elevator shaft.

You can access these tools using the Tools palette, Create and
Change areas. As these tools were covered in exercise 1, they are no
longer explained in detail.

Tools: Objective:

[ wall

&7 Slab

& Recess, Opening in Slab
=[] Move \

Start by making initial settings.

To select a drawing file and set options

1 In the Tools palette, select the e Basic: Walls, Openings,
Components module.

2 (Click Open on a Project-Specific Basis (Standard toolbar)
and double-click drawing file 203.

3 Check the current scale (1:100) and unit of length (m) in the
status bar.

4 On the Format toolbar, select pen thickness 0.50 mm and line
type 1.
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Create the walls of the elevator shaft.

To create walls

1

2

Click H:] Wall (Repeat menu).
Click Properties.

The Wall dialog box opens. Select wall thickness 0.300, priority
rating 300, pen thickness 0.50 mm and area style 301. Then click
Height....

Enter the height as absolute values:
. & Top level of wall: -3.09.

e =7 Bottom level of wall: -4.19.

Height @

Top level Preview
7R ] & " 9
iT|€.\:I =2 Default TL 2.5000
Elevation point -3.0900

. = +
[ | ry
[ :
_ BL

Bottom level

2 IEF=3

&

Elevation point -4.1800 Default BL 0.0000

7

Cancel

Click OK to confirm the settings.
Click C Rectangular Component.

Start point: in plan view (viewport on the right), click a point in
the workspace.

Disable b Enter at right angles and check that the wall’s offset
direction is towards the outside! If necessary, change it by

clicking ==&= Reverse offset direction.

Diagonal point: enter 1.54 for the AX ¥ coordinate and 2.00 for
the & Y coordinate. Press ENTER to confirm.
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Tip: You can also use the

=¥ Slab Foundation tool to
create the floor slab.

This tool allows you to define
the top level of the
foundation by matching the
bottom level of an existing
component.

Now you will create the slab and the floor slab for the elevator shaft.

To create the slab and the floor slab

1

2

3

Click & Slab (Repeat menu).
Click M Properties.

The Slab dialog box opens. Set the priority rating to 300, select
area style 301 and click Height....

Enter the height as absolute values:
. &= Top level of slab: -2.79

e =7 Bottom level of slab: -3.09
Click OK twice.

Set properties, place polygon point 1, element or offset: enter
0.70 for the offset in the dialog line.

In plan view, click the bottom left corner of the wall you have
just created.

To point or element / enter offset: in plan view, click the top right
corner of the wall you have just created and press ESC.

Repeat steps 2 through 8 to enter the floor slab. The floor slab
projects from the wall by 0.20 m. Use the following absolute
values to define its height:

. &= Top level of slab: -4.19

e =7 Bottom level of slab: -4.49

10 Press ESC to quit the tool.
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Tip: You can also select the
slab in elevation or isometric
view.

The slab now needs an opening.

To create a slab opening

1

2

w

Click = Recess, Opening in Slab (Repeat menu).
Click the upper slab.

On the Recess, Opening in Slab Context toolbar, click
M Properties.

Select the Opening type and the % Freeform outline. Then click
OK to confirm.

Switch on & Area detection in the input options (icon must be
pressed in).

Change the offset to 0.00 in the dialog line and click within the
walls of the shaft. The system automatically detects the area.

Press ESC to quit the tool.

On the Window menu, click Ll 3 Viewports to restore the full
view in all the viewports.

In isometric view (top left viewport), select the Hidden line image
view type at the bottom of the viewport.

B



102

Exercise 2: elevator shaft Allplan 2014

To finish, move the elevator shaft underneath the elevator shaft of
the basement you created in exercise 1.

To move the elevator shaft

1 Make drawing file 203 current and open drawing file 101 in
reference mode.

2 Hl 3 Viewports should still be active. Click ol Move (Edit
toolbar).

3 In plan view (viewport on the right), select the entire elevator
shaft.

4 On the Window menu, click Clal 3 Viewports to refresh the view
in all viewports.

5 Position the elevator shaft on the 3D floor plan in such a way
that they are congruent. In addition, the shaft dimensions must
match.

Plan:1 Ox
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Unit 3: Key Plan

In this unit you will learn how to create key plans
quickly and easily.
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Allplan 2014

Exercise 3: key plan for basement

Requirements:

@ Key Plan

Allplan 2014 Engineering comes in different module packages.

Open the Tools palette and check whether the (] Engineering
family includes the following module(s):

In this exercise, you will create a key plan for the basement. This

exercise requires exercise 1.

You will mainly use the tools in the @ Key Plan module. You can
access these tools in the Tools palette, Create and Change areas.

Start by selecting fileset 1 with the following drawing files:

Drawing Drawing
file number

Drawing file name

1 101
102
103
104
105
110

3D floor plan

2D floor plan

2D stair

Dimensions and labels
Hidden line image

Key plan

You can find the fileset in the 'Engineering Tutorial’ project (see
”Appendix: creating the training project”).
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Tip: Look in the Allplan help
for basic information
on the Key Plan module:

4 [=7 Engineering
3 EGeneral Information
3 E| Floor plan and shel drawing
4 [F=7 Key Plan module
4 [=7 Basics
D Intreduction
D Marks
» EgTools

Tools: Objective:

@ Horizontal Mark (o) 030

(i) Slab Mark
"[l Move I : Pi

(iff Modify Lines @ e

02 0%
d-20 =20

FT

T
) d=24

Woz) d=30

Start by making initial settings.

To select drawing files and to set options

1

Select the [ Engineering family in the Tools palette and open
the T Key Plan module.

Click Ll Open on a Project-Specific Basis (Default toolbar),
open the drawing file tree for fileset 1, select drawing file 110,
open drawing files 102 and 103 in edit mode and close all the
others.

On the Window menu, click El 1 Viewport.

Check the current scale (1:100) and unit of length (m) in the
status bar.

On the Format toolbar, select pen thickness 0.25 mm and line

type 1.
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6 Click x Options (Default toolbar) and select the Key plan page.

==

47 Representation

Arrow length [ Relative to slab size

Arrow length measured from E ® Middle
Border
Additional text As construction lines

7 Make settings as shown above and click OK to confirm.

As the half-space landing and the flights of the stair will be created
as precast elements, you will only draw the boundaries of these
components. After this you will use print sets to specify which
design entities are visible.

To control the visibility of design entities
1 Click 7 Line (Repeat menu).

2 Click in the Select, Set Layers list box (Format toolbar) and
choose Select....

DE_GEN02 k-2 § 30 = -

Select...

Print set... I/\\s

Privilege set._.

Set...

DE_GEND2 General02
DEFAULT

3 The Single layer selection dialog box opens. To close the tree
structure, click = at top left.

4 Open the Key plan layers in the Engineering layer structure by
clicking the respective triangle symbol, click the layer KP_GEN
and click OK to confirm the dialog box.
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Single layer selection x
o || = p From layer,. = Pen =2 Line
Status Short name Full name

= DEFAULT DEFAULT

»  ARCHITECTURE

¥ ENGINEERING

Shell

Reinforcement drawing

Bar reinforcement

Mesh reinforcement

BAMTEC

Key plan
= KPGEN . Keyplan,general
= KP_KEY L\\? Key plan

b BUILDING USING EXISTING STRU

(vwvwww

5 Complete the design by drawing the stairwell and the other
missing stair components. Then press ESC to quit the tool.

6 Click in the Select, Set Layers list box again and select Set....

7 C(lick in the layer structure with the right mouse button and select
Match visibility from print set....

8 Select the Key plan print set and click OK twice to confirm.

All you can now see is the floor plan with the lines you have just
drawn; the style areas are not visible.

First, you will apply marks to the exterior walls. Next, a mark will be
assigned to the slab.

To create horizontal marks

1 Click @ Horizontal Mark (Tools palette, Create area).
Check that the layer KP_MRK is active. If it isn’t, activate it on
the Format menu or toolbar.

Horizontal Mark =
’T|'D‘ o4 OO0 g Plustextm Number+’7| 1
+4 > &+ [0]o/o] = Leader| v | 5

Close

2 On the Horizontal Mark Context toolbar, click ® Without
Direction of Load and select =} Bubble.
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Tip: You can specify the type
of leader on the Context
toolbar.

3 Enable Plus Text, Leader and Number +. This defines how the
mark is displayed.

1

4 C(Click = to make settings for the mark text.

Horizontal Mark x

& Al 2500 14, 1000 Al =00 -
@ A 250 R e 1 ‘

5 Set the following parameters:
o Text Height = Text Width: 2.50
e Aspect: 1.00
e Font: Arial
o Font angle in degrees: 90
6 In the dialog line, enter W01 and press ENTER to confirm.

7 Place the mark, which is attached to the crosshairs, outside the
exterior wall on the left (see illustration below).

8 Reference to point: select the Straight setting and click the
exterior wall. The leader is created. Press ESC to finish.

9 Set a start point, click text or enter additional text: set the text
parameters and click where the additional text is to be displayed.

10 Enter d=30 for the additional text and press ENTER to confirm.

I
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11 Press ESC. The next mark number is already attached to the
crosshairs. You can modify it in the dialog line.

12 Enter W02 for the exterior wall at the bottom.

13 Use the same approach to assign mark numbers W03 and W04 to
the other exterior walls.

14 Press ESC twice to quit the tool.

Two options are available for displaying slab marks: a mark can be
displayed horizontally or at an angle that reflects the angle of the
slab diagonal. In this exercise, you will create horizontal marks.

To create slab marks

1 Click Ej Slab Mark (Tools palette, Create area).

Slab Mark

*
A % ’_| D Amow 0.1 Plus text ’7‘ Numher+’7| j
ENEN g

- f Q 0 Leader

Close

2 Click “é‘ Direction of Load on All Sides, set the arrow length,
which is relative to the slab size, to 0.10 and disable the Leader
option.

3 Enter 01 in the dialog line and press ENTER to confirm.

4 Start point, match text or enter mark text: click the bottom left
corner of the slab.

5 Diagonal point, match text or enter mark text: click the top right
corner. The mark is displayed.

6 Click where the additional text is to appear.

7 Enter the additional text in the dialog line and press ENTER to
confirm.
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8 Press ESC twice to finish.

S

d=30

01
d=20

[

Allplan provides several methods for modifying key plans:

@ You can use this tool to modify marks.

@ You can use this tool to modify text in marks.

(i? You can use this tool to modify lines and their reference.
A@’ You can use this tool to edit additional text.

KQ You can use this tool to change text settings.

You can use this tool to replace text in marks.
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The next step is to move the slab mark.

To modify marks

1 Click =l Move (Edit toolbar).

2 Select the element(s) you want to move: click the mark.
The mark including additional text, leaders and slab diagonals is

selected.

3 From point:

click the center of the circle.

4 To point: drag the circle on the diagonal upwards to the right.

d=30

The slab diagonals have also moved.

5 Click o4 Modify Lines (Tools palette, Change area).

6 Click line to be modified: click the end of the lower diagonal.
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7 To point or line: click the bottom left corner.

#

d=30

01
d=20

8 Use the same approach to modify the line at the top.
9 Press ESC to quit the tool.

Note: You can also accomplish this task using direct object
modification, which is covered in the Basics Tutorial.

Mark reports

You can assign detailed, additional text to the marks. In order for the
marks to be displayed more clearly, you can select the Additional
text as construction lines setting in the options. You can then print
the marks and the additional text using the E Report tool (Tools
palette, Create area).
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Complete the key plan as shown below. Do not assign marks to the
half-space landing and the flights of the stair as these components
are precast elements.

Then open drawing file 104 in edit mode. As you have selected the
Key plan print set, only the main dimension lines are displayed.
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6
S(%JZ 08 d=30 s[ ®F of
- 02 05 l -
=T d=20 420 =% s
d-30
“
3

493
593
I
S
GE
2
=
1
=24
593

3
"
S
5.90

5
B | E— E
=3 = —=+¥ w
Ca{ B 09 IX R
d=20
@ oo
<+ =30 T =%
ILEE ] [ I
5
S o~
— “ e A
—{— =
“- FT d=20 ~ - g ¥
o o b 2.
= = I T 13 o Q| ~
S|S sl
—= % =%
44l DFT Ql ST T
A B

4.83°
5.77°
S
X
S
3
6.23°
5.23°

+*

+*

L 100 39

L 100 %%
30
A+
?
&
30
A4

30 291 2 5.19 o 3905 30
A A E A
120, 6 13.20° 5 ,
KO o

Printing layouts is covered in exercise 9.
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Unit 4: Reinforcement

Drawing

This unit consists of four exercises, in which you will
learn how to create reinforcement drawings quickly and
efficiently.

You will use the tools in the & Associative Views and
(2 Bar Reinforcement modules to

reinforce a 3D elevator shaft and create a
reinforcement model in 3D at the same time (method
1). Finally, you will create a reinforcement schedule
and a bending schedule.

You will use the tools in the (2 Bar Reinforcement
module to reinforce a basic 2D door lintel, create a
reinforcement model in 3D (method 2) and save the
reinforcement as a symbol.

You will use the tools in the (3 Bar Reinforcement
and £/ Mesh Reinforcement modules to reinforce a
basic 2D slab without creating a 3D model from the
reinforcement (method 3).

You will use the tools in the Bl BAMTEC module to
reinforce a section of a slab.

To finish, you will learn how to manage cross-section
catalogs.
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Overview of exercises

Exercise 4: creating a 3D elevator shaft with a 3D model
(method 1)

You will use the tools in the Associative Views and Bar
Reinforcement modules to reinforce the elevator shaft you created in
exercise 2. Based on the reinforcement, a three-dimensional model
will be created automatically.

Floor plan of floor slab t=30cm Floor plan of shaftwals t=30cm
158 1210 Fiyse w10
E}'iz 12410 feree e Typical section
matz-n nonzon comer remmrceme
placed 4 ies.

e 1210

Foeeie W
Fines 1210
B QR
Section B-B i Fr g
o @ lol®

Tiyrea 1210

Bar schedule - bending shapes

marc [Pz | 8 | sege T e To e
wgm ipormsomm ]
e | em1 &) ol
A so| 1zl amm A 10920 B
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Exercise 5: creating a 2D door lintel with a 3D model (method
2)

You will draw a door lintel using the tools in the Draft module and
reinforce it using the tools in the Bar Reinforcement module. Based
on the reinforcement, a three-dimensional model will be created
automatically.

Door lintel 1:50

Elevation Section

@2312

| 1
@2038-10

248 14
| | | 3
1247 1.51 Tad7

You will save the door lintel as a symbol in a catalog. You will then
retrieve and modify it.

Door lintel 1:50

Elevation Section

@2912

|
@2% 8-10
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-

Exercise 6: creating 2D slab without a 3D model (method 3)

You will use the tools in the Bar Reinforcement and Mesh
Reinforcement modules to reinforce sections of the slab you created
in exercise 1. In this exercise you will not create a 3D reinforcement

model.
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Exercise 7: BAMTEC® reinforcement

You will use the tools in the BAMTEC module to reinforce a section
of the slab without a 3D model.

Dieses Elsen rot markiert! (

()e o8 -2006)2 68 -2005) 168 -2(k) 1008 -2
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Initial settings

Until now you have been working with the Palette Configuration
and you have activated tools by selecting the relevant family and
module in the Tools palette.

In the following exercises you will access tools in different families
and modules without setting them in the Tools palette first. This
requires the following settings:

o Select the Ej Engineering Views, Details family in the Tools
palette and open the B Associative Views module.

Tip: As the exercises in this e Show the Engineering toolbar, which contains the most
guide make constant important tools in the (o Engineering family on flyouts.
reference to the flyouts, we Click the status bar with the right mouse button and click
advi§e bookmarking or Engineering on the shortcut menu. Double-click the title bar of
making a copy of this page. the Engineering toolbar to dock it at top left.
Bar Entry and Placement flyout
)]
m Area Reinforcement flyout
+a

Mesh Entry and Placement flyout
BAMTEC flyout

Display flyout

Engineering Modify flyout

p B8 [0 & G

Reports flyout
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Exercise 4: creating a 3D elevator shaft with
a 3D model (method 1)

Tip: Look in the Allplan help
for basic information

on the reinforcement
methods:

[ Engineering
EGen eral Information
[ Floor pian and shell drawing
Key Plan module
[£=7 Reinforcement drawing
[ Reinforcement methods
E| Basic approach

Requirements:
Allplan 2014 Engineering comes in different module packages.

Open the Tools palette and check whether the (i Engineering and

[t Engineering Views, Details families include the following
modules:

@ Associative Views E Bar Reinforcement

Check whether the following tools are available on the Engineering
toolbar:

db Bar Shape
7S FF Components

In this exercise you will reinforce the 3D elevator shaft you designed
in exercise 2. First you will generate associative sections. After this
you will create the reinforcement with a 3D model (method 1). This
exercise requires exercises 1 and 2.

Start by selecting fileset 2 with the following drawing files:

Drawing |Drawing Drawing file name
file number

2 101 3D floor plan
201 General arrangement - 3D modeling module
202 Concrete component
203 General arrangement - walls, openings,

components module
204 Associative views

205 Reinforcement drawing with 3D model

You can find the fileset in the 'Engineering Tutorial’ project (see
”Appendix: creating the training project”).
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Floor plan of floor slab t=30cm Floor plan of shaftwalls =30cm
158 1210 dfj16a 1210
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Task 1: creating associative sections

In the first part of this exercise, you will use the architectural floor
plan and the 3D elevator shaft to create associative sections, which
Tip: For more information on will form the basis for placing reinforcement later (see Tip).
the & Associative Views
module, please consult the
Allplan help:

You will mainly use the tools in the @ Associative Views module.
You can access these tools in the Tools palette, Create and Change

o areas.
E Engineering
(=7 Engineering Views, Details.
[=7 Associative Views module
[ Basics
ESToole
E How To ...
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Tools: Objective:

ik Create Section

Fioor plan of Soor sBb =30cm Fioor plan ofshaft wals =30cm

[ Copy

B Modify View and
Section Properties

Ex

Properties palette

Secfon A4 Seclon 56

You can use the tools in the @ Associative Views module to create
clipping paths and views. These form the basis for the reinforcement
drawing later.

At first glance, associative views and sections would appear to be no
different from 2D data. However, they are derived from a three-
dimensional model and are therefore inherently linked with this
model.

The component displayed will automatically update to reflect any
modifications you make to the 3D component or in a view or
section. If, for example, you move an opening in the front elevation
or insert it in the floor plan later, the 3D component and all
associative views and sections of your general arrangement drawing
will adapt automatically. You can also make modifications in
isometric views.

Placing reinforcement has an immediate and direct effect on the
three-dimensional model and consequently on all the other views
and sections.

To create reinforcement, at least two orthogonal views or sections
are required. You can create any number of additional sections by
deriving them from the three-dimensional model. The reinforcement
is automatically displayed in the appropriate manner and can be
labeled immediately.

Sections are different to views in that they have a spatially delimited
depth. This delimitation is defined using two clipping lines.
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Start by making initial settings.

To select drawing files and to set options

< Open the Tools palette and check whether the i Associative
Views module (Engineering Views, Details family) is selected.

1 Click Lusl Open on a Project-Specific Basis (Default toolbar),
open the drawing file tree for fileset 2, select drawing file 204,
open drawing files 101 and 201 (or 203) in edit mode and close
all the others.

2 On the Window menu, click L1l Viewport if three viewports are
still open.

3 In the status bar, click the current Scale and select 1:50. Check
the current unit of length and set it to m, if necessary.

4 Click % Options (Default toolbar) and then Associative views.

5 Check that the Automatically transfer 3D components to
sections option is selected. If it isn't, select it.

©

el
General
Dimensions Update automatically
3D components to sections Transfer automatically
Global coordinate system Display in all views

View border

1 - 126 ] |-

100.0 mm

6 On the Format menu, click % Select, Set Layers, select the List
layers used in open documents option, click the ARCHITECTURE
layer structure and then the S# button at top left to expand the
tree structure.

7 Select the layers AR_GEN and AR_WALL, click the selection with
the right mouse button and, on the shortcut menu, choose
Modifiable.

Note: If you are using drawing file 203 instead of drawing file
201, the layer AR_GEN is not available. In this case, set the
AR_SLAB layer to modifiable.
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Layer - B X

Select Layer/Visibiity || Print Set | | Priviege Set | | Format Defirition | | Layer Structures

& ol &[] Piviege set: €l aLLpian -
Short name Full name Drawing type Scale definition >
DEFAULT DEFAULT

Contents of list box

¥ Architecturs

List layers assigned to tool selected last

1] AR_GEN Architecture, general ® Lt " 4 "
LI AR WALL L 18/ UstTayers Used in open documents
] AR_coL rchy
1] AR_SLAB Modifiable

1] AR_BEAM Visible, frozen L\\, yers

8 Select the List entire layer hierarchy option and expand the
ENGINEERING layer structure. Open the Shell layers and make

SH_GEN E Current and set SH_SHL to D Modifiable.

Layer - 0 %
Select Layer/Visibilty || Print Set | | Priviege Set | | Format Definition | | Layer Structures
& | = = (= 51| 40 | Frivilege set: &5 ALLPLAN -
Status Short name Full name Drawing type: Scale definition -
O DEFAULT DEFAULT
»  ARCHITECTURE Centents of st box
* ENGINEERING List layers assigned to tool selected last
*  Shel
I SH.GEN Shell. general List layers used in open documents
CICOCe8H._SHL Shell (®) List entire layer hierarchy
1010 SH_3DSHL 30 shell

You will begin by creating a plan view based on the 3D general
arrangement drawing. The height will not be delimited.

To create a plan view

1 Click E Create Section (Tools palette, Create area).
The layer set on the Format toolbar is used for the label. You
cannot select a different layer. The layer for the section is taken
from the 3D components. You can also specify it in the dialog
boxes for hidden line images and sections.

2 Select 3D elements of which you want to create a section: click to
the left of the elevator shaft’s upper floor slab and enclose it in a
selection rectangle without releasing the left mouse button (see
below). This selects the elements fully bounded and intersected by
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Tip: In Observer mode, the
bottom edge is placed so that
it is always horizontal; in
other words, horizontal edges
are always horizontal,
regardless of the viewing
direction.

When set to Folded, however,
the section created is folded.

the selection rectangle (@ Select elements based on direction is
enabled in the Filter Assistant).

G,
227
%
2.2
Note:

You can also activate m Select elements fully bounded and
intersected by selection rectangle in the Filter Assistant and
define the selection rectangle independently of the direction.

On the Create Section Context toolbar, you can switch between
Observer and Folded by clicking the buttons. Select Observer.

Create Section *
Ref. Mode |  Observer
Soffit No
Cancel

Select viewing direction: click in the circle. This has the effect
that the object is viewed from the top when the section is
calculated.

From point: click to the left of and below the bottom left corner
of the upper floor slab (see below).
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6 To point: click a point above the top right corner of the upper
floor slab (see below). Then press ESC to finish.

s
l

gﬂ'll

o277 R Y, % VWIIIIJ}?

The View and Section Properties Context toolbar is displayed
and the section is attached to the crosshairs.

7 The Status box is set to Hidden. If it isn’t, click the box to switch
to the hidden line image.

8 C(lick the Def... button on the View and Section Properties
Context toolbar to open the Settings for hidden line images
dialog box. Check that the Display visible edges option is
selected. In addition, select all the settings for Display hidden
edges, specify the following format properties and click OK to
confirm the dialog box.

Visible edges:
Pen 0.35 mm; do not change the line and color; layer SH_SHL

Hidden edges:
Do not change the pen, line and color; layer SH_SHL
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View and Section Properties

i?
==

N X Fet 1.000 Status Hidden Accelerated Nao
& YR 1000 Hidden|  Def

Convert

Fitter

D i )
= g

Settings for Hidden Line Images

Surface elements
*) Ne surface elements
Cnly fills from colars
Create bitmaps from textures, fills from colors

Surfaces...
Consider light H
Light angle in view (left / right)
Light angle to visible axis (length of shadow)
Light intensity

Fill-in light intensity

Adjacent edges
Remove adjacent edges

2500 Max. angle (degrees)

Adjacent edges for archit. components

Display adjacent edges between different surface elements

Display adjacent edges for reund compenents (wall, column, chimney)

Representation

Specdial settings

For architectural sections

Result = Pen 5= Line
Display visible edges 035 1
Display hidden edges 018 2 ————

(_\ Color

2 Layer

1 N [¥] SHSHL
25 = [v] SH.SHL

G d

OK

Cancel

9 On the View and Section Properties Context toolbar, click

a4l
Section settings for associative view beside =z4i.

& 7

"
H
"

Cancel

10 In the Representation of clipping path area, select the Place
clipping line option. In the Section display area, select the Apply
thick line around intersected elements option and then Exterior
edges. Finally, select layer SH_SHL for all linear elements and
click OK to confirm the dialog box.
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View and Section Properties
K Fet
Y Fet

1.000
1.000

Leave the other settings as they are.

Convert D
Fitter Off

Status | Hidden Accelerated No

Hidden Def...

a4l

B} =l
o

Section

Representation of clipping path
Place clipping line

- Direction symbal

Length of line segments

Size in mm/inches

Section display
Display boundary lines

0.1000 Prajection of boundary lines

Apply thick line around intersected components
*) Exterior edges All edges
Display surface elements of intersected components

Display hidden and intersected edges

Format properties for = Pen 7= Line © Calor =] Layer

Clipping Path 0.50 5 —-—-- 1 I SH_SHL

Boundary lines 0.25 4 — — — 1 I SH_SHL

Thick line for border 0.50 1 1 I SH_SHL

Hidden and intersected... 0.18 15 - - - - - - 25 SH_SHL

Surface elements Y Hatching &a Fill % Style Area

3D objects 303 443 [ 1 30 1 301 Reinforced...
Hidden areas 303 351 E 28 [ 1 301 Reinforced...

Label
Text parameters | &

Section identifier

Sed

Text parameters..,

Section object
Display section object (as construction lines)
Height of section object based on intersected elements.

Top level Bottom level

oK

Cancel

Tip: Track tracing helps you
place points in exact
alignment with existing
points. You can press the F11

key or click the A" Track line
icon in the dialog line to
quickly switch track tracing
on and off.

s 7

u
=
4

Cancel

11 On the View and Section Properties Context toolbar, click

L
I Dimension Line to switch off dimensioning.

12 To point or angle of rotation: place the section so that it is to the
right of and aligned with the architectural floor plan.

13 Press ESC as you do not want to define additional sections.

14 To define the label for the plan view, enter

Floor slab, t = 30cm

in the dialog line and press ENTER to confirm.

15 Set the label’s parameters (text height 5mm, text width 4mm) and

place the label for the view.
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You will now create a longitudinal section and a transverse section
based on the plan view you generated beforehand.

To create sections

2 The :ﬁ Create Section tool is still active. If it isn’t, activate it
now.

1 Select 3D elements of which you want to create a section: select
the entire plan view you created beforehand by enclosing it in a
selection rectangle or by clicking the view border.

2 Select viewing direction: click below the circle. The effect of this
is that the object is viewed from the front when the section is
calculated.

3 Define the clipping area by clicking the bottom left corner and
the top right corner in the area of the door opening (see below).
Then press ESC to finish.

%%
4 On the View and Section Properties Context toolbar, click

a4l
Section settings for associative view beside z4i and make
the following settings in the Section object area of the Section
dialog box:

e Select the Display section object (as construction lines) check
box.

e Clear the Height of section object based on intersected
elements check box and enter
-2.29 for the top level and -4.49 for the bottom level.
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e C(lick OK to confirm the dialog box.

Secticn object
Display saction object (as construction lines)

Height of section chject based on intersected elements

Top level -2.2800 Bottom level -4.4900

QK Cancel

5 To point or enter a rotation angle: place the section so that it is
below and aligned with the floor plan and press ESC.

6 Enter the label for the section in the dialog line, press ENTER and
place the label.

7 The & Create Section tool is still active. Select the plan view
again and create the longitudinal section (viewed from the right).

8 Place the section to the right of the transverse section.

9 Press ESC to quit the tool.

Note: You can configure the program to automatically dimension
associative views and sections. All you need to do is enable the type
of dimension line you want to use and make appropriate settings on
the View and Section Properties Context toolbar.
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Tip: If no tool is active, you
can also open the
modification tool by double-
clicking the section with the
left mouse button.

Finally, you will copy the plan view and modify the height settings
in order to display the floor slab and shaft walls separately.

To copy the plan view and to adjust the height
1 click I copy (Edit toolbar).

2 Select the entire plan view by enclosing it in a selection rectangle
or by clicking the view border and place the copy so that it is to
the right of and aligned with the plan view.

3 C(lick & Modify View and Section Properties (Tools palette,
Change area) and select the entire plan view on the left.

4 On the View and Section Properties Context toolbar, click

M Section settings for associative view and make the
following settings in the Section object area of the Section dialog
box:

o (lear the Height of section object based on intersected
elements check box and enter
-4.00 Leave the bottom level as it is: -4.49.

e C(lick OK to confirm the dialog box.

Section object
Display section object (as construction lines)

Height of section object based on intersected elements

Top level -4.0000 Bottom level -4.4800

QK Cancel

5 Click Apply to confirm the View and Section Properties Context
toolbar.

6 Use the same approach to modify the height settings of the plan
view on the right. Enter the following values:
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e Top level -2.75.

e Bottom level -3.15.

Section object
Display section object (as construction lines)

Height of section chject based on intersected elements

Top level -2.7500 Bottom level -3.1500

OK Cancel

7 Press ESC to quit the tool, switch to the
Properties palette, click the label of the plan view on the right
and change it as shown below.

Floor plan of floor slab +=30cm Floor plan of shaft walk t=30cm

Sedion A-A Section B-B
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Task 2: edge reinforcement of floor slab

Tip: Refer to the chapter
“Reinforcement methods - 3D
reinforcement model” in the
Allplan help:

[=7Engineering
E|Ger| eral Information
[EFioor plan and shell drawing
ESKey Plan module
[=7 Reinforcement drawing
[=7 Reinforcement methods
Basic approach

Now you will place bar reinforcement and create a three-dimensional
model as you go along (method 1; see Tip).

You will mainly use the tools in the &G Bar Reinforcement module.
You can access these tools using the flyouts on the Engineering
toolbar and the shortcut menu.

First you will create the edge reinforcement of the floor slab using

the dh Bar Shape tool, which provides additional options for

entering reinforcement in comparison with the L Enter tool.

For the longitudinal direction, you will create the bending shape
as a freeform bar by specifying individual points.

For the transverse direction, you will use a predefined bending
shape that expands to adapt to the existing outline.

Tools: Objective:

XK

4y

G

] [ =

(E

B

iy

Options Floor plan of floor siab £=30cm Floar plan of shaftwalls t=30om

Bar Shape: —

vl
g

4 ///.W;/’////d///)y///

Freeform

s 121

Place Bar Shape: |
Along placing line |

7
T T

R

Copy and Mirror
Label

‘Sedion AA Section BB

Dimension Line, Label

Bar Shape:
Open Stirrup

Modify Placement
Display Mode
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Tip: You can specify how bar
reinforcement is displayed

using the .4 Options for the
Bar Reinforcement module.

For more information please
consult the Allplan help.

Start by making initial settings.

To select drawing files and to set options

1

Click Open on a Project-Specific Basis (Default toolbar) or
double-click in the workspace with the left mouse button. Make
drawing file 205 current.

Drawing files 101, 201 (or 203) and 204 are now D open in
edit mode.

Note: If the Automatically transfer 3D components to sections
option is selected and you are working in a workgroup
environment, you need to open drawing file 204 in F reference
mode to ensure a smooth workflow.

Close the dialog box and check the current reference scale (1:50)
and unit of length (m) in the status bar.

Check whether the Engineering toolbar is displayed at top left. If
it isn’t, open it as described in the initial settings (on page 120).

Switch to the Tools palette and define the DEFAULT layer as the
current one.

Use the & Modify View and Section Properties tool to hide the
section object in each of the two sections.

Select Reinforcement drawing for the drawing type in the status
bar.

The hatching in the sections changes to fills.

Click Led Open on a Project-Specific Basis again and close
drawing files 101 and 201 (or 203).

Before you start, you need to specify whether Allplan is to create a
3D reinforcement model (see Tip on page 134).

In this exercise, you will work with the reinforcement model (method
1). This means that the reinforcement placed will be managed
internally by the system and displayed in all the views and sections

that are created using the tools in the B Associative Views module.
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Tip: Allplan also provides a
predefined bending shape for
creating open stirrups. You
will use it later when you
enter open stirrups in the
transverse direction.

For the reinforcement of the floor slab, which is 30 cm thick, you
will create two-way bar reinforcement of #12/10 cm in the top layer
and @10/10 cm in the bottom layer. The concrete cover is 4 cm.

The layer BR_GEN is proposed for bar reinforcement. You can use
this layer as it is not necessary to differentiate between the upper
and lower reinforcement layers.

You will place the reinforcement on several layers when you create
the slab reinforcement in exercise 6.

Start by creating the freeform bending shape of the open stirrup in
the longitudinal direction.

To enter the open stirrup as a freeform bending shape

1 Click 4 Options (Default toolbar), select the Reinforcement page
and check that the Reinforce with 3D model option is active in
the General area.

2 Click db Bar Shape (Bar Entry and Placement flyout).
Check that the layer BR_GEN is selected. If it isn’t, activate it on
the Format menu or toolbar.

The Bar Shape palette opens and the Freeform bending shape is
active by default. You can use it to create any bending shape. To
use a different bending shape, click the button above the graphics
area and select one of the predefined shapes.

Click E] to open a dialog box that displays all the bending
shapes graphically in groups.

‘ Bar Shape ? | Selection

Tools ||Bar Shape ||wizards | Library | |Connect| | Layers

[\J Freeform
|Freef0rm v|

= Closed stimups

D Stimup, closed
D Torsion stimup
@ Diamond stimip
® Circular stimup
W Polygonal stimup
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3 In the parameter area of the palette, select diameter 12, enter
0.04 for the concrete cover and clear the Hook at start and Hook
at end check boxes.

4 General
Mark number 17
Concrete strength grade  ©25/30

Cross-secticn catalog Retonstabstahl (B)

Diameter 12
Bar length 7
Per meter [}
4 Geometry
Same concrete cover
Concrete cover 0.04
> Segment 70

> Bending position 0
Initial segment
Final segment
Hook at start
Hock at end

ooy -

4 To enter the open stirrup, click the points in section A-A as
shown below. The next step is to define the segment length.

A 1st point
B 2nd point
D C
C 3rd point
Al \B D 4th point

5 Press ESC to finish entering the open stirrup.

6 In the parameter area of the palette, enter 0.80for the length of
the Initial segment and the Final segment.
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Note: You can still change almost all the parameters. Any
changes you make are immediately displayed in the preview.

4 Geometry
Same concrete cover
Concrete cover 0.04
> Segment 3/3

> Bending positicn g,

Initial segment 08

[Fino scqment L
Hook at start =
Hook at end [

7 Press ESC to finish entering the bending shape. As the Label
option was active in the input options when you created the bar

shape, the 5 Label tool starts automatically.
To finish entering the bending shape and to label the bar, click in
the workspace with the right mouse button and select the

Abc
i Label tool on the shortcut menu.

8 Make settings for the mark text in the palette.
Select the Options for text parameter and click E], enter 1.00 for
the aspect and click OK to confirm.

9 Place the mark.

10 This defines the bending shape. If you want, you can continue
and immediately place the open stirrup you just created.
However, you can also press ESC and place the mark later using
the s Place Bar Shape or .=# Place tool.

In this exercise you will place it now.
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Tip: The entries you make are
immediately displayed in the
preview. This way, you can
check the effects of your
settings at any time.

To place the open stirrup in edge-based mode

1
1 The palette of the &= Place Bar Shape tool is open and Linear

placement is selected.

If it isn’t, click the open stirrup you want to place v1vLith the right
mouse button and, on the shortcut menu, choose *#*' Place Bar
Shape.

|Place Bar Shape ‘]l|

Tools || Place Bar shape | Wizards | | Library | | Connect | | Layers

[LII"IEEF placement V]

Mo TITTT

L

LT

Click the edges of the outline to define the placing area.
Placing line from point: click the bottom right corner in plan
view.

Placing line to point: click the top right corner (see illustration).

Symbols indicate the placing region.
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Tip: Refer to the chapter
"Reinforcement methods -
placing mode: align [ move /
rotate” in the Allplan help:

4 [F=rEngineering
+ E3General Information
3 EF\DM plan and shell drawing
3 EKey Plan medule
4 [=7 Reinforcement drawing
4 [=7 Reinforcement methods
3 E|Elasic approach

Using the input options, you can define the position of the placed
bar, specify how the placement is to be displayed and select
automatic labeling.

Input Options

x
| Aign |||[|_] ||n Jw |l 8bc

Select the Align option and set the placement display mode to
| Show middle bar only.

Align uses the spatial orientation and position of the identified

mark and places the reinforcement in alignment (see Tip).

In the parameter area of the Place Bar Shape palette, enter 0.04
for the concrete cover and 0.10 for the spacing. You can leave
the other settings as they are.

4 Placing region
Placing line Defined
Same concrete cover
Concrete cover 0.04
4 Reinforcement
vark number 14
Component factor 1
Layer factor 1
Murnber 30
Soocng (B .
Input parameters Spacing
Sectional format 1
Reinforcement percentage 11.31
4 layer
Placing length 292
Edge offset <} Start = end
Start 0.004
End 0.004

el
5 Click 3 Dimension Line, Label on the shortcut menu.

Alternatively press ESC twice to quit the tool and to start the

[
9 Dimension Line, Label tool.

6 Make settings for the dimension lines in the palette.
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7 Select the Dimension line options line and click E] The
Dimension Line dialog box opens. Check that the layer BR_GEN
is selected. Change the aspect to 1.00.

[Bar Label 2]

Tools | Barlabel ||wizards || Library || Connect| | Layers

[Dimen;ion line v]
Dimension Line x
Amowhead
| | Size in mm/inches 40
Short slash - 12 12
Amonhesd 7 Shor i 180 114, 1.38
Ll |- |- |-
il 1 1 il
Advanced settings
a o o a o | Show dimension line
Same for all elements Pen Line Color
Dimension line/mark sym...| Text/leader Elemert = Pen &= Line ) Color £ Layer
4 Di A Dimension line 0.18 1 —— 1 I DEFAULT
imension fine Bxtension lines 0.25 1 1 S DEFAULT
Dimensicn text [ Symbol 0.25 1 NN DEFAULT
Nurnber of spacing valt [ Numbers et 0.25 1 I DEFAULT
Dimensicn line text ]
Text || Dimension Text
Bar markers Ll eneon
- T Adal - [emf- [ wmf[-] (BT L

8 Click OK to confirm the Dimension Line dialog box and click a
point through which the dimension line is to pass.

The palette switches to the Text/leader tab, where you can define
the label for the placement.

9 Specify the parameters as shown, select the Options for text line
and click E], enter 1.00 for the aspect and click OK to confirm.
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Note: Automatic mark number is selected in the input options.
Depending on the drop-in point specified, the program
automatically creates the mark number at the beginning or end of
the label. You can check this by moving the crosshairs over the
workspace.

[Bar Label #]

Tools

Bar Label ||Wizards| Library |Connect|| Layers Input Options L

[Dimension line ']

| Automatic mark number m

(10)80 210 -15

Dimension line/mark sym... Text/leader |_

4 Label
Mark number
End with mark number e
Mumber of pieces
Diameter
Steel grade
Spacing
Layer
Position
Length
Custom text
Bending shape
Two-line text
Options for text

4 Leader
Text leader Automatic
Leader end symbol ]

=

T

30 @ 17410(‘?’

i o S U )

10 Place the label and press ESC to quit the tool.

Note: When you click % Zoom All, you can see that Allplan has
created not only the reinforcement in the associative views but also
a reinforcement model of the 3D elevator shaft.

i

To hide the model data, use “ to define a section and click & to
save this section.

The procedure was described in unit 2 when you created the
architectural floor plan.



Engineering Tutorial

Unit 4: Reinforcement Drawing 143

Displaying and labeling placements

When placing reinforcement, you can specify the placement display
mode in the input options or in the dialog box:

||| Al the bars are displayed.
| Only the bar in the middle is displayed.
|| You can select the bars to be displayed.

Jw A single bar is displayed as folded. This defines the exact
position of the bar, which is required for placing it on the
building site. Allplan presents the different directions in which
the bar can be folded. Select the direction you want to use.

]
You can use the "= Modify Placement Display Mode tool to change
the display later.

Labels can be placed at any time. The Display flyout provides the
following tools for creating labels at a later stage:

] Label

=4
9 Dimension Line, Label

Reinforcement placed is displayed in all the views and sections.
During creation, however, reinforcement can only be labeled in the
placing view. You need to place labels in all the other views and
sections later.
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Tip: To activate general edit
tools, you can also click in the
workspace with the right
mouse button and select a
tool on the shortcut menu.

Tip: Track tracing helps you
define the 2nd point of the
mirror axis. You can press the
F11 key or click the A Track
line icon in the dialog line to

quickly switch track tracing
on and off.

Instead of placing the bar again on the opposite side, it is easier to
mirror mark 1. You can then label the reinforcement.

To copy and mirror the placed reinforcement

1

Click 4'-1“'5 Copy and Mirror (Edit toolbar).
Click the bar in the section.

Define the mirror axis:

1st point of mirror axis: using the right mouse button, click a

horizontal line of the floor slab in the transverse section and click
Midpoint on the shortcut menu. Make sure that you do not

click the midpoint of the line or any other existing point.

2nd point of mirror axis: in the dialog line, enter a value that is
not zero for the

AY Y coordinate and press ENTER to confirm.
Press ESC to quit the tool.

Using the right mouse button, click the bar in the section and
select 3 Label on the shortcut menu.

Place the mark where you require and press ESC to quit the tool.

]

— "0

Lm

Due to the three-dimensional association of the sections, the
mirrored placement is also displayed in the floor plan. Click the
bar in the floor plan with the right mouse button and, on the
shortcut menu, click E Dimension Line, Label to label the
placement.
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8 Place the dimension line and the label to the left of the floor plan
and press ESC to quit the tool.

[=] D
= =
I I
o N
o o
© |BY e
< T <O
m m
8

As an alternative, you will now use a predefined, expanding bending
shape to create the edge reinforcement in the transverse direction.
Finally, you will place the bending shape automatically.

To create an expanding open stirrup and place it
automatically

1 Click dh Bar Shape (Bar Entry and Placement flyout) again.

2 Select the Open stirrup bending shape in the list box at the top
of the Bar Shape palette

| Bar Shape 2 ‘

Tools ||Bar Shape ||Wizards || Library | Connect || Layers

IOpen stirrup [ 'I
F]
e,
H? 4 p@
S I

3 In the parameter area of the palette, select diameter 12 and clear
the Same concrete covers check box as these bars are in the
second layer. Change the values for Concrete cover 1 and 3 to
0.055 each and the value for Concrete cover 2 to 0.04.
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4 Enter 0.80 for Segment length 1 and 3 and clear the Hook check

box.

4 General
Mark number 2
Concrete strength grade  C25/30
Cross-section catalog Betonstabstahl (B)
Diameter 12
Bar length ?
Per meter &

4 Geometry
Same concrete cover [
Concrete cover 1 0.035
Concrete cover 2 0.04
Concrete cover 3 0.055
Segment length 1 0.8
Segment length 3 08
Hook
Bending pin factor 4

5 In section B-B point to the bottom right edge of the floor slab
until the open stirrup expands correctly, then click the left mouse
button.

-

5

6 Press ESC and place the label for the bar in the section.

7 Select the 1k Place automatically option in the input options.

Input Options x
E\ﬂﬂ | Align = m | Abc
| Automatic placement i

Using automatic depth placement, the bar is immediately placed
in the floor plan of the floor slab.
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10

11

12

13

Note: 1F Automatic depth placement is only possible when you
create the bending shape in a 3D outline and place it immediately
afterwards.

In this case, you cannot define the the placement display mode:

|11 all the bars are always displayed.

=4
Select 23 Dimension Line, Label on the Repeat menu, click a bar
in the placement you just created and place the dimension line
and the label.

To copy these bars to the lower part of the floor plan, click

ﬂ“i Copy and Mirror (Edit toolbar) and select the placement as an
entity group in plan.

1st point of mirror axis: using the right mouse button, click a

vertical line of the floor slab in plan and select v Midpoint on
the shortcut menu.

2nd point of mirror axis: in the dialog line, enter a value that is

not zero for the
AX X coordinate and press ENTER to confirm. Press ESC.

Using the right mouse button, click one of the placements in
)
plan, select = Modify Placement Display Mode on the shortcut

menu and activate | Show middle bar only for both
placements.

Input Options  *

HELE [ e
-

Abc =
Use the shortcut menu and the i3 Label and £23 Dimension Line,
Label tools to create labels for the bottom placement in the
section and plan.
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Floor plan of floor slab t=30cm Floor plan of shaft walls t=30cm

v 7z Z 7
|\ J : g
& 7 o
s . 7 5 ,
5 |15 ’
i E 2
|
’ e ’ , [ G ~ .fl
T - )
L ]
! @252-12-1-3 !
Section A-A Section B-B
%f 7
. 7, _,; f,/
i
7 7 /
/ ] |
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Task 3: Area Reinforcement of the Floor Slab

Tip: You can also select the
Create menu and click
Engineering, Bar
Reinforcement, J]I Enter
Area Reinforcement and

choose il Span
Reinforcement on the

Context toolbar that appears.

Enter Area Reinforcement *

i R L

Cancsl

The edge reinforcement of the floor slab has been placed. The
following part of the exercise involves creating area reinforcement.

Tools: Objective:

il

[
@&

[lek
[

Z

Enter f;) 25 ¢ 12 -10
Area Reinforcement

Span Reinforcement ST s
New Mark Number ‘ ; °
Modify Mark ; o | o
o =1 e
Modify Placement m -
Display Mode @ @ -

@ 25 ¢ 10 10| dnfen

Al

\e) 25 & 12 -10 oben

25 0 12 -10

You will start by creating two-way bar reinforcement.

To create span reinforcement for the bottom layer

1

2

Click [m] Span Reinforcement (Area Reinforcement flyout).

Check that the layer BR_GEN is selected. If it isn’t, activate it on
the Format menu or toolbar.

From point or element / enter offset: click the bottom left corner
in the floor plan.

To point or element / enter offset: enter -0.04 for the support
depth in the dialog line.

Entering a negative value moves the placing polygon towards the
inside.
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5 Click the top right corner of the floor plan.

@25 ® 12 -10
| |

o
v

6 Press ESC to finish. This selects the area.

Enter Area Reinforcement x
e 5 o2m = 4490 - it
of K IER | R

I

H

OK Cancel

7 Define the layer depth. Click in the box beside - Layer Depth.
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8 Layer in reference view: click the bottom left point in section B-B.

The dashed line indicates the current layer depth of the
reinforcement. The concrete cover is taken into account. The
elevation symbol shows the layer depth of the definition point
entered. The direction of the positive bar segments and the
placing direction of the bar are indicated by the arrow.

9 C(lick Concrete Cover (Bottom) and enter 0.04. In section B-B
you can see how the dashed line moves.

10 Click OK to confirm the entries.

Enter &rea Reinforcement x
A [ 1400 Al oo o osw : e | b —— 1. G
g nam & 7880 M 246 0.005 0.005 = TS

OK Cancel

11 Set placing parameters:
Diameter 10,
Spacing 0.10,
Angle 0.00,

Select PP (= placement in polygon) at bottom right.
As the bars and the edge reinforcement are congruent in the floor

plan, set the placement display mode to Ik Show selected bars
to ensure that the edge reinforcement is not hidden.

12 Click OK to confirm.



152 Exercise 4: creating a 3D elevator shaft with a 3D model (method 1) Allplan 2014

13 Select the bar you want to display: all the bars are displayed in
the selection color in the preview. Click a bar in the upper part
and press ESC.

14 Select the Bar markers option, specify the symbol type and place
the dimension line.

Dimension line/mark ... Text/leader

4 Dimension line
Dimension text B
Mumber of spacing values []

Dimension line text 0
Symbol type 4% Circle
Symbol size 4.00 mm

Dirmensicn line options

15 Select the Custom text parameter, type in bottom in the line
provided for defining text and place the label.

16 Next, you will place the transverse reinforcement. You do not
need to enter the general arrangement polygon again. You can
copy the one you used for the longitudinal reinforcement. Click
Match in the input options.

Input Options *
Match

17 Select the polygon you want to match: click the existing polygon.

18 The system will automatically propose 0.050 for the concrete
cover at bottom. Increase this value to 0.055 (this is to take the
bar ribs into account) and click OK to confirm.

19 The system will automatically propose 90 degrees for the placing
angle. Check the settings and click OK to confirm.

20 Select a bar to be displayed and place the dimension line and the
label to which you have added custom text.
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The bottom layer should now look like this:

; 25 ¢ 12 -10

30 ¢ 12 -10
30 @ 12 -10

<
=)
S
A
@zswwowo nfen

li;ZS‘D 12 -10

Now that you have completed the bottom layer, you should be able
to create the bars for the top layer yourself. The following section
should serve as a guideline.

To create span reinforcement for the top layer

1 The [m] Span Reinforcement tool is still active. If it isn’t, select it
now.

2 Match the existing general arrangement polygon.

3 To define the = Layer depth, click the top left point of the floor

slab in section B-B and enter 0.00 for the . Component
thickness.

4 (Click Concrete Cover (Top) and enter 0.04.
5 Confirm the settings and set the placing angle to 0.00 degrees.
6 Change the diameter to 12 in the dialog line and confirm.

7 Select a bar to be displayed and place the dimension line and the
label to which you have added custom text (here: "top”).
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8 Use the same approach to create the second reinforcement layer
at the top. Bear in mind that you need to associate the layer
depth with the top level and click Concrete Cover (Top) after you
have copied the general arrangement polygon. Here, too, set the
diameter to 12.

The floor slab should now look like this:
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Instead of creating the top layer from scratch, you can copy and
mirror the bottom reinforcement.

[=]
pun

As the diameter of the top bars is 12 mm, you need to assign new
mark numbers to the bars of the mirrored reinforcement using the

& New Mark Number tool (Engineering Modify flyout).

You can then change the diameter using the o Modify Mark tool
and select the bars to be displayed and place labels using the

o
"= Modify Placement Display Mode tool.
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Task 4: starter bars

The reinforcement for the floor slab is complete. Now the wall
reinforcement is missing. This part of the exercise involves placing
the starter bars.

Tools: Objective:

Jdb Bar Shape:
Open Stirrup
Stirrup, closed

Modify Placement

|
Display Mode
- H—@

Place Bar Shape:
Along placing line

iy

Y
£

&

1

't5 Dimension Line, Label

To enter and place starter bars

1 Using the right mouse button, double-click the open stirrups of
the floor slab wherever you like.

The dh Bar Shape tool starts and the Open stirrup bending shape
is active. The diameter is set to 12.

|Bar Shape 1 |

Tools ||Bar Shape | Wizards | | Library | |Connect| | Layers

[Open stirrup ']

4 General
Mark number 7
Concrete strength grad €25/30
Cross-section catalog  Betonstabstahl (B)
Diameter 12
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2

Check that the layer BR_GEN is selected. If it isn’t, activate it on
the Format menu or toolbar.

In the parameter area of the palette, select the Same concrete
covers check box, enter 0.04 for the Concrete cover and 1.00 for
the Segment length 1 and 3.

4 Geometry
Same concrete cover
Concrete cover 0.04
Segment length 1 1

Segment length 3 1
Hook ]
Bending pin factor 4

4 In section A-A point to the left outer edge of the wall until the

open stirrup expands correctly, then click the left mouse button.

[

4
Press ESC to label the bar.

Place the bar label in the section.

1F prace automatically is still set in the input options. The open
stirrups are placed across the entire shaft wall on the left in the
floor plan.

If they aren’t, click ™ New placing line in the parameter area of
the palette and define the placing line accordingly.
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4=
7 Select E Dimension Line, Label on the Repeat menu, click a bar
in the placement you just created in plan, deactivate the Bar
markers option and place the dimension line.

8 Deactivate the Custom text option and place the label.

9 Press ESC to quit the tool, click the placement in plan with the

)
right mouse button and, on the shortcut menu, choose "= Modify
Placement Display Mode.

10 Choose | |k Show selected bars, click the three bars just below the
middle (see following illustration) and press ESC twice.
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The floor slab should now look like this:
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Now you will place mark 7 in more walls.

Remember: you inserted a door opening in the wall on the right
when you created the floor plan of the basement. In this region,
mark 7 will not be placed. You will use closed stirrups instead. The
placing region for mark 7 will be defined in the floor plan of the
shaft walls. The placed bars, however, will only be displayed in the
floor plan of the floor slab as the starter bars are not within in the
clipping area of the shaft walls.

To place and rotate starter bars

1t
1 Click & Place Bar Shape (Bar Entry and Placement flyout) and
confirm the value displayed in the dialog line: mark 7.

2 Deactivate the Align option in the input options.

3 Place mark 7 in the lower transverse wall (from left to right). To
define the end points of the placing line, click the points where
the inside edges of the longitudinal walls and the outer edge of
the bottom wall intersect (use X Point of Intersection on the
shortcut menu).
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Tip: The sequence in which
you enter points is irrelevant
with the Align placing mode.
With the Move or Rotate
options, however, the
sequence in which the points
are entered defines the
direction of the placing
region.

Refer to the chapter
"Reinforcement methods -
placing mode: align [ move |
rotate” in the Allplan help:

4 [=7 Engineering
+ £ General Information
3 EHDDI’ plan and shell drawing
3 EKey Plan module
4 [=7 Reinforcement drawing
4 [=7 Reinforcement methods
3 E Basic approach
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In the parameter area of the palette, set the Angle of rotation to
Perpendicular. The preview of the bending shape changes
accordingly.

Lo |

4 Placing region

Placing line Defined

Relative to placing line Left Input Options &
Perpendicular - Align =T Ilw| Jw | ¥ Abe
Same concrete cover % Ly

Concrete cover 0.04

In the input options, click 1N Show selected bars, select the bars
you want to display and press ESC.

Click in the workspace with the right mouse button and choose
=

Y9 Dimension Line, Label, place the dimension line and the label
in the floor plan and press ESC to quit the tool.

Use the J'-1|L"- Copy and Mirror tool to copy the reinforcement and
its label to the transverse wall at the top. (Alternative: do not
change the Angle of rotation and continue to place the bars in
the transverse wall at the top.)
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8

11
Click & Place Bar Shape again and confirm the value displayed
in the dialog line: mark 7.

The Align option is not active, and the angle of rotation is set to
Perpendicular.

Placing line from point: click the bottom right outer corner of the
30 cm shaft wall in the floor plan of the shaft walls.

10 Placing line to point: click the point where the lower reveal and

11

12

the 30 cm shaft wall intersect.

i — ‘#‘9

The placing region is highlighted in the floor plan of the shaft
walls, and the placement is displayed in the floor plan of the
floor slab. As the starter bars for the wall are not within the
clipping area of the shaft walls, all the bars are displayed,
regardless of the selected display mode.

Press ESC to finish.

Use the same approach to place the starter bars above the door
opening. To define the first point of the placing line, click the
point where the upper reveal and the 30 cm shaft wall intersect.
Click the top right outer corner of the 30 cm shaft wall to define
the second point of the placing line.



Engineering Tutorial

Unit 4: Reinforcement Drawing 161

4=
13 Select &3 Dimension Line, Label on the Repeat menu, click a bar
in the placement you just created in the floor plan of the floor
slab and place the dimension line and the label.

14 Create the dimension line and the label for the second placement
and press ESC to quit the tool.

15 Using the right mouse button, click one of the placements in the
)
floor plan of the floor slab, click "= Modify Placement Display
Mode on the shortcut menu and select | Show middle bar

only.

16 The display of the placement clicked changes. Click the second
placement and press ESC to quit the tool.

You will now create and place a closed stirrup in the wall near the
door opening.

To create and place a closed stirrup in the door area

1 On the Repeat menu, click dh Bar Shape.
Check that the layer BR_GEN is selected. If it isn’t, activate it on
the Format menu or toolbar.

2 Select the Stirrup, closed bending shape in the list box at the top
of the Bar Shape palette.

3 In the parameter area of the palette, select diameter 12 and enter
0.04 for the concrete cover.
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4 Move the crosshairs in section A-A over the left outer edge of the
wall on the right until the open stirrup expands correctly, then
click the left mouse button.

M

®
Qg's O

5 Press ESC and place the label for the bar in the section.

6 Automatic depth placement is not useful as the stirrups are only

placed around the door opening. Deactivate the 1F prace
automatically option in the input options. The Align option is
active.

7 Define the placing line by clicking a corner of the upper reveal in
the floor plan of the shaft walls and then the corresponding
corner of the lower reveal.

=4
8 Select &9 Dimension Line, Label on the Repeat menu and create
dimension lines and labels for the placements in the floor plans.

]
9 On the Repeat menu, click "= Modify Placement Display Mode,

select | Show middle bar only and click the placement in the
floor plan of the floor slab.

10 Press ESC to quit the tool.
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This completes the starter bars for the walls.

Floor plan of floor slab t=30cm
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Task 5: bar reinforcement for the walls

Tip: To create complex
bending shapes (e.g. bent-up
bars for silos, towers or barrel
roofs), you can use the

= Convert, Match Elements
tool to convert a bending
shape you have drawn using

the 1N Draft module to a bar.

When converting, Allplan
interprets the design entities
as the center line of the bar.
This should be borne in mind
when you create them.

The following part of the exercise involves applying reinforcement to
the walls up to the top level of the floor slab (TL = -2.79). You will
enter the reinforcement in the floor plan of the shaft walls.

Tools: Objective:
@l Bar Shape: Section AA
Freeform
Straight bar .
L-shaped bar @_7@:' :.
wi Place Bar Shape: @ 'j f é%
Al lacing li rzy I :
one pracing Tne 1212 2 (I g G%E?@ua 12-10
@ Modify View and o (Fhe12-10
Section Properties % i
e S 7 =
i Define Batch Wi 1010
@ 10 -1
w Place:

il Place in Batch

i Reinforcement Tools

Due to the offset, a cranked bar needs to be created for the exterior
wall reinforcement. You will create this bar manually using the

Freeform bending shape provided by the db Bar Shape tool.

To manually enter and place cranked bars
i}

1 Select the =F Bar Shape tool again and select Freeform.
Check that the layer BR_GEN is selected. If it isn’t, activate it on
the Format menu or toolbar.

2 Clear the Same concrete covers check box and enter 0.00 for the
Concrete cover at start and Concrete cover at end.

3 Click the arrow to the left of the Segment parameter and enter
0.04 for the Concrete cover of segment.

4 (Click the two outside corners of the top left wall in section B-B.
Start at the top.
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Tip: You can also define the
segment type in the graphics
area.

5 In the parameter area of the palette, set the Segment type to

Crank and click the point where the shaft wall and the upper
floor slab intersect.

4 Geometry
Same concrete cover B
Concrete cover at start 0
Concrete cover at end 0
4 Segment
Segment type

Concrete cover of segm
> Bending position
Initial segment
Final segment
Hock at start
Hook at end

The segment type automatically switches back to Default. To
define the last point, click the point where the shaft wall and the
lower floor slab intersect.

Make sure that the preview of the segment is within the wall. To
achieve this, you need to approach the point from the outside.

Press ESC to finish entering the bending shape. Enter 0.95 for the
length of the Initial segment and 1.10 for the length of the Final
segment.

Note: To check or change the crank, select the Segment
parameter, click | 4! to select the segment 2/3 and then click

E] beside Crank value.

Press ESC and place the label for the bar in the section.

A
Bl—
®
4
| B A st point
cll B 2nd point
C 3rd point
| D 4th point
2
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9 In this example, automatic depth placement would not be
created at the required position. Therefore, leave the setting of the

1k Place automatically option in the input options as it is (not
selected!) and define the placing line in the floor plan of the shaft
walls:

o Placing line from point: click the bottom left outside corner of
the 30 cm shaft wall.

e C(lick the bottom right outside corner of the 30 cm shaft wall
to define the 2nd point of the placing line.

10 Clear the Same concrete covers check box in the parameter area
of the palette. Taking the wall offset of 6 cm into account, enter
0.10 for the Concrete cover at start and Concrete cover at end.

11 Select | || Show all bars in the input options. Open the shortcut
4=
menu and select the €23 Dimension Line, Label tool.

12 Create the dimension line and label for the placement in the floor
plan of the shaft walls. The floor plan should now look like this:

T2

|
|
(20 12 -0
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13 Place this mark yourself in the floor plan of the shaft walls (not
in the area near the door!) and label the placements. Note that the
concrete cover of the placement beside the reveal of the door is
0.04 instead of 0.10.

Switch off the Align option and set the angle of rotation to
Perpendicular.
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14 To ensure that the wall reinforcement, which protrudes above the
clipping area defined, is displayed in its entirety, you will now
modify the upper section border in the two sections. Double-click
the view border of a section with the left mouse button and click
Yes to confirm the message. Double-click the view border of a

section with the left mouse button again to open the & Modify
View and Section Properties tool. Click Section settings for
associative view, change the Top level to -1.7900, click OK to

confirm the dialog box and click Apply. Use the same approach
to change the top level of the second section.
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To complete the vertical wall reinforcement, you will create and
place a straight bar. In addition, an L-shaped bar will be inserted in
the upper floor slab.

To enter a straight bar and an L-shaped bar and to
place them in batch mode

1

Close the drawing files 101 and 201 (or 203), open the Repeat

menu, click dh Bar Shape and select the Straight bar bending
shape.

Check that the layer BR_GEN is selected. If it isn’t, activate it on
the Format menu or toolbar.

Deactivate the Expand to adapt to edges option in the input
options.

Select diameter 12 in the parameter area of the palette, disable
the Same concrete covers option and change the value for
Concrete cover 1 to 0.04 and the values for Concrete cover at
start and Concrete cover at end to 0.00.

To define the start point, click the corner of the left inside edge of
the shaft wall (see figure) in section B-B.

Enter 0.00 for the &% X coordinate in the dialog line and 2.40
for the 3% Y coordinate. Press ENTER to confirm.

This creates the bar with the mark number 10. Press ESC and
place the label for the bar in the section.

Press ESC as you do not want to place the bar now.

The dh Bar Shape tool is still active. Select the L-shaped bar
bending shape.

Here, too, click the corner of the left inside edge of the shaft wall
in section B-B to define the start point.

10 To define the other points, click the point where the inside edge

of the shaft wall and the top level of the upper floor slab intersect
and then click the top left end point of the floor slab.

11 Select diameter 12 in the parameter area of the palette, change

the value for Concrete cover to 0.04 and enter 1.00 for segment
lengths 1 and 2.
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12 Press ESC, place the label for the bar in the section, and press
ESC twice to stop placing the bar and to quit the tool.

13 Using the right mouse button, click one of the bars you have just
[ ppien |
created and select i:2 Define Batch on the shortcut menu.

14 Select bars for the batch: select marks 10 and 11 using the
Brackets (Filter Assistant toolbar).

15 Click mark 10 with the right mouse button and select = Place
on the shortcut menu.

Place x 16 Click il Place in Batch and click OK to confirm.
P T w s (s

17 Proceed in a clockwise direction and place the mark on the inside
4] e edge of the walls in the floor plan of the shaft walls. Enter 0.00
for Concrete cover at start and Concrete cover at end and enter
0.04 for Concrete cover of placement. Start with the wall at the
bottom. Select the Align setting and enter 0,015 for the spacing
in the dialog box.
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Tip: When you click Custom
in the input options after you
have defined the first
placement, you can
immediately enter the next
placing region along any
placing line (here: the wall on
the left, for example) and
then create common labels
and dimension lines for these
placements.

Enable the 'number of pieces'
option for the individual
dimension lines.

For the other placements, click mark 10 in the section, confirm
the placing mode, select the Rotated setting and 270°, 180° and
90° for the placing angle on the left, at the top and on the right,
respectively.

18 Place labels as shown below.
Use the same approach to place the reinforcement in the wall on
the right; however, skip labeling.
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19 L-shaped bars are required near the door. In this area, you need

to XK Delete (Edit toolbar) the straight bars (mark 10) placed on
the inside.

With the iy Select elements based on direction setting, you
need to start on the left hand side when you open the selection

rectangle. You can also activate the ] Fully bounded selection
option in the Filter Assistant.

20 Using the right mouse button, click an L-shaped bar placed, select
)
"= Modify Placement Display Mode on the shortcut menu and
click | Show middle bar only in the input options.

21 Click all the L-shaped bars placed and press ESC.

I
22 Use the ¥ Dimension Line, Label tool on the shortcut menu to
label marks 10 and 11 in the wall on the right.
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The floor plan of the floor slab also contains marks 9 and 10. You
will now hide the wall reinforcement in this area.

To hide reinforcement placed
(mte:)
1 Click w Reinforcement Tools (Display flyout).

Tip: Click L2 | to show 2 Click Hide V (hides selected reinforcement in one view).

hidden reinforcement again.

Reinforcement Tools *

Al-1 1-All One-On Puto Hide V

Cancel

3 In the floor plan of the floor slab, click all the bars of the wall
reinforcement you want to hide.

Next, you will create horizontal bars as straight bars. They will be
entered in the floor plan of the shaft walls and placed in the
sections.

To create and place transverse reinforcement using
horizontal bars

1 Double-click a mark (10, for example) in the floor plan of the

shaft walls with the right mouse button to open the dh Bar
Shape tool. Select the Straight bar bending shape.

2 Change the value for Concrete cover 1 to 0.055 as the bar is to
be within the transverse reinforcement.
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3

Start at the top and click the inside corners of the shaft wall on
the right in the floor plan of the shaft walls. The bar is displayed
in the preview. Press ESC and place the label for the bar.
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The bar created is placed in section A-A. 1F prace automatically
is not active in the input options. It is the Align option that is
selected.

O
3 ¢ 12 -10(10)-

Click the upper and lower wall corner on the right. In the
parameter area of the palette, enter 0.055 for the Concrete cover
at start and 0.02 for the Concrete cover at end.

i
Press ESC twice to quit the tool and to start the &3 Dimension
Line, Label tool.

Select a different dimension line for the label of mark 12. Select
the Fan dimension line type in the Bar Label palette.
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8 Set the parameters so that the number of pieces, diameter and
spacing are displayed and change the setting for the text leader
to Manual.

[Bar Label 2]

|' Toals ”BarLanel ||W|zards|| Library HConnectH Layers |

[Dimen;ion line | .

(10)80 @10 -15

Dimension Imelmark;y...| Text/leader L

4 Label
Mark number

=

End with mark numbe
Number of pieces
Diameter

Steel grade

Spacing

Layer

Position

Length

Custom text

Bending shape

i e = Y

Twe-line text

Options for text
4 Leader

T ool R

Leader end symbol [

Options for leader -4~ Circle

9 Select the Options for text parameter and click E], enter 1.00 for
the aspect and click OK to confirm.

10 Place the label and click all bars to which you want to apply a
leader.
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Tip: If you consider the
spacing between the mark
border and label to be too

large, open the X Options,
Reinforcement - Labels page
and set the blank after the
mark to "0" (in the preview
for the Bar reinforcement at
the top of the page).

11 Press ESC twice to quit the tool.
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12 Now you can place mark 12 along the other vertical bars or you
can copy and mirror the placement:

-

]
:7@ % ¢ 12 -10
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OE 36

13 Now use the same procedure to create horizontal reinforcement
for the transverse side. To enter the bending shape, select Expand
to adapt to edges in the input options. Define a new placing line
in the area of the shaft wall in section B-B. The start point of this
new placing line is at the top and the end point at the bottom.
Finally, hide the transverse reinforcement in the floor plan of the
floor slab.
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Tip: If you want to modify an
existing label, click it and
open the Properties palette.
Change the settings in the
parameter area of the palette
and click in the workspace to
finish.

Now, you will complete the labels in the sections and floor plans.
Start with section A-A.

To label reinforcing bar placements later

1

Click mark 3 (lower longitudinal reinforcement in the floor slab)

Hbc
in section A-A with the right mouse button and select - Label
on the shortcut menu.

Select the Diameter and Spacing parameters and place the label.
The text leaders are set to Automatic. With the Automatic mark
number being selected in the input options, the program places
the mark number at the beginning or end depending on the
position of the label. If you want, you can deactivate this option.

Text/leader |

4 Label
Mark number

End with mark number |Innut Options *

| Aufomatic mark number E

=

Mumber of pieces
Diameter
Steel grade

EEEOE

Spacing

Click mark 5, check the settings, place the label and press ESC.

Click mark 4 with the right mouse button and select

[
9 Dimension Line, Label on the shortcut menu.

The Fan dimension line type is selected from the label of the
horizontal reinforcement. In addition, the text leaders are set to
Manual.

Deactivate the Number of pieces parameter and place the label.

Text/leader |

4 Label
Mark number

=

End with mark number
MNumber of pieces
Diameter

Steel grade

EOo=EO

Spacing

6 Click all the bars to which leaders are to be drawn.

7 Press ESC to finish.
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8 C(lick mark 6, check the settings and place the label.

9 C(lick all the bars to which leaders are to be drawn and press ESC
to finish.

10 Click 3 Label on the Repeat menu and label marks 9, 10 and
11. Switch off the Diameter and Spacing parameters. The text
leaders are set to Automatic.
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11 Now create the labels for section B-B as shown below:

Section B-B
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12 Complete the labels in the floor plan of the shaft walls as shown
below:

Floor plan of shaft walls t=30cm
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Now you have reinforced the elevator shaft with the exception of the
horizontal corner reinforcement, which will be created using FF
components. Finally, you will define the clipping area of the shaft
walls.

N
]

b

L
1 1
3@:12.10.@ 1 |ﬁD2M12'1D 1034 21210

To modify the clipping area

1 Double-click the view border of a section with the left mouse
button and click Yes to confirm the message.

2 Using the right mouse button, click the view border in the floor
plan of the shaft walls and, on the shortcut menu, choose

& Modify View and Section Properties.

3 C(Click M Section settings for associative view and set the Top
level of the section object to
-3.1000 and the Bottom level to -3.4000.

4 Click OK to confirm the dialog box and click Apply.
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Task 6: standard section

In this exercise, you will learn about the function used to place bars
in views.

Tools: Objective:
[ FF Components . .
Typical section

Place: i o,
= horizantal camer reinfarce ment

.@ Place In View

¢) Modify Number Off
Factors

placed 4 fimes

=0l

AT 148 12-10

.1‘\

@f’ o148 12 40

With the option to place reinforcement in views, you can assign
placement quantities to bars without having to place them in a
specific region. The reinforcement is only displayed in one view.

This placing mode is useful for displaying standard details. If you do
not enter the dimensions in the placement direction, you need to
determine the number of bars manually.

The location of the bars in space is not defined when you place bars
in this mode. The placement only affects the quantities (number off
figures).

To create a standard section using FF components and
place it in view mode

1 Click Open on a Project-Specific Basis (Default toolbar) and
make drawing file 204 current. Drawing files 101, 201 (or 203)
and 205 are now open in edit mode.

2 Use the tools in the Draft and Text modules (Create menu) to
draw a wall corner to the right of the floor plan of the shaft
walls. Label this standard section and select the style area 301
Reinforced concrete (see following illustration).
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Assign the layer BR_GEN to the elements by clicking = Select,
Set Layers on the Format menu and double-clicking the layer
BR_GEN.

+iH

|

3 Click ® FF Components (Bar Entry and Placement flyout).
Check that the layer BR_GEN is selected. If it isn’t, activate it on
the Format menu or toolbar.

&
7

_ Select Component ®

= Catalog selection
Additional wall reinf L L -
All H: | ==
Beams, girders I‘}
Columns i
Foundations J I_
Insulating strip _‘ ’_ —| ’_
Jamb wall
Openings
Stairs
Tanking, shafts
Verge, haunch
Wall corners

i cos

4 Select the Wall corners catalog in the Select Component dialog
box and double-click Wall corner.
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Wall corner *
& [120 [= 11 000 [= /= 0800 m = [0055[- =
0.055 |~ = 0.055 |~ =
2120 |-
H
10100 /@1 20 . ,—‘
[ os00 |55 L
P a (==
‘o o Dlameterh
& [120 [+][0100 [~ ][ 0200 [EE
o085 <=1+ T/100 Fm
opss |+ e |1 0.055] - =
e & Conc

5 Enter the global values in the first line of the Wall corner dialog
box: 12 for the & Diameter, 0.10 for the ||| Bar spacing, 0.80
for the |: Segment length and 0.055 for the == Concrete cover.

As the corner reinforcement is only used for assembly, set the
diameter to 8 and click OK to confirm.

6 Point to the left edge of the wall corner until the reinforcement
expands correctly, then click the left mouse button.

7 Click Cancel as you do not want to enter dimensions in the
placing direction.
Entering dimensions causes the program to determine the number
of the stirrups and the length of the longitudinal bars based on
the component settings specified.

8 Select view Click the floor plan of the shaft walls. This assigns the
standard detail to this view.

9 The system prompts you to specify the position of the label for
the first stirrup. Press ESC.

10 Select .ﬁ Place In View and click OK to confirm.
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Text/leader

4 Label
Mark number
End with mark number
MNumber of pieces
Diameter
Steel grade

Spacing

|

=

EOoOEE

FF Compaonents x

M TawEina

0K Cancel
FF Compaonents x
Mo pes + Laye 1 Tl Spacing 0.100 Tl
Sec 1 No. of pos 14 11 As/m 11300 T

0K Cancel

11 Enter 14 (= number of horizontal bars) for the number, set the
spacing to 0.10 and click OK to confirm.

12 Enable Number of pieces, Diameter and Spacing and place the
label.

13 The dialog line prompts you to specify the position of the label
for the second stirrup. Press ESC.

14 The procedure is the same as for the first stirrup.

15 Enter 1.35 for the length of the longitudinal bars, do not change
the other settings and click OK to confirm.

Longitudinal Bars ®

Per bar 1.35 m
ol

e

s

I

o

Support length 14.000|m
Length factor 1.10

Cancel

e
16 As the wall corner exists four times, click ¥ Modify Number Off
Factors (Modify flyout).

17 Select placed reinforcement to modify number off factors: select
the entire reinforcement of the standard section, enter 4 for the
Component factor and click OK to confirm.

18 On the Repeat menu, click It@ Dimension Line, Label and label
the horizontal bars, mark 15, by enclosing them in a selection
rectangle. Select Number of pieces and Diameter for the label
parameters and set the text leaders to Automatic.
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Task 7: bar schema

The following part of the exercise involves creating bar schemas.
You will create full schemas which are drawn to scale and place
them beside the design.

Tools: Objective:
Full Schema
22 &
S — e [178.]8 |2
0 IS R £
@ 60 ¢ 1 L-1B2m o - o S~
S m— gui s fa |s
@ 506 12 L=179m 20 ®
i 30 ¢ 10 L=246cm E E =
: 25 0 10 L=292tm 0 i i ;
: 30 & 12 L=246tm - s * ng
@ 19@
{ :} ® 8/ LfM = 23.76m

The partial and full schema tools provide a way of displaying the
internal number-off and bending shape management in the
reinforcement drawing. You can place a schema bar and label for
every mark in the drawing file. The schema will automatically
update to reflect any changes you make to the placed reinforcement
or bending shapes.

There are two types of schema:

. Full Schema
Number off information on all the placements of a mark

o U5 Partial Schema
Number off information on one placement of a mark

The bending shape can be drawn to scale or not and it can be
displayed so that it is aligned with the placement.



184 Exercise 4: creating a 3D elevator shaft with a 3D model (method 1) Allplan 2014

To create a full schema
1 Click k==l Full Schema (Display flyout).

2 Select Meshes or Rebars in the Input options, and in the dialog
line, enter the number of the mark based on which a schema is to
be created or click the mark.

Tip: If you have deleted a bar

while working, the bar's mark pE— "
number will remain Q= gl <[ e ][@a [ [A<
‘unassigned'. w6 xly] 5 A o « 1 %
You can use Git Rearrange —
Marks to close this "gap".

3 Enter the settings as shown above.

4 The schema and its label are attached to the crosshairs.
You can use the i Rotate and -'-‘“i Mirror options to specify how
the bars are positioned. Place the schema to the right of the
sections.

5 You should be able to create the other bar schemas yourself. For

L
straight bars, you can switch off -1- leg dimensioning. Set the
text angle so that it matches the position of the bar shape.

Tip: If you consider the
spacing between the diameter
and length to be too small,
open the .4 Options, 2
Reinforcement - Labels page D oo i
and insert a blank in front of e

the length ("L="in the @ D0 1 Lt
preview for the Bar
reinforcement at the top of OEXEEE

the page). .

@ 25 0 10 1=292em
@ 30 0 12 L=246cm

@ 25 0 12 L=292cm (5 5% 0 12 L-Bhen
() ® 8/ LigM = 23.76n
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Task 8: reinforcement schedule and bending schedule

The last part of this exercise involves creating a reinforcement

schedule and a bending schedule.

Tools: Objective:
Reinforcement REPOItS Bar schedule - bending shapes

Reinforcing Bar Legend RS

ngh
e |

wax

Reinforcement schedules are created as you work and are thus

always up-to-date. You can also print them whenever you need.
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Tip: Parameters relevant to
marks (like number off value,
steel grade, diameter and
individual length) are saved
for reports.

You can create reports both
in document edit mode and
in layout edit mode.

Tip: Click the dimensioned
bending shapes in the Report
Viewer - 'w_‘-l Print Preview to
modify them in the
workspace.

Start by printing the bar schedule, which Allplan 2014 has created
automatically as you worked.

To create a bar schedule

1 Click Reinforcement Reports (List/Schedules flyout).

2 The Reports dialog box appears in which you can select
predefined reports.
If necessary, click the Default folder on the left and select the
Reinforcement schedule - bending shapes report.

b Repaorts

Look in:

[
Default

[
Office

E
My Documents
Computer
“

MNetwork

Reinforcement -

MName

. Cross-section catalogs
Couplers, nuts, threads.rdlc
@Mesh cutting diagram - Switzerland. rdlc
Mesh cutting diagram.rdic
Mesh reinforcement.rdic
Quantities - Austrian standard.rdic
Reinforcement - overview.rdic
Reinforcement schedule - bending shapes - summary.rdlc
Reinforcement schedule - bending shapes.rdic
Reinforcement schedule - British Standard.rdic

Reinforcement schedule - Holland Form.rdlc

Reinforcement schedule - 150 4066.rdlc
Reinforcement schedule - names.rdlc
Reinforcement schedule - Switzerland.rdlc

File name: Reinforcement schedule - bending shapes.rdic

Files of type: Report definition file (*.rdic)

s [@-

Date modified

10/1/2013 10:43...
9/3/2013 8:20 AM
9/3/2013 8:20 AM
9/3/2013 8:20 AM
9/3/2013 §:20 AM
9/3/2013 §:20 AM
9/3/2013 8:20 AM
9/3/2013 8:20 AM
9/3/2013 8:20 AM
9/3/2013 8:20 AM
9/3/2013 8:20 AM
9/3/2013 8:20 AM
9/3/2013 §:20 AM
9/3/2013 §:20 AM

Type

File folder
RDLC File
RDLC File
RDLC File
RDLC File
RDLC File
RDLC File
RDLC File
RDLC File
RDLC File
RDLC File
RDLC File
RDLC File
RDLC File

3 C(Click All in the input options.

The report is displayed in the Report Viewer. Various attributes,
such as the project, are included automatically.

4 Enter Elevator shaft - reinforcement drawing for the Layout
parameter. This attribute is taken automatically from the layout
name in layout edit mode.
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5 Clear the Show steel grade check box as there is only one steel

grade in the layout.

Report

Parameters

a1

Allplan System Parameters
Company address

4

Company logo

Company name

Date 10/14/2013

Edited by bmertin

Email

Layout

Project name

Telephone Number

Time 1343
4 User Interaction

Note

Mumber of components

PageMo 1

Show graphics

Show logo

Show steel grade

SIEE -

Show steel grade
Steel grade grouping on or off,

=8 R o)

&

C:\ProgramData\Memetsc | Project:

m

Engineering Tutorial (with

Ej} 1 of 1 % B RPIB- | 100% -
4‘-
5.+ Allplan
Reinforcement schedule - bending shapes
Engineering Tutorial (with model)
For layout:
Edited by: bmertin
Date / time: 1042013 [ 13:43
Note:
All bar shapes
Mark Pieces a Dimensioned bending shape Individual Total Weight
[mm] length [m] length [m] [kal
Elevator shaft
1 80 12 182 10620 96.97
2 50 12 1.78 89.50 79.48
3 30 10 248 7425 4553

6 Click @ Print, select the printer and start printing.
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Note: In Allplan 2014 you can place bending schedules in layouts.
To print a bending schedule, you can use the Reinforcement

schedule - bending shapes report provided by the =2 Reinforce-
ment Reports tool.

Next you will place the bending schedule in the drawing file.

To place the bending schedule in the drawing file
1 Click =i Reinforcing Bar Legend (Reports flyout).
2 Select the legend you want to use.

3 If necessary, select the Associative legend of active document
option and click OK to confirm the Legend selection dialog box.
When this option is selected, the bending schedule updates
automatically when you add or delete marks later.

4 Place the bending schedule in the workspace.
A section of the diagram should now look like this:

Bar schedule - bending shapes

Awk | Fex © Single Dz Dendng e Total vz
angth notizzcael ngh
[rrem] Im] m] L4
1] 12 LEz n| 1.2 FEET
7| == ] TR g| L it
=
2| 2 FE 2.m EEEH

5 Define the DEFAULT layer as the current one.

Printing layouts is covered in exercise 9.
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Exercise 5: creating a 2D door lintel with a
3D model (method 2)

Tip: Refer to the chapter
"Reinforcement methods - 3D
reinforcement model” in the
Allplan help:

[F=7 Engineering
] General Information
E Floor plan and shell drawing
E Key Plan module
[£57 Reinforcement drawing
[ Reinforcement methods
E Basic approach

Requirements:
Allplan 2014 Engineering comes in different module packages.

Open the Tools palette and check whether the (i Engineering and

[t Engineering Views, Details families include the following
modules:

@ Associative Views E Bar Reinforcement

Check whether the following tools are available on the Engineering
toolbar:

db Bar Shape

In exercise 4, you reinforced a 3D general arrangement drawing and
created a 3D model (method 1, see Tip).

In the following exercise, you will create a precast element of a
reinforced door lintel as a symbol. You will apply reinforcement to a
2D general arrangement drawing and create a 3D model (method 2,
see Tip).

Start by selecting fileset 3 with the following drawing files:

Drawing Drawing Drawing file name
file number

3 301 General arrangement in 2D
302 Reinforcement drawing with 3D model
303 Modified door lintel

You can find the fileset in the 'Engineering Tutorial’ project (see
"Appendix: creating the training project”).
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Task 1: designing a reinforced door lintel

First, you will use the tools in the B Draft module to create an
elevation and section view as the general arrangement drawing for a

precast door lintel.

After this, you will apply reinforcement. You will mainly use the

tools in the ] Bar Reinforcement module. You can access these
tools using the flyouts on the Engineering toolbar and the shortcut

menu.

Finally, you will save the precast door lintel as a symbol in the

library.

Tools:

¢ Options

dk, Bar Shape:
Stirrup, closed
Straight bar

w2 Place Bar Shape:
Along placing line
Along placing segment
Single placement

Dimension Line, Label

T E

Library

Objective:

Door lintel

Elevation

- s

\Ll
3

a

Fh2oles 10

-

k3

e

1:50
Section
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First, draw the outline.

To draw the outline in 2D

1 Click Open on a Project-Specific Basis (Default toolbar),

open the drawing file tree for fileset 3 and double-click drawing
file 301.

In the status bar, click the current Scale and select 1:50. Check
the current unit of length and set it to m, if necessary.

Use the tools in the Draft module to create the design as shown
below. Select pen thickness 0.35 mm for the elevation and 0.50
mm for the section. Use the L] Rectangle and 7 Line tools
(Create menu - Draft module).

Assign the layer DE_GENO2 to the elements by clicking in the
Select, Set Layers list box (Format toolbar) and selecting the
layer DE_GENO2.

Door lintel 1:50

Elevation Section
z
_..;ﬁT ................. :
-1L -‘ll -‘IL -‘lb "l 5I
7, 151 24 7

You do not need to draw the coordinate system and the 3D view
(shown as dashed lines), which serve as an aid to orientation.

Double-click in the workspace with the middle mouse button to
refresh the view.
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Tip: Refer to the chapter
"Reinforcement methods -
orientation in space” in the
Allplan help:

4 [F=r Engineering
+ £ General Information
3 EFluur plan and shell drawing
3 EKE‘{ Plan medule
4 [=7 Reinforcement drawing
4 [=7 Reinforcement methods
3 Eﬂasic approach

Now you will create and place the stirrup reinforcement for the
beam. The setting you make defines the spatial orientation for the
entire reinforcement (see Tip).

The layer BR_GEN is proposed for bar reinforcement. You can use
this layer as it is not necessary to differentiate between the upper
and lower reinforcement layers.

To manually create and place stirrup reinforcement

1 Make drawing file 302 current and set drawing file 301 to edit
mode.

2 Click 4 Options (Default toolbar), select the Reinforcement page
and check that the Reinforce with 3D model option is active in
the General area.

3 Click dh Bar Shape (Bar Entry and Placement flyout).
Check that the layer BR_GEN is selected. If it isn’t, activate it on
the Format menu or toolbar.

4 Select the Stirrup, closed bending shape in the list box at the top
of the Bar Shape palette.

|Bar5hape l}l|

Tools | Bar Shape | Wizards | | Library || Connect | | Layers

[Stlrrup, closed V]
(4
—
4 General

Mark number 16
Concrete strength grade C25/30
Cross-section cataleg  Betonstabstahl (B)
g
Bar length ? T}
Per meter 0

4 Geometry
Same concrete cover

Concrete cover 0.03
Hoock angle 90
Hock length 0.104

Bending pin factor 4
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Tip: As you are creating a 3D
reinforcement cage, you need
to provide the system with a
spatial reference. When you
work in 3D, the spatial
orientation is automatically

defined by the view.

5

In the parameter area of the palette, select diameter 8 and enter
0.03 for the concrete cover.
You can leave the other settings as they are.

The Expand to adapt to edges and Label options are active in the
input options. In the section point to the component line on the
left within the outline until the bending shape expands, then
click in the workspace.

Ear Shape

e

OK

Y |Z
Y |-Z

Cancel

Select view for spatial orientation: the stirrup is located in the Y-
Z plane and is to be placed in the X direction. Click X and click
OK to confirm.

this setting defines the spatial orientation for the entire
reinforcement.

Press ESC to start the L Label tool and place the bar label in the
section. Set the parameters so that only the mark number is
displayed.

[Bar Label %]

Tools | Barlabel ||\Wizards | Library || Connect|| Layers

Bar shape label

Text/leader |

4 Label

End with mark number

=

Mumber of pieces
Diameter
Steel grade

oooo

Spacing
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Tip: You can change the
placement display mode
immediately using the input
opj;tions or later using

= Modify Placement
Display Mode.

1t
The v Place Bar Shape tool opens automatically.

9 Placing line from point: click the bottom left end point of the
beam.

10 Placing line to point: click the bottom right end point of the
beam.

11 Select viewing direction: click to the right of the bending shape.
The placed area is selected (marked) and you can see already
whether the bar is located in the correct position.

Door lintel 1:50

Elevation Section
3 1, Offtal
of | [T1o _

411.. 15 ’11’ "Il’ ?.7{
24 : 24 24

12 In the parameter area of the Place Bar Shape palette, select the
Same concrete covers option and enter 0.03 for the Concrete
cover. If necessary, set the angle of rotation to 0 and the spacing
to 0.10. You can leave the other settings as they are.
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4 Placing region
Placing line Defined
Relative to placing line Left
Rotation angle Perpendicular
Same concrete cover
Concrete cover 0.03

4 Reinforcement
Mark number 1
Compenent factor 1
Layer factor 1
Number 20
Input parameters Spacing
Sectional format 2
Reinforcement percentage 10.053

4 Layer
Placing length 193
Edge offset +}+ Start = end
Start 0011
End 0.011

i
13 Press ESC twice to quit the tool and to start the &= Dimension
Line, Label tool.

Note: If you have not worked through exercise 4, you need to set
the aspect to 1.00 by selecting the Dimension line options line

and clicking E]

14 Set the type to Dimension line and place the dimension line and
label below the beam. Set the label parameters so that the number
of pieces, diameter and spacing are displayed.

Door lintel 1:50

Elevation Section
IO O] =
| |
e -

T ! A

15 Press ESC to quit the tool.
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Next, you will create and place the longitudinal reinforcement of the
beam based on the stirrup reinforcement you just entered.

To create and place the bottom longitudinal
reinforcement

1 Click db Bar Shape (Bar Entry and Placement flyout) again.

|Bar Shape Rl|

Tools ||BarShape |Wizards || Library || Connect|| Layers

[Straight bar v]
*‘l—!_g_r'

4 General
Mark number 2
Concrete strength grade  ©25/30
Cross-section catalog Rstonstabstahl (B)
Diameter 14
Bar length s
Per meter ]

4  Geometry
Same concrete cover (]
004 -
Concrete cover at start 003
Concrete cover at end 003

2 Select the Straight bar bending shape in the list box at the top of
the Bar Shape palette.

3 Select diameter 14 in the parameter area of the palette, disable
the Same concrete covers option, if necessary, and change the
value for Concrete cover 1 to 0.04 and the values for Concrete
cover at start and Concrete cover at end to 0.03.

4 Deactivate the Expand to adapt to edges option in the input
options and click the two bottom corners of the beam in
elevation view. This creates the bar.

If you want, you can still change all the parameters except for
the (bending shape).
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5 Press ESC, set the label parameters as shown below and place the

label.

[Bar Label 7

Tools ||Barlabel | Wizards || Library | |Connect|| Layers

Bar shape label

80 210

Text/leader

4 Label

Mark number

=

End with mark number
Number of pieces
Diameter

Steel grade

Spacing

O0OoOE®

Layer

1
The @+ Place Bar Shape tool opens automatically.

Click &~ Segment in the input options and click the bottom
stirrup leg in the section (see following illustration).

Door lintel 1:50

Elevation Section
#IIIIIIIIIIIIIIIIII&D_ 1 Iﬁ
AT ik °

@ 2000 8 -10

5020 ¢ 14
T L v
2% : 24 2%

In the parameter area of the Place Bar Shape palette, enter 4 for
the Number, click in the workspace with the right mouse button

1=
and select l"E Dimension Line, Label on the shortcut menu.
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4 Placing region
Placing line
Relative to placing line
Rotation angle
Same concrete cover
Concrete cover

4 Reinforcement
Mark number
Component factor
Layer factor
Number
Spacing
Input parameters
Sectional format

Reinforcement percenta

Defined
Left
Perpendicular
0
|ﬂ| Ear Shape
4
1 |l_—‘3" Place Bar Shape
1 @ Dimension Line, Label
= s Place
MNumber of pieces
1
e 6.158
0.146

<+ Start=end

8 Select the Fan dimension line type and set the parameters so that
only the number of pieces and the diameter are included.

[Bar Label

2

Tools |Barlabel | Wizards

Library | | Connect|| Layers

(Fan - .
80 10
Text/leader
4 Label

Mark number
End with mark number

Mumber of pieces
Diameter
Steel grade ]
Spacing [}
Layer [

With the Automatic mark number being selected in the input
options, the program creates the mark number at the beginning
or end of the label depending on the drop-in point specified.

Place the label below the bars. The system automatically draws
leaders to all the bars.
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The next step is to enter the top longitudinal reinforcement. You will
learn about an approach that is particularly useful for reinforcing
components in section or plan without creating an additional view.

To create the top longitudinal reinforcement in the
section and to place it freely in the view

1 The Iﬂl Bar Shape tool is still active. If it isn’t, select it on the
Repeat menu.

The bending shape is set to Straight bar.

k
2 Select ® Straight bar as point in the input options and select
diameter 12 in the parameter area of the palette.

|Bar Shape 1 |

Tools || Bar Shape | \Wizards || Library | | Connect| | Layers

[Straightbar 'I

Input Options x
& PRI - e

4 General
Mark number 3
Concrete strength grade  ©25/30
Cross-section catalog Befonstabstahl (B)
12 -
Bar length 1

3 Click i Measure Length (Default toolbar).
4 C(Click the top left and right end points of the beam.

5 Click Iy in the Measured values dialog box and then click L =
1.99000 m.

Measured values @
Length = 189000 m
Total = 189000 m
Angle = 0.000000 deg
Delta X = 189000 m
Delta ¥ = 0.00000 m
Delta Z = 0.00000 m
& \Ehlg % (eRl | cancel
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6 Select the value for the Bar length in the parameter area of the
palette, click this box with the right mouse button and, on the
shortcut menu, choose Paste.

4 General

Mark number El

Concrete strength grade  C25/30

Cross-section catalog Betonstabstahl (B)

Diameter 12

{

Per meter [}
Cut
Lopy
Paste
Delete %

7 The value 1.99000 is entered. Taking the concrete cover of 3.0
cm at the start and end into account, change this value to 1.93.
le Place bar in fillet is active in the input options. Do not
change this setting.

8 The cut bar is attached to the crosshairs. Point to the top left
rounded corner of the stirrup displayed in the section and click
the left mouse button.

Input Options

P *
F@Q V] Abc

4 General
Mark number 3 +
Concrete strength grade  C25/30
Cross-section catalog Betonstabstahl (B)

Diameter 12

Bar length
Per meter ] ]

£

9 (lick in the workspace with the right mouse button and select
1
i Place Bar Shape on the shortcut menu.

10 Select Single placement in the list box at the top in the Place Bar
Shape palette.

11 Select view: click the beam displayed in elevation.
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12 Set the E Anchor point to top right in the input options and
f=
enter 0.03 for the ... Offset in X direction and 0.04 for the

-a-i Offset in Y direction.

|P|ace Bar Shape 1 |

Tools || Place Bar Sh... || Wizards | | Library || Connect | | Layers

;Single placement V]

Input Options
BJ & [o030 =§ | ooa 7 Abc

E

4 Reinforcement

Mark number

Component factor

o

Layer factor

13 Click the top right corner of the beam displayed in elevation.

14 Press ESC as you do not want to create an additional placement.

15 Press ESC again to skip labeling.

Door lintel 1:50

Elevation Section

113 t

|||||||||||||+r§aH|l||T Ia

[ il

I | | 1

@ M e -0 49 %
@ IR

F—F 151 F—t +—t

L ' 1t 24

16 Click ﬂ“i Copy and Mirror and mirror the top longitudinal bar in
the section.

17 Press ESC to quit the tool.




202

Exercise 5: creating a 2D door lintel with a 3D model (method 2)  Allplan 2014

Now you can create the missing labels. The top longitudinal bars are
two separate placements. To create a common label, you need to
select both placements.

To label the top bars later
1 Click o Dimension Line, Label (Display flyout).

2 Using the left mouse button, enclose the two bars at the top in
the section in a selection rectangle (from left to right).

= Select elements based on direction is active in the Filter
Assistant.

3 The dimension line type is set to Fan. Place the label above the
bars. You can enter a direction angle for the label in the dialog
line. Allplan automatically draws leaders to all the bars.

4 Using the same approach, create a label for top longitudinal bars
in the view and place it above the bars.

5 Press ESC to quit the tool.

The drawing should now look like this:

Tlrsturz M 1:50
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Now that you have completed the reinforcement of the door lintel,
you will save it as a symbol. You will then retrieve and modify it.
Symbols and their use are covered in the Basics Tutorial.

To create and save a symbol

1
2

Open the Library palette and click the Symbols folder.

The reinforcement symbol is to be available to all the users in
your office: open the Office folder.

|Library 3 x |

Tools || Properties | | Wizards || Library || Connect|| Layers

¢= Library b Symbols re

. ;‘: 2 [ Default
& { Office L\\,
{ g8 | Project

Click i New group at the bottom of the Library palette, enter
Standard details for the name of the new group and press ENTER
to confirm.

Double-click the new Standard details group to open it and click
@ New symbol at the bottom of the Library palette.

Enter Door lintel for the name of the new symbol and press
ENTER to confirm.

Select element(s) you want to save as a symbol

This example includes only associative views without a
reinforcement model. As you want to copy the 3D model without
the views, you must not select the view borders. Otherwise, the
views are also copied.
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6
Tip: You can also change the 7
position of a symbol's base
point when you retrieve it.

8

Open the = Brackets, enclose the entire reinforcement symbol in
a selection rectangle and click the view borders of the two views.
With the exception of the view borders, all the elements are

displayed in the selection color. Close the z Brackets.

Set the symbol’s base point

Click the bottom left corner of the beam in elevation view to
define the symbol’s base point. This is the point at which the
element is attached to the crosshairs when you retrieve it later.

Click Dumb symbol without Snoop functionality in the dialog
box and click OK to confirm.

The new Door lintel symbol has been saved in the Standard
details folder.

|L\brary a X|

Tools || Properties || Wizards || Library | Connect | Layers

= 1 P Symbols b Office ¥ Typical details P

Preview

im
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Task 2: modifying the reinforced door lintel

Now you will retrieve the door lintel and modify it.

Tools: Objective:
(= Library Door fintel 1-50
"f? Stretch Entities Elevation Section

2@

(¥ New Mark Number

T T
[Ew Properties palette pEI e el

T LA 11 T
(b:s:.a FPLE-R

(§} Rearrange Marks ot fogt

T FE]

£ Properties palette

This task also requires fileset 3:

Drawing Drawing Drawing file name
file number

3 301 General arrangement in 2D
302 Reinforcement drawing with 3D model
303 Modified door lintel

You can find the fileset in the ’Engineering Tutorial’ project (see
"Appendix: creating the training project”).




206

Exercise 5: creating a 2D door lintel with a 3D model (method 2)  Allplan 2014

First, you will retrieve the symbol and place it in a separate drawing
file.

To retrieve a symbol

1

Click Open on a Project-Specific Basis (Default toolbar) and
double-click drawing file 303.

In the status bar, click the current Scale and select 1:50. Check
the current unit of length and set it to m, if necessary.

The Library palette is still open from the last task; you can see
the Standard details group in the Office folder. If this is not the
case, click the Symbols folder in the Library palette and open the
Office and Standard details folders.

Clear the Auto-scale option and double-click the Door lintel
symbol with the left mouse button.

|L\brary 3 x |

Tools || Properties || Wizards || Library ||Connect | Layers

] 4; b Symbols b Office b Typical details re

Preview

Door lintel 1:50

Flevation Section
@2: 12 @“ 2
M. O F
‘I'i @"D 8-10 ‘I'
@4 214 ®4 o
.@} 24 151 24 "E'L

Font size

Auto-scale ®

Typical details
Doorlnel 150
e e

o Gk

o Ee

o

Door lintel Ik

| Door lintel

The symbol is attached to the crosshairs at its base point.
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5 To place the symbol, click in the workspace.

6 Double-click in the workspace with the middle mouse button to
restore the full view.

Next, you will modify the clear dimensions of the door opening and
the width of the door lintel. In addition, you will modify the spacing
between the stirrups in the middle and the diameter of the bottom
longitudinal reinforcement.

As you saved the door lintel with the 2D general arrangement
drawing when you defined the symbol, you do not need to create it
again. If you only save the reinforcement itself as a symbol, you can
also place it in a new general arrangement drawing.

To modify the door lintel’s dimensions
1 Click # Stretch Entities (Edit toolbar).

2 Using the left mouse button, enclose the stirrup leg on the right
and the top and bottom corner bars in a selection rectangle in the
right-hand part of the section (see below).

3 Enter dX = 0.06 and dY = 0.00 to change the width to 30 cm.
The outline and reinforcement adapt automatically.

4 Use the same approach to modify the support area on the left in
the elevation (dX = -1.00 and dY = 0.00).

The door lintel should now look like this:

Door lintel 1:50

Elevation Section

——
O ]
11l [ |
- O |
1#—— 3953-0

T4 @

A 4' A A
7 151

4 @Emlz
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Next, you will alter the spacing in the middle of the beam. First, you
will assign a new mark number. Then you will modify the spacing
and rearrange the marks so that the stirrup reinforcement is
combined to a single mark again. Finally, you will change the
diameter of the bottom longitudinal reinforcement.

To modify reinforcement
1 Click @ New Mark Number (Engineering Modify flyout).

2 What is to become a new mark? Click to the left of the 14 stirrups
in the middle of the beam and enclose them in a selection
rectangle without releasing the left mouse button (E Select
elements based on direction is active in the Filter Assistant).

3 Allplan proposes a new mark number (based on the last mark
number assigned plus one). Accept it and press ESC.

4 C(lick a stirrup in the middle, select the Properties palette and
select Place Bar Shape (1) in the list box at the top.
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5 In the parameter area of the palette, change the Spacing to 0.20
and click in the workspace to finish.

|Proper‘tls_c 1 x |

Tools | Properties | Wizards | | Library | | Connect | | Layers

Place Bar Shape (1) - Y

4 Placing region
Placing line Defined

4 Reinforcement
Mark number 1
Component factor 1
Layer factor 1
MNumber 7
1]
5
2
5

[Spacing [ -
[m:ll'. |35I'5I“'E:EI£ pacing
Secticnal format
Reinforcement |25I'CEI1T&;5 -':'27
4 Layer
Edge offset 5 Start=end
Start 0.061
End 0.061
Door lintel 1:50
Elevation Section
Z1p 12
== F——f = =
\RT F5H T T D]
_________ =
: —-
@ 16| & B - 10
2he @ 1k
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6 Click a bar with the right mouse button and select Gt Rearrange
Marks on the shortcut menu in order to combine the two marks
to a single mark.

Rearrange Marks *
Lock[v] Fom#| 1
Idertical shapes [ | To# 9999
Meshes m after 1
Rebars m
oK Cancel

7 Make settings as shown above and click OK to confirm.

8 Delete the label for the stirrups in the elevation, click

=
3 Dimension Line, Label and use the brackets to select all the
stirrups in the elevation.

9 Set the type to Dimension line, select the Dimension line text
option, select No. of pieces + spacing for the text and place the
dimension line.

10 For the label, switch off spacing, place the label and press ESC to
quit the tool.

11 Click a bar in the bottom longitudinal reinforcement and select
Bar mark (1) in the list box at the top in the Properties palette.

12 In the parameter area of the palette, change the Diameter to 16
and click in the workspace to finish.

4 General
Mark number 2
Mumber of pieces 23
Concrete strength grade  ©25/30
Cross-section catalog Betonstabstahl (B)
16 -
Length 293
4 Geometry
Hock at start ]
Hock at end [}
Bending pin factor 4

13 Switch to the Tools palette.
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Tip: The essentials are
described in the Allplan help:
refer to the chapter about the

Associative Views module
and the chapter
"Reinforcement methods - 3D
reinforcement model".

E Engineering
[=7 Engineering Views, Details
[ Associative Views module
£ Basics
ExTools
ESHow To ...

Your drawing should now look like this:

Door lintel 1:50
Elevation Section
@z Bz
([T T T T T
L L s QM1 -l
I I I3 @ E EI [ I1r:.
4'2.;; 251 er.ﬂt

Finally, you can create a bar schema. The approach is the same as
with the elevator shaft in exercise 4. Consequently, it is not
described any further here.

As you created the reinforcement with a 3D model, you can delete
the elevation or section at any time and create them again using the

tools in the @ Associative Views module. As opposed to the
elevator shaft, only the three-dimensional reinforcement cage is
displayed (see Tip).

If you want to reinforce a component in the floor plan only, you can
create a new plan view provided the original view or the section still
exists.

Printing layouts is covered in exercise 9.
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Exercise 6: creating 2D slab without a 3D
model (method 3)

Tip: Refer to the chapter
"Reinforcement methods - 3D
reinforcement model” in the
Allplan help:

[£=7 Engineering
[ General Information
E Floor plan and shell drawing
E| Key Plan module
[E=7 Reinforcement drawing
[=7 Reinforcement methods
E Basic approach

Requirements:

Allplan 2014 Engineering comes in different module packages.

Open the Tools palette and check whether the (o Engineering
family includes the following module(s):

l“| Mesh Reinforcement El Bar Reinforcement

This exercise involves reinforcing a floor slab based on the 2D floor
plan of the basement created in exercise 1. In this exercise you will
not create a 3D model (method 3, see Tip). This exercise requires
exercise 1.

Start by selecting fileset 4 with the following drawing files:

Drawing Drawing Drawing file name
file number

4 102 2D floor plan
401 Reinforcement, bottom layer - without
3D model
402 Reinforcement, top layer - without 3D
model

You can find the fileset in the 'Engineering Tutorial’ project (see
”Appendix: creating the training project”).

Instead of drawing file 102, you can also open drawing file 101 of
exercise 1 in edit mode. In this case, set the status of the existing
layers to Modifiable and hide the style areas so that you can see

better what you are doing: click =] Show/Hide (Default toolbar) and
deactivate the style area.
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Task 1: mesh reinforcement, bottom layer

Tip: You can specify how
Mesh reinforcement is
Qisplayed using the

Options tool.
For more information please
consult the Allplan help.

In this part of the exercise, you will create the mesh reinforcement
for the bottom layer.

You will mainly use the tools in the | Mesh Reinforcement
module. You can access these tools using the flyouts on the
Engineering toolbar.

Tools: Objective:

9 Options

Span Reinforcement | e | /

jod

I \? @%q Q’% &y
H \el

Start by making initial settings.

To select drawing files and to set options

1 Check whether the Engineering toolbar is displayed at top left. If
it isn’t, open it as described in the initial settings (on page 120).

2 Click Ll Open on a Project-Specific Basis (Default toolbar),
open the drawing file tree for fileset 4, make drawing file 401
current and open drawing file 102 in edit mode.

3 In the status bar, click the current Scale and select 1:50. Check
the current unit of length and set it to m, if necessary.
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Now you will start by placing meshes in the span at bottom left in
the floor plan.

To place by span in a rectangular area

1 Click % Options (Default toolbar), select the Reinforcement
page, clear the Reinforce with 3D model check box in the
General area and click OK to confirm.

2 (Click @ Span Reinforcement (Mesh Entry and Placement
flyout).

The system proposes the layer MR_GEN.

3 Click in the Select, Set Layers list box (Format toolbar) and
choose Select....

4 Open the shortcut menu in the Single layer selection dialog box,
select the List layers assigned to currently selected tool option
and double-click the layer MR_M_B.

5 From point or element or enter offset: enter 0.15 for the support
depth in the dialog line.

6 Define the placing polygon by clicking the bottom left inside
corner of the wall and then the top right wall corner. Press ESC
to finish.

| L
- [
6l
Span Reinforcement N
e Ty o012
& L

0K

Cancel
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Tip: When Transverse
Overlap is enabled, only
entire meshes are placed. The
value proposed by the system
is displayed in the data entry
box. It cannot be changed.

Tip: Allplan 2014
automatically calculates the
overlap depending on the
type of reinforcing steel mesh
you select. The placement
algorithms are designed with
economic considerations in
mind. However, you can
change this at any time by
specifying the lap joint
yourself. The lap joint can be
labeled if required (see

Options - Reinforcement
- Labels page).

7 The support depth needs to be changed on the right and at the
top. Click ] Support depth in the dialog box.

8 Click side of polygon: click the right side of the polygon and
enter 0.12.

9 Repeat these steps with the top side of the polygon and click OK
to confirm the settings.

Span Reinforcement *
& P om w21 Stating length | 3.18 I P
Q257A | 034 A oooo Starting width | 2.30 St GV Rd 15

OK Cancel

10 Click 21884 Mesh Type and select Q257A. This sets the values

i+
for the Ilﬁ Longitudinal Overlap and [F¥] Transverse Overlap to
0.34.
Define the other settings as shown above.

11 Click OK to confirm the entries.
The placement should now look like this:

L B

12 Press ESC to quit the tool.
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Tip: The general arrangement
polygon of the area
reinforcement placed is
displayed in construction line
format. Clicking this polygon
selects the entire placement.

The next step is to apply reinforcement to the adjacent span on the
right. You will mark out the span using a freeform outline.

To place by span in a polygonal area

1 Click 5 Span Reinforcement (Mesh Entry and Placement
flyout).

2 Enter 0.12 for the support depth in the dialog line.

3 Working counter-clockwise, click the inside corners of the span
and press ESC to finish.

Depth in the dialog box, click the exterior wall, enter 0.15 and
click OK to confirm.

5 Select mesh type Q513A and set the placing angle to 0.00
degrees.

6 Confirm.
The reinforcing steel mesh placement is drawn and labeled.

M [\
pE
B
Q'
) L
B &> Il
}
)
@Q
o
qg;\v
S } }

7 Press ESC to quit the tool.
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Now you should be able to place the reinforcing steel meshes
yourself (support depth for interior walls is 0.12 and for exterior

walls 0.15):
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Finally, you can place various labels.

e If you inadvertently deleted labels, you can use ) Label to label
meshes with the mark number and/or mesh type at a later stage.

In addition, you can label the mesh dimensions of individual

meshes. In general, dimensions of the same mark number only

have to be labeled once.

S
e You can use [l Dimension Overlap to manually dimension

splices in the longitudinal and transverse directions. When labels

are created automatically, all splices are also dimensioned.
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Task 2: recess

Now you will apply reinforcement to the slab opening created for the
elevator shaft.

You will mainly use the tools in the 2 Bar Reinforcement module.
You can access these tools using the flyouts on the Engineering
toolbar.

Tools: Objective:
. Edge Reinforcement %&7 S, ;@Zm ‘
it Additional @ U, %,
Reinforcement ‘ — )
'@ﬁ. Rearrange Marks - %6% I i g ohz %}
\S |0 @
i T -

Start by placing open stirrups around the elevator shaft.

To place edge reinforcement

1 Click bl Edge Reinforcement (Area Reinforcement flyout).
The system proposes the BR_GEN layer.

2 Click in the Select, Set Layers list box (Format toolbar) and then
Set....

3 Select the List layers assigned to currently selected tool option
and use the shortcut menu to make layer BR_B_B Current.

4 Select the List layers used in open documents option and set the
layer MR_M_B to Hidden, frozen so that you can see better.

5 1st edge point or click a line: click the bottom inside corner of
the shaft wall on the right.

6 2nd point: click the top inside corner.
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Edge Reinforcement ®
™ opo
0.700
OK Cancel

7 To specify the direction point, click the slab to the right of the
shaft wall.

polygon and enter the offset. Enter -0.03 for the side towards the
recess and 0.00 for all the other sides.

9 Enter 0.70 for the Edge Reinforcement Length and click OK to
confirm.

Enter Area Reinforcement b

A [l 1w | A oo o o4e0 Sk e &

& om0 & 333 M o7 0.021 0.021 = TS
OK Cancel

Tip: You can use the

(o Shape for each side of
polygon parameter to define
the bending shape at the
edges of the general
arrangement polygon,
regardless of the general
bending shape selected for
the reinforcing bars. This
allows you to define hooks at
the supports and create
straight lap joints at the same
time, for example.

el
10 Set the 2 Diameter to 8 and the I} Spacing to 0.15 and click
Shape.

Bending Shape Definitions @
Shape at start

'“I | ..., @ 0.100

Shape at end
& vee

0.100

- L ‘
a
—

w

. f— a 0140 — 2| o100
I L o omw __H b| 0100
b a 0100 b a| o100
h— —
NI j b 0100 I_/— I b | 0100
- o | asmo vne 2 s | 500

11 In the Bending Shape Defaults dialog box, select the bending
shapes for the start and end of the bar as shown above.

12 Enter values as shown for the a (0.14) and b (0.70) parameters of
the bending shape at the start of the bar and click OK to confirm.

13 Set the display mode to llx Show selected bars, switch the start
point so that the placement starts on the left and click OK to
confirm.

14 Select the bars to be displayed and place the dimension line and
the label.
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o [f necessary, set the type to Dimension line, select layer
BR_B_B for the dimension line and set the aspect to 1.00 by
selecting the Dimension line options line and clicking L),

e (lear the Dimension line text check box for the dimension
line. For the label, select Number of pieces, Diameter and
Spacing and select the automatic text leaders.

15 The next edge point for the next placement is now displayed
attached to the crosshairs. Click the corner at top left, set the
parameters and complete the edge reinforcement as shown in the
following illustration.

L
(D 1nes -5

@14@8-15
@14¢a-15
[

(D 108 -5
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The longitudinal reinforcement is still missing.

To place additional reinforcing bars as area
reinforcement

1 Click -uﬁ Additional Reinforcement (Area Reinforcement flyout).
Check that the layer BR_B_B is current. If it isn’t, select it on the
Format menu or toolbar.

2 Click From-to in the input options.

3 Enter start point: click the top inside corner of the shaft wall on
the right.

4 Enter end point: click the bottom inside corner.

5 Make the following settings:

Enter Area Reinforcement ®
Vd 1.000 Spacing|  0.070 Shap __ __ 4= N
oz 1.000 Length  4.000 Number| 3 PP ||

QK Cancel

Diameter 12

Offset to edge 0.04

Spacing 0.07

Bar length 4.00

Straight Bar

Number of bars 3

Placement display mode Il Show All Bars.

6 Click OK to confirm.

7 Place the dimension line and the label. Set the text parameters so
that only the Number of pieces value and the Diameter are
displayed.

8 Now place the additional reinforcement above the three other
shaft walls yourself.
The bar length for the reinforcement at the top and bottom is 4.0
m and 5.0 m for the reinforcement on the left.

9 Press ESC to quit the tool.
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10 Although the same bar shape has been placed along each edge,
the individual placements have been assigned consecutive marks.
Click Git Rearrange Marks (Engineering Modify flyout) and
confirm the settings.

11 Finally, click in the Select, Set Layers list box and select Set....

12 Click in the layer structure with the right mouse button and select
Match visibility from print set....

13 Select the Reinforcement, bottom layer print set and the Set all
layers visible in print set to modifiable option and click OK
twice.

All you can now see is the entire reinforcement (bottom layer)
and the floor plan without style areas.

14 Move the labels of the bar and mesh reinforcement so that they
do not collide.

The drawing should now look like this:
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Task 3: support reinforcement / spacers

Now you will create support reinforcement. Finally, you will enter
spacers.

You will mainly use the tools in the | Mesh Reinforcement
module. You can access these tools using the flyouts on the
Engineering toolbar.

Tools: Objective:
I Support Reinforcement \\: |
Place Individually =
& Modify Format p
Properties @
- o
——— ]
\ \

Start by making initial settings.

To select drawing files and to set options

1 Click Ll Open on a Project-Specific Basis (Standard toolbar)
and make drawing file 402 current. Drawing files 102 and 401
are open in edit mode.

2 Check the current reference scale (1:50) and unit of length (m) in
the status bar.
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You will now create support reinforcement.

To place support reinforcement
1 Click Support Reinforcement (Mesh Entry and Placement
flyout).

2 Click 8 Select, Set Layers on the Format menu, match the layer
visibility from the Reinforcement, top layer print set to hide the
reinforcement at the bottom, select the List layers assigned to
currently selected tool option and double-click the layer
MR_M_T.

3 Ist support point, direction or angle: enter 90.0.

4 Click the diagonally opposite points in the wall.

Support Reinforcement *
™| 0150
= 1.500
oK Cancel

5 Click =1 Support Reinforcement Length and set it to 1.50.

el

6 Click .3 Support Depth and make the following settings: 0.15
for the exterior wall and 0.12 for the interior wall.
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7 The area delimited by a dashed line represents the placing
geometry.

8 C(lick OK to confirm the dialog box.

9 Set the Mesh Type to R335A and click OK to confirm.
The reinforcing steel mesh placement is drawn.

= _

=

10 Press ESC to quit the tool.

Edge reinforcement

The edge reinforcement tool in the mesh reinforcement module is
equivalent to the tool with the same name in the bar reinforcement
module. The procedure was described with the edge reinforcement
around the slab recess. The procedure for selecting the mesh type
and setting the parameters is the same as for the tools you have

already used in the £l Mesh Reinforcement module. Consequently,
this tool is not described any further here.

A special placing mode - surplus mesh placement - can be used for
edge reinforcement. To do this, create a reinforcing steel mesh
cutting diagram in a separate window. Then you can click a left-over
mesh and place it in its entirety or just parts of it (see further down).
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Spacers

Basically, spacers are only important when it comes to ordering steel
and they should therefore be included in reinforcement schedules.
The steel quantities need to be calculated based on the drawing file
with the meshes.

There are two ways to display spacers:

e You can define the placing region for the spacers using the

@ Span Reinforcement tool. Areas without reinforcement at the
top can be entered as recesses. Then select spacer for the Mesh
Type.

When you create the placement as construction lines, it is
displayed on screen but not printed. Advantage: the required
number is determined automatically. Disadvantage: the cutting
diagram and the reinforcing steel mesh schedule include cut
spacers. This does not reflect standard on-site and bending shop
practice (only entire spacers are ordered and supplied).

¢ You can define a spacer using the A Place Individually tool and
calculate the required number manually. This is a relatively fast
approach and fully appropriate for display purposes.

Finally, you will enter spacers using the place individually tool.

To enter spacers

1 Click 4 Place Individually (Mesh Entry and Placement flyout).
Check that the layer MR_M_T is selected. If it isn’t, activate it on
the Format menu or toolbar.

Place Individually

x

Va N 3 £ 2m | oo A oo + t ‘1
-9

BK16 0N 050 B @ [ av H

2 Click 91884 Mesh Type and select spacer BK16. Enter the
required number (e.g. 120). For the number of meshes, enter 2
and set the layer factor to 60. Set the placing angle to 0.00
degrees.
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3 Set placing parameters or specify position: click anywhere in
your drawing and press ESC to quit the tool.

4 Click @ Modify Format Properties (Edit toolbar), select the
Convert 2D entities to construction lines option, click OK to
confirm and select the meshes you just created (assuming that
you want to exclude the spacers from subsequent printouts).

Meodify Format Properties
Type of medification
Maodify Farmat Properties

Format properties

Layer

Sequence (+ is in front)

i

*) Convert 2D entities to construction lines
Convert construction lines to 2D entities

Change "From layer" for pen, line and color

DEFAULT

OK Cancel

==
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Task 4: cutting diagram [ excess mesh

To finish, you will create a cutting diagram for the bottom mesh
reinforcement layer and place excess mesh.

You can access the tools via the flyouts on the Engineering toolbar.

Tools: Objective:

e feors CrMiphn
A/ Place Individually e

Start by creating the cutting diagram for the bottom reinforcement
layer.

Note: To create a cutting diagram, a drawing file with reinforcing
steel meshes must be current. If the reinforcing steel meshes to be
included in the cutting diagram are located in different drawing files,
open the other drawing files in edit mode. Meshes on visible but
frozen layers are not included in the cutting diagram.
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Tip: To place the mesh
cutting diagram in the
drawing file, you can also use
the Mesh cutting diagram of
the Mesh Legend tool.

However, this diagram cannot
be sent to the printer.

To place a cutting diagram in a drawing file

1

Make drawing file 401 current. Drawing files 102 and 402 are
open in edit mode.

On the Format toolbar, select pen thickness 0.25 mm and line

type 1.

Open the Layers palette and set layer MR_M_B to Modifiable and
layer MR_M_T to Visible, frozen.

|Layers 1 x
Tools | |Properties| Wizards || Library || Connect || Layers
= 8 O %) L
Status Short name Full name

| DEFAULT DEFAULT
* Design
[JO[] DE_GEMOZ General02
¥ Surface elements
0[] su_strL Area style
¥ Bar reinforcement
0[] BR.B_B Bar reinforcement at bottom
¥ Mesh reinforcement
O] MR_M_B Mesh reinforcement at bottom
OO MR MT_ Mesh reinforcement at top
Current
Modifiable
Visible, frozen L\\)
Hidden, frozen

Click =1 Mesh Reports (Reports flyout).

In the Reports dialog box, click the Default folder on the left,
select the Mesh cutting diagram report and click All in the input
options to include all marks.
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The report is displayed in the Report Viewer.
Report [E=N(E=R >N
Parameters E 1 of 3 b M % @ I:l‘ B' Fit to Page -

H

lgl Excel

£ Mllplan

4 Aliplan System Parameters Mesh cutting diagram b Allplan L\\A

o e 5 or

Company logo C\ProgramData\Men """ e ] word

Company name Eamzd oy pee iR

Component Slab reinforcement || 20 T 1OMA0IE T W

Construction project

Date 10/14/2013 20EMA 1'0524A TOEMA 105244 1'Q188A

Edited by bmertin

Ermail

Layout

Project name Engineering Tutorial |

Steel list number

Telephone Mumber

Time: 14:36

4 User Interaction
PageMo 1 1
Show logo
1'010eA L 101684 ) FQIEA
I0A3EA 1'03354 TOsTA
| ] [ Hopes Hame s bl
7]as2a 705,30
HCTED 20850 |
7| asesa S0
FICETY 11340
2| Tas 154850
Company address
@411@ =

6 Click E= Export and select Allplan.

The current drawing file is displayed and the report is attached to
the crosshairs.

7 Place the report in the drawing file.

This saves the mesh cutting diagram in the drawing file and
prints it along with the drawing file with reinforcing steel meshes
placed in the layout.
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After you have created a cutting diagram in which the entire meshes
are filtered out, you can see which excess pieces are left. You can
click and then place these.

To place excess mesh

1
2

Click 4 Place Individually (Mesh Entry and Placement flyout).

Select a layer. Make sure that you do not mix the bottom and top
reinforcement layers.

Click 2 Excess Mesh Placement on the Place Individually
Context toolbar.

In addition to the current viewport, the Excess Mesh Placement
window appears, which shows all the meshes with pieces of
excess mesh as a cutting diagram.

In the cutting diagram, click the piece of excess reinforcing steel
mesh that you want to place.

The Excess Mesh Placement window is closed again.

Place the piece of excess mesh. You can retain the dimensions of
the reinforcing steel mesh copied automatically or change them.

To place more pieces of excess mesh, click Excess Mesh
Placement again.

Printing layouts is covered in exercise 9.
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Exercise 7: BAMTEC® reinforcement

Tip: Refer to the chapter
"Reinforcement methods - 3D
reinforcement model" in the
Allplan help:

=7 Engineering
EGen eral Information
E| Floor plan and shell drawing
Key Plan module
[=7 Reinforcement drawing
=7 Reinforcement methods
E Basic approach

Requirements:

Allplan 2014 Engineering comes in different module packages.

Open the Tools palette and check whether the (] Engineering
family includes the following module(s):

= BAMTEC

In this exercise you will manually create BAMTEC carpet
reinforcement based on FEA calculation results (i.e. the FEA results
are not used automatically). You will not work with the 3D model
(method 3, see Tip) as you will only create a floor plan without
sections.

You will mainly use the tools in the [l BAMTEC module. You can
access these tools using the flyouts on the Engineering toolbar.

Start by selecting fileset 5 with the following drawing files:

Drawing Drawing Drawing file name
file number
5 501 Structure
502 Carpet outline
503
504

You can find the fileset in the 'Engineering Tutorial’ project (see
”Appendix: creating the training project”).
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Tools Objective:
Tip: Look in the Allplan help  EZ Carpet Outline T o v
for basic information on the — ) ] -
] BAMTEC module: 21 Separate into Files
[=7 Engineering ﬁ Carpet Mounting StrlpS B
E|General Information i
EIFloor plan and shell drawing ;'_'Il Basic Carpet =
EKE‘[ Plan module .
[£=7 Reinforcement drawing Relnforcement
EReinfurcement methods. . ————F———
[T Defautts, Cross-section catalogs o) Additional Carpet R
5] Bar Reinforcement module Reinfo rcement ¥
Erﬂesh Reinforcement module °
=7 BAMTEC module & :
Bsvce =h BAMTEC File =
g Library

The following exercise is based on the slab outline shown below. The
process of creating this slab outline is described in detail in the
"Finite Elements” manual. The FEA results used here are also taken
from this manual.

In this exercise, you will reinforce the area with hatching (see
below). If you have downloaded the training project from the
Internet, you will find the slab outline in drawing file 501. All you
need to do is set the existing layers to visible. Otherwise, create the
slab outline yourself.

To copy or draw the slab outline

1

If you have already carried out FEA calculations for this example,
copy the floor plan (consisting of grid, walls and recesses) to

drawing file 501.

Place the grid, walls, beams, columns and recesses on different

layers.

If these drawing files are not available to you, you can create the

slab outline yourself using the v Basic: Walls, Openings,

Components or B praft module. Use the dimensions given.
Place the grid, walls, beams, columns and recesses on different
layers. You can use the layers proposed by Allplan.
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Tip: You can specify how
BAMTEC reinforcement is
displayed using the

Options tool.
For more information please
consult the Allplan help.

Start by making initial settings.

To select drawing files and to set options

1 Check whether the Engineering toolbar is displayed at top left. If
it isn’t, open it as described in the initial settings (on page 120).

2 Click Ll Open on a Project-Specific Basis (Default toolbar),
make drawing file 502 current and open drawing file 501 in edit
mode.

3 Check the current scale (1:100) and unit of length (m) in the
status bar.

4 On the Format toolbar, select pen thickness 0.25 mm and line

type 1.

5 Open the K Options and check that the Reinforce with 3D
model option is not active.

The first step involves defining the carpet outline, i.e. the size of the
carpets, the unroll direction, the label and the position of the carpets
in the slab.

Note: Certain technical criteria pertaining to the application
guidelines for the BAMTEC reinforcement technology have to be
observed (see Tip on page 232)!

To define the carpet outline

1 Click B carpet Outline (BAMTEC flyout).
The system proposes the layer BA_B.

2 Click in the Select, Set Layers list box (Format toolbar) and
choose Select....

3 The List layers assigned to currently selected tool option is
selected. Double-click the BA_B_B_1 layer.

4 From point or element or enter offset: enter 0.00 for the support
depth in the dialog line. Press ENTER to confirm.

5 To create the first carpet, use the inside wall corner in the B/1
axis for the start point.
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6 Enter 14.10 for the &% X coordinate in the dialog line and -
14.25 for the & Y coordinate. Press ENTER to confirm.

7 Press ESC to close the polyline and click OK to confirm.

Carpet Qutline B
e ™4 oooo
=
0K Cancel

8 On the Carpet Outline Context toolbar, enter an angle of 180°.
This defines the position of the first bar and thus the unroll
direction.

9 Enter 0.10 m for the offset between the first bar and the edge.

10 Define the carpet label as shown. "B 1.1“ stands for: bottom
layer, carpet 1, 1st carpet.

Carpet Qutline ®
Angle 180.00 Carpet Label Bench
Offsst| 0,100 Lower 1 1 I

OK Cancel

11 Click OK to confirm the values.
The carpet outline is created with the unroll direction, first bar
and label.

12 Now you can enter the next carpet. Repeat steps 4 through 11
and create the other carpets. Name them B1.2, B1.3, B1.4,, B1.5
and B1.6. Please note the following:
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Enter the outlines of the carpets B1.2 and B1.3 for the longitudinal
direction yourself. Please note the following:

e In the D and F axes, the carpets are joined without overlap.

e When you define the carpet outline for carpet B1.3, do not
include the rectangular area at bottom left between grid point
G/1 and the top right corner of the recess as this would cause the
program to generate illegal reinforcing bars. The offset around
the recess needs to be set to 0.05 m.

Carpet Outline ®
Angle 50.000 Carpet Label Bench

Offset| 0,050 Lower 1 4 I

OK Cancel

e The values on the Context toolbar above are valid for the carpets
B1.4, B1.5 and B1.6. The angle for the unroll direction (90°
instead of 180 degrees) and the offset to the first bar (0.05 m
instead of 0.10 m) are different. Use the layer BA_B_B_2.

e The carpets B1.4 and B1.5 are 12.00 m long in the transverse
direction. With an overlap length of 0.50 m, the length of carpet
B1.6 is 12.70 m. Carpet B1.6 has a recess in the bottom left area
(similar to carpet B1.3).

e To define the lap joint, specify the start point by moving the
crosshairs to the bottom left corner of the carpet previously

created. Then enter a value of 0.50 in the & Y coordinate data
entry box, which is highlighted in yellow. In this case, the offset
values are 0.00.

Alternatively, you can enter an offset of -0.50 for the top side of
the outline of carpets B1.5 and B1.6.

Compare what you have drawn with the finished carpet placing
drawing below.
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Tip: You can also separate all
the carpets in one go by
selecting the following
option:

Copy ALL carpet outline
polygons to different
drawing files

Tip: As opposed to manual
reinforcement, the

ﬂl‘i Reinforce tool is used to
reinforce carpets
automatically.

This tool is designed with
economic considerations in
mind, allowing you to create
a structurally adequate
reinforcement system in a
fully automatic manner.

Before you can create the reinforcement for the carpets, you need to
distribute the individual carpets in the placing drawing onto
different drawing files. You will use carpet B1.1 as an example.

To distribute carpets onto different drawing files
1 Click E Separate into Files (BAMTEC flyout).

2 Select the Copy ONE carpet outline polygon to a different
drawing file option in the File Settings and Reinforcement
Mode dialog box.

3 Check the box in the File Splitting area and click OK to confirm.
4 Click the first bar of carpet B1.1.

5 Specify the first drawing file - 503 - in the Select destination
drawing file dialog box.
The program automatically creates drawing files 503 (data for

assembly drawing) and 504 (layout). (See for yourself: click .]

Using carpet B1.1 as an example, you will now learn about the
functions used for reinforcing carpets manually. You will use the
following tools:

fff Carpet Mounting Strips
Eﬂ] Basic Carpet Reinforcement

I%  Additional Carpet
Reinforcement

Note: For production reasons, the following values defining the
spacing between mounting strips must be adhered to:

the first mounting strip begins after 52.5 cm. After this, the
mounting strips are spaced at 1.55 m intervals.
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To place mounting strips

1

6

7

8

Click Open on a Project-Specific Basis (Default toolbar) and
double-click drawing file 503.

Click e Carpet Mounting Strips (BAMTEC flyout).
Carpet mounting strips are always created on layer BA_B_MST,
regardless of the selected layer.

As you separated the carpet polygon beforehand, a general
arrangement polygon already exists. Click Match in the input
options.

Select the polygon you want to match: click the polygon and click
OK to confirm.

Make the following settings on the Carpet Mounting Strips
Context toolbar:

s .

11 Spacing 1.55

A Angle 90° (entering an angle of 90° places the start point at
bottom right. Production also starts

at this point.)

Line type for bar display 4

Carpet Mounting Strips x
Z 1 /5| 0000 1l 1
& mo1ss0 & M 1438 I

OK Cancel

Click OK to confirm the entries.

The mounting strips are displayed in the selection color. The
dimension line is attached to the crosshairs. You do not need to
dimension the mounting strips manually as they will be arranged
automatically by the production machine. Skip labeling by
pressing ESC.

Press ESC to quit the o Carpet Mounting Strips tool.
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The basic carpet reinforcement has a diameter of 12 mm and is
spaced at 20 cm intervals. It has the mark number 3. See the
illustration of the reinforced carpet at the beginning of this exercise
(objective).

To define basic carpet reinforcement

1
2

Click 2l Basic Carpet Reinforcement (BAMTEC flyout).

Select carpet to which you want to apply basic reinforcement:
click the carpet polygon.

Enter the following parameters on the Basic Carpet
Reinforcement Context toolbar:

523/ Diameter 12
i .
11 Spacing 0.20

7% Offset to starting edge 0.100
Line type for bar display 1

Easic Carpet Reinforcement x

& 1l A 1800 o £ 1
& i oz & m iz o100 | 013 I

OK Cancel

Click OK to confirm the entries.

The basic reinforcement is displayed in the selection color. The
palette for the dimension line appears.

o If necessary, set the type to Dimension line, select layer
BA_B_B_1 for the dimension line and set the aspect to 1.00
by selecting the Dimension line options line and clicking E]

e Select the Bar markers option and place the dimension line in
the workspace.

Switch to the Text/leader tab, set the label parameters so that the
Number of pieces, Diameter and Spacing are included, select the
automatic text leaders and place the label in the workspace.

Press ESC to quit the 4l Basic Carpet Reinforcement tool.
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Tip: The entries you make are
immediately displayed in the
preview. This way, you can
check the effects of your
settings at any time.

You will place five different types of additional reinforcement in
carpet B1.1. Marks 4, 5, 6, 7, and 8 are used for the additional
reinforcement. See the illustration of the reinforced carpet at the
beginning of this exercise (objective).

To place additional carpet reinforcement

1 Click B Additional Carpet Reinforcement (BAMTEC flyout) and
select layer BA_B_B_1.

2 Set the following parameters on the Additional Carpet
Reinforcement Context toolbar:

Z Diameter 8

& Anchor point (start point of placement): top left
g dx offset = 0.35

-:-i dy offset = 4.002

D Placing length 5.25

Tﬁ' Spacing 0.20

/% Angle = 180°

Number of pieces: 10

Additional Carpet Reinforcement *

#
“

0 0 pmo [Tl T 525 A tem 1 [ 1.
> il I /
=7 33| ame |i1) m 0.200 &/ 2515 Number| 10 FE ||

Cancel

3 Place the additional reinforcement at the top left corner of the
carpet polygon.
4 The additional reinforcement is displayed in the selection color.

Place the dimension line and the label using the settings
proposed by the system.
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You will now create more additional reinforcement. Repeat steps 2 to
4 and use the settings given in the following section.

To create more additional reinforcement

1
2

The B Additional Carpet Reinforcement tool is still active.

Make the following settings on the Context toolbar:
2 Diameter 8

| Anchor point (start point of placement): top left
i dx offset = 0.15

=3 dy offset = 6.002

I| Placing length 6.45

T .
11 Spacing 0.20
Number of pieces: 10

Additional Carpet Reinforcement *

7 s 3T - Y A 18000 1 E] 1 -
o ¢
g k==l i ez (iT] i 2o & 2515 Number| 10 re Il

Cancesl

4

[<) N )]

Place the additional reinforcement at the top left corner of the
carpet polygon.

Place the dimension line and the label.
The IR Additional Carpet Reinforcement tool is still active.

Make the following settings on the Context toolbar:
4 Diameter 8

| Anchor point (start point of placement): top left
s dx offset = 0.055

3 dy offset = 8.002

Il Placing length 5.65

i .
111 Spacing 0.20
Number of pieces: 24
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Additional Carpet Reinforcement

x

i Mumber

Va 0 omss i1 8 I 565 A 18000 1 E] 1.
. >
P =N R A1 IR w0200 & 2515 24

re ol

Cancel

7 Place the additional reinforcement, the dimension line and the
label.

8 The =9 Additional Carpet Reinforcement tool is still active.

9 Make the following settings on the Context toolbar:
Diameter 8
E Anchor point (start point of placement): top left
= dx offset = 0.055
¥ dy offset = 12.802
H_L Placing length 6.25
11 Spacing 0.20
Number of pieces: 8

Additional Carpet Reinforcement x
Va N 0 o 3T - Il sa2s PARRE L] 1 E] 1.
X S i
P B S RS SRR VY- I | 0200 & 2515 Number| 8 Pr |
Cancel

10 Place the additional reinforcement, the dimension line and the
label.

11 The . Additional Carpet Reinforcement tool is still active.
12 Make the following settings on the Context toolbar: Do not forget
to change the anchor point:
& Diameter 8
= Anchor point (start point of placement): top right,
i dx offset = 0.25
=3 dy offset = 13.202
I| Placing length 5.35

(as .
11 Spacing 0.20
Number of pieces: 6
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Additional Carpet Reinforcement x

. -9
g L=~ i3 e it o o2m & 2515 Numbsr| 6 Pe |||

535 A 18000 1 1+

Cancel

Tip: If drawing file 504 is
open in edit mode, you can
use the definition point you
specified when the carpets
were separated.

13 Place the additional reinforcement at the top right corner of the
carpet polygon.

14 Place the dimension line and the label.

15 Press ESC to quit the Additional Carpet Reinforcement tool.

You can use the Reinforcement Reports and Reinforcing Bar
Legend tools to generate various reinforcement schedules.

Now you will create a BAMTEC file for carpet B1.1.

To create a BAMTEC file
1 Click E-P BAMTEC File (Lists/Schedules flyout).

2 Select placements from which you want to derive the BAMTEC

file: use the E Brackets (Filter Assistant toolbar) or the left
mouse button to select all the placements.

3 Set the definition point: specify the carpet’s local reference point.
The system proposes two points. Click the point at bottom right.
The point clicked is marked by a symbol.

4 Place the name of the carpet file where you require.

As opposed to automatic reinforcement, you need to create the
symbols required for carpet production. To finish, you will create
these symbols using the symbols provided.
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To place symbols

1

Open the Library palette and click Symbols in the navigation
field at the top. If you have not yet selected a symbol, click the
Symbols folder.

Open the Default, Unfinished structure and BAMTEC symbols
folders.

Double-click the BEZ-Aufroll 1:50 symbol (symbol number 6)
with the left mouse button.

Place the symbol with the text to the right of the carpet.

Click XK Delete (Edit toolbar) and delete all the redundant
elements.

il Move (Edit flyout) the text into the correct position.

Dieses Elsen rot markiert!

%71 ® 12 -20

(T)e o8 -2006)2t 68 -20(5) 1068 -2(k) 10068-2

Resterme der Absiénde 20 u. 10 cn
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Reinforce carpet B1.4 yourself. The approach is the same as with
carpet B1.1. The start point of carpet B1.4 is the bottom left corner of
the carpet polygon. The additional reinforcement is spaced at the
following intervals (reference point at top or bottom right):

Additional reinforcement 1 (mark 3):
dX = 4.151, dY = 1.00, L =5.85

Additional reinforcement 2 (mark 4):
dX = 7.151, dY = 0.20, L =6.50

Additional reinforcement 3 (mark 5):
dX = 11.551, dY = 0.00, L =4.45

Additional reinforcement 4 (mark 6):
dX = 4.151, dY = 0.00, L=2.85

Additional reinforcement 5 (mark 7):
dX = 5.151, dY = 0.00, L =4.85

Carpet B1.4 should look like this after the rearrangement:

@13 ¢ 8-20 L=b45em @22 ¢ §-20 L=650cm @15 ¢ 8-20 L=585cm
@71 ¢ 10-20

2
k]
. g
e T N T i M =
5 $
& H
9 g B
g OTITITTITT T I I o
; 5
<
< 8 8
P AR ERRERENE H [ —
- E : 5
=] l§ 0 il
% g it !

hes *‘F Pepoicnals ver
23 ¢ 8-20 L:LBSUN@S ¢ B8-20 L=285cm
‘mrmii

Printing layouts is covered in exercise 9.



248

Cross-section catalogs Allplan 2014

Cross-section catalogs

This chapter shows two examples of cross-sections catalogs. You will
learn how to modify mesh cross-section catalogs and add a new
custom mesh.

Note: Using the self-explanatory forms of the cross-section catalogs,
you can define new catalogs (e.g., custom mesh) or change existing
ones. Cross-section catalogs can be viewed on screen and listed in
reports. You can create reports for individual cross-section catalogs
straight from the overview of all cross-section catalogs.

These reports can be customized, printed, placed in the current
document or saved as a file in Excel, Word or PDF format. Numerical
input for custom meshes is supported, as is output of a mesh with a
single bar representation.

Now you will change the length of a standard stock mesh from 6.00
m to 12.00 m.

To modify a mesh cross-section catalog

1 On the Tools menu, click Defaults and then Cross-Section
Catalogs. The following dialog box appears:

Cross-Section Catalogs @

Overview
Mame Steel grade Type
Custom mesh (4] BSt 500 M{A) MA
Custom mesh (B) BSt 500 M(B) MA
HS mesh B5t 500 M hA
Spacers BK/S B5t 500 M hA
Spacers BT B5t 500 M hA
Stock mesh (4) B5t 500 M{A) MA
Stock mesh (B) B5t 500 M(B) MA
BAMTEC strips Tragband RU
Mesh cross-sections B5t 500 M RU
Reinf. bars (B) BSt 500 S(E) RU

Functions

Mew Edit Delete Cutput
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2 Click Stock meshes (A) BSt 500 M(A) and then Edit. A full
overview of the mesh cross-section catalog is displayed:

Mesh X-Section Catalog @
Cross-section catalog
MName Stock mesh (A)
Steel grade BSt 500 M{A)
Overview
Mesh label Length [m] Width [m]
Q1884 6.000 2.300
Q2574 6.000 2300
Q3354 6.000 2.300
Q4244 6.000 2,300
Q5244 6.000 2,300
Q6364 6.000 2350
R188A 6.000 2,300
R25TA 6.000 2.300
R3354 6.000 2.300
R4244 6.000 2300
R5244A 6.000 2.300
Functions
Mew Change Delete COutput
OK Cancel

3 (lick a mesh and then Edit.
The following dialog box appears:
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Stock mesh @
Mesh description Mesh weight
Mesh labe Q3354 Mesh weight 74.30 kg
Longitudinal overlap 0.38m As longit. 3.35 cm2/m
Transverse overlap 038 m As transv. 335 emZ/m
Mesh parameters Mesh display
04| 00 4 80 |- 0 00
. T | 7500mm
-
T | 150,00 mm
Pl BD
600m [
=
T [m0mm]| |
L
= = =
23.00 mm 150.00 mm 23.00 mm
4“ '1'
230m
Save |  Close |

4 Enter 12.00 m for the length of the mesh.

5 The weight of the mesh is automatically calculated based on the
modified length. This way, you can modify and save settings
without any problems.
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Next, you will enter a new custom mesh.

To enter a new custom mesh

1 The Stock meshes (A) BSt 500 M(A) dialog box is still open
from the last task. Click Cancel to return to the overview of the
Cross-Section Catalogs.

2 In the Cross-Section Catalogs dialog box, click New. The
following dialog box appears:

Mew Cross-5ection Catalog @
Type

Mesh X-Section Catalog

Bar X-Section Catalog

| Close |

3 (lick Mesh X-Section Catalog.
Another dialog box appears:

Mesh X-5ection Catalog @

Cross-section catalog

MName Custom mesh

Steel grade M500

Cverview

Mesh label Length [m] Width [m]

Functions

New Change Delete Output

J Cancel
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4 C(lick in the Label data entry box and enter Custom Meshes.

5 C(lick in the Steel grade data entry box and enter 500 M.

6 Click New.

A dialog box shows which meshes can be defined and how:

Select Mesh Type
Stock mesh

- Do not show bars

- With standard
bar combination

- With any

bar combination

Custom mesh

- With standard bar
combination,
without edge bars

- With standard bar
combination,
with edge bars

- With any

bar combination

Custom design mesh

- With any

bar combination
Spacer
- Do not show bars

- With any

bar combination

]

| Close

==

Stock meshes without a single bar representation;
only the length, width and overlap are variable.

Stock meshes with a single bar representation;
the parameters are entered in a dialog box.

Stock meshes that can be defined in the
workspace.

Custom meshes without edge bars; can be
defined in a dialog box.

Custom meshes with edge bars; can be defined in
a dialog box.

Custom meshes that can be defined in the
workspace.

Custom meshes with any bar combination;
special functions are provided for defining these
meshes in the workspace.

Spacers that can be defined without single bars;
spacers are entered in the same way as stock
meshes without a bar representation.

Spacers with a single bar representation; can be
defined in the workspace.

7 C(Click Custom mesh, without edge bars.

Allplan 2014
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8 A dialog box opens. Enter a name for the new mesh: Custom
Mesh 1.
Custom Mesh without Edge Bars @

Mesh description Mesh weight

Mesh labe Custom mesh Mesh weight 9150 kg

Longitudinal overlap 030m As langit, 6.71 cm2/m

Transverse overlap 030 m As transv, 2,84 cmZ/m

Mesh parameters Mesh display

Hl 8.0 | |dz
e
N T[ss000mm| T
T [ 20000 mm
Flas
510 m
b
350,00 mm
>
= Ll L —
25.00 mm 150.00 mm 475.00 mm
* +
290 m
Save | Cancel |

9 Now you can set the parameters as you need. Start by entering
values for the length, width and the spacing between the bars.
The overlap values depend on these parameters.

10 Save the settings and finish.
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Unit 5: Layout Output

This unit, which consists of two exercises, shows you
how to assemble and print layouts.

255

= You will use the tools in the &3 Smart Symbols
module to create a title block as a label style.

* [In addition, you will print a layout containing the
elevator shaft you reinforced in exercise 4 (unit 4)
using the tools in the L2 Layout module.
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Requirements

for printing

Before you print, the output device needs to be configured correctly.
If you are working on a network, you can use any device connected
to a remote machine (assuming it is configured correctly).

To do this, connect the output device and install it in the Windows
Print Manager. On a network, install the device on the computer to
which it is connected and then share it.

For more detailed information, please consult your printer’s user
guide or the documentation of the operating system.

Printing the screen contents

Printing the screen contents is covered in the Basics Tutorial. Below
is a short description of this approach.

To print the screen contents

1 Select the drawing files and layers you want to include in the
printout.

2 Click 'v—‘-l Print Preview (Default toolbar).

3 Click ¥# Print Preview Settings, select the Representation tab
and select the Thick line check box. This not only makes the
different line weights visible on screen but also ensures that they
are also printed as such.

In addition, you can use the Print construction lines option to
specify whether construction lines are to be included in printouts.
Set the other options as required.

4 If necessary, set the scale in the print preview.
5 Click £ Set Up Printer and select a printer.
6 Click I‘__g Quick Print.

7 Press ESC to close the print preview.
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Exercise 8: custom title block

Requirements:

Allplan 2014 Engineering comes in different module packages.

Open the Tools palette to check whether the [ Bonus Tools family
includes the following module(s):

2]
Cz1 Smart Symbols

Allplan 2014 provides a wide range of "intelligent” title blocks based
on label styles. Label styles contain design entities, text and
attributes.

The advantage of a title block with attributes is that the text will
update whenever the layout is opened.

You can create your own label styles or modify existing title blocks

el
using the tools in the C&1 Smart Symbols module. Attributes can
only be used when you assigned them during project creation or
later.

This exercise requires an empty drawing file.

Tools:

g= Library
4= Label Style

To assign attributes
1 On the Default toolbar, click 6% New Project, Open Project.

2 Select the Engineering Tutorial project, open the shortcut menu
and click Properties...
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3 In the Project Settings dialog box, click Assign attributes....

New Project, Open Project - O ®
& | B & <)
Project name Created on | Project template Description
@ = ; - -
8 Architecture Tutorial Project Settings ==

@Architecture Tutorial fwith model)
£+ Enaineerina Tutorial {with model)
MNew Project Project name:
Copy to

Praoject info

Delete project

Rename Created on: | Assigf attributes... |

R L\\s Free memory:

Current project size!
Path settings

Folder: C:\Data"Memstschek\ Allplan_2014% Pen and line definitions: Office *) Project
Fonts: * Office Project
Patterns, hatching styles, area styles: ® Office Project
Bar and mesh cross-section catalogs: # Office Project
Layer structures, line styles, drawing types: Office £ Project
Attributes proposed * Office Project
Urban planning symbols Drawing symbal regulations
CAD-TAI project assignment CAD-TAI research... *OFF*
Settings

Offset coordinates X Y. F
Project angle for rotated plan view: 0.000
Input, output currency: EUR
\ QK | Cancel

4 In the Project Attributes dialog box, click D Hide unassigned
values and open the Architect group.

5 In the Attribute value column of the Architect row, click in the
box and type in the following:

Sam Sample

6 Use the same approach to enter the Sample Street, Anytown
value for the Architect address attribute.

7 Specify the attributes for the Client, Construction project,
Building information and Structural analysis groups as shown
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Tip: You can find the title
block as a drawing file and as
a symbol in the training
project. Information on
downloading the training
project can be found in the
appendix; please refer to the
section "Training projects on
the Internet (on page 316)".

in the illustration. After this, click 2 Hide unassigned values to
see all the attributes you have defined.

w Project attributes - Engineering Tutorial (with model) EI@
7T Show unassigned values
Group Attribute name Attribute value
Architect
Architect Sam Sample
Architect address Sample Way, Anytown
Building information
Lacation/ plot Plan City
Client
Client Edward Example
Client address Example Road, Example Town

Construction project

Construction project name Mew detached house
General
Structural analysis

Structural analysis Stable Engineers

Structural engineer address Stable Street, Stable Town

QK Cancel

8 C(lick OK to confirm the Project Attributes, Project Settings and
New Project, Open Project dialog boxes.

The attributes you just assigned will now be used in the label style
for the title block.

This exercise assumes that the title block created in exercise 5 of the
Basics Tutorial is available to you. You have already drawn this title
block and saved it as a symbol with the name Original in the Title
blocks library file.
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Exercise 8: custom title

block

Allplan 2014

Tip: To position the label
styles quickly and accurately
at a later date, you can place

& Point Symbols as
i@ Construction Lines to

mark the beginning of the
original text to be deleted

(Create menu, Draft module).

To create the title block as a label style

> The title block named Original you created in the Basics Tutorial

is available.

2 Open an empty drawing file and close all the others.

S Select the £F Bonus Tools family in the Tools palette and open
]
the L& Smart Symbols module.

< Set the scale to 1

1.

1 Click the Symbols folder in the Library palette.

2 Open the Office folder (or the Project folder if you are working

with the training

project).

3 Open the Title blocks folder.

4 Double-click the Original symbol with the left mouse button.

x

Library o
Tools | |Properties |Wizards | Library || Connect|| Layers
= 4| =y P Symbols P Project b Title blocks pel
Preview
]
[
[
= =
Ermozst Bacany Uak Tros 12
=T
=
. kx5
i
Font size
Auto-scale v
Font factor 1.0000
Title blocks
@
[
Criginal %
| Original
&
@ Mew symbol
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5 To place the symbol, click in the workspace.

6 If the title block appears too small, click % Zoom All at the
bottom of the viewport.

7 Delete the text that is to be replaced by attributes (project-specific
information).

Index | Art der Anderung

Datum / Name

Index | Art der Anderung

Datum / Name

Planinhalt

Balkonfertigteil Typ 12

P aninhalt

StraRe, Minchen

Buuvorhaben NEUDUU einer‘ WDhnﬂnlUgE Bauvorhahen +
mit Tiefgarage +
Bauherr Bauherr o Bauherr: Datum
Sfl"l:lﬁe, Mi.in[hen ieze\thnet igzm[hngr
ame me
Architekt Ar\[hitekfen E‘E:;uﬂ Architekt i;:\r‘:”
StraBe, Minchen Madstab Madstab
! M 1:50/25 M 150725
Ingenieurbiiro Beratende Ingenieure ;t(u;gu;\(mer Ingenieurbiiro :t ;t(n;zu;v(mer

8 Click ¥= Label Style (Tools palette, Create area).

9 On the context toolbar, click Attribute.

Label Style

Atrbute
Formula

DefFol

Foil

Depends on

R3C -

<=R5C
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10 Select the Project category, choose the Construction project
name attribute and click OK to confirm.

Attribute Selection

Category

Attribute

Internal architecture
Landscaping

Urban Planning
Thermal Insulation
Layout

Special archit. attributes
Project

Digital Terrain Model
Architectural Roof Covel
Smart Fit

Fixtures

Precast elements

TBM Heating

Computer

Construction project
Construction project address
Construction project email
Construction project homepage
Construction project mobile number
Construction project name
Construction project street
Construction project ZIP code/city
Construction site

Construction stage

Construction supervision
Construction velume

OK Cancel

11 Set the text parameters as shown below and change the format:

A30.

This defines the attribute as a text item with 30 characters

maximum.

Label Style

s B

5000 1A 1000

A Format A30
5,000 T | sison Adiust Unit

Infa

12 Switch off Adjust height/width to scale and place the attribute
so that it is left-aligned in the box for the construction project

details.

13 Repeat steps 9 through 11 and place the following attributes.
Set the text height and width for the Client address, Architect
address and Structural engineer address attributes to 4.000 mm.

Use a value of 5.000 mm for all other text items.
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Category Attribute Format  Text
height
Project Construction project name  A30 5.000 mm
Location/plot A30 5.000 mm
Client A22 5.000 mm
Client address A30 4.000 mm
Architect A22 5.000 mm
Architect address A30 4.000 mm
Structural analysis A22 5.000 mm
Structural engineer address  A30 4.000 mm
Layout Layout name A40 5.000 mm
Tip: When placing text, you
can align it using track lines
or you can do this later using
the [¢a Align Text tool
(Change menu, Text module).
Index Changed Date / Nama
Drawing

Layout name (first 50 characters)

Froject . .
Construction project, name
Location/ plot
Cent Client ﬁ;x.zmx
Client, address et by
Arentect Architect e
Architect, address_____ |=E .
Snnneer Structural analysis ;'23'&”
Structural engineer, address__

14 Click DefFol (Define Foil) on the context toolbar.

15 Using the left mouse button, enclose the entire title block in a
selection rectangle.
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16 Click the point at bottom right. This will serve as the reference

point.

Note: Title blocks must be saved in subfolders 7 and 8 as these
subfolders are associated with the =l Label tool in the 2 Layout

module.

17 Click subfolder number 8 and enter Title blocks.

-

Save Data |E|
Folder Subfolder MName
Office 8 Title blocks
Private 1 Enter @
Project 2 :
External path 3 New entry Title blocks
4
5 OK Cancel
[
7 7
& Title blocks 8
9 9
10 10
11 11
12 12
0K Cancel

18 Click line 1 and enter Reinforcement drawing.
19 Click OK to confirm the Save Data dialog box.

20 Press ESC to quit the tool.
The title block is now saved as a label style.

Note: You can also find the ¥= Label Style tool in the following
modules:

% Object Manager, Rooms, Surfaces, Stories,
[+1+]
B8 Landscaping, & Urban Planning
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Exercise 9: assembling and printing layouts

Printing finished layouts is a critical step. In Allplan 2014 a layout is
the element that you bring to paper.

As opposed to design using a conventional drafting board, the scope
of the layout does not have to be defined in advance.

Generally, you leave the layout (which involves arranging and
laying out drawing files and/or filesets) until you're finished with the
design. This is also the stage where you define the paper size, scale,
border, angle, and so on.

Each project can contain up to 9,999 layouts.

Tools:

Set Up Page
Layout Element
Update Layout

Print Layouts

Gite W R

Layout Window
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Task 1: assembling layouts

Tip: The name you enter here
will appear as the Plan name
attribute in the title block!

Now you will set up a layout with the general arrangement and
reinforcement of the elevator shaft. This involves two steps:

o Defining the layout, that is, the sheet size, border and title block.

e Selecting the layouts elements, that is, the filesets and drawing
files.

To define a layout

1 Click < Layout Editor (Default toolbar).
The icon remains pressed in until you quit the layout editor again
and switch back to document edit mode.

2 (Click Open on a Project-Specific Basis (Default toolbar) to
select the layout in the Open on a project-specific basis: layouts
dialog box.

3 Select layout 1, press the F2 key and enter Elevator shaft -
reinforcement drawing for its name.
Close the dialog box.

Open on a project-specific basis: layouts ®

2ll=lL)% \HihalElE 8 2 =
Layout structure
@ Engineering Tuterial {with model)
w 55 Alllayouts
i 1 Elevator shaft - reinforcement drawing :
2

3
10

ala[alalalalatalal

Active layout: (1) Elevator shaft - reinforcement drawing Close:

4 Click L& Set Up Page (Tools palette, Create area).

5 In the Page area, set the Format to DIN A2 and select

Landscape. In the Margins area, select the Without (role,
PDF) option.
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Using the setting you make for the margins, Allplan always
places the page so that its bottom left corner coincides with the
bottom left corner of the printable area of the printer you have
specified in the = Print Layouts tool. This ensures that the
printout includes all the elements that extend as far as the
margins of the page.

6 Click the Layout border button in the Properties area.

Set up page . ox

Set up page
Page

Farmat DIM A2 =
Width 594.0 mm
Height 420.0 mm

Crientation ‘ |

Margins

Margin *) Without (role, PDF)
With (single sheet)

Properties

Title block Mone -

Background Mone v

[,g gf Close

7 Set the border type to Filing margin (DIN 824 A), change the
format properties of the layout border, if necessary, and click
Close to return to the Set up page palette.
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Set up page

= Setuppage }» Layout border

Border type

Barder pen and line type

Cutside 0.25
1

Inside[¥] | p.50
1

Other[¥] | p.35
1

Type | Filing margin (DIN 824

1 I

7 I

5

Close

Note: If you want to place a layout border of any size on the

page, use the ==l Layout Border tool (Tools palette, Create area).
Here, you can define custom border sizes using the input options.

8 C(lick the Title block box in the Properties area and select the

Label option.

Properties

Title block Label

Offset to the right
Offset to the bottom

Background Mone

& &

5.0 mm

5.0 mm

Layout border Filing margin (DIN 824 A) ®|

1 Unfinished structure ®|

Close
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Tip: To change the annotation
for the layout, switch to the
Text module and use the
standard text editing tools.

9 In the Office folder, select the Reinforcement drawing label style
and click OK to confirm.

Select Label Style

Falder

Default I I
Office 1
Private IE‘ ===
Project Slevstor at - reifer cema oraw g
External path =T
=T
=T
=T Eisanle Eng -'Ml!
5 sate s
Subfolder Label Style
8 Title blocks 1 Reinforcement drawing
| OK | Cancel

Taking the offsets specified into account, Allplan automatically
places the title block in the bottom right corner.

Instead of attributes, you can now see the values you have

assigned.
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10 Enter 0.00 for both the Offset to the right and the Offset to the
bottom and click Close to quit the Set Up Page tool.

ndex | Changed Date | Name

Draw ing

Elevator shaft - reinforcement drawing

Projeat
Mew detached house
Plan City
et Edward Example o 20k
Example Road, Example Town b
ArchRect Sam Sample S;?HD:EJ oy
Sample Way, Anytown v
Engineer H Plan number
Stable Engineers XXX
Stable Street, Stable Town

Layout elements are mainly drawing files that you place in the
layout. Drawing files can be positioned individually or as a fileset.
You can specify which layers are to be included in the printout by
selecting a print set.

To select layout elements

1 Click = Layout Element (Tools palette, Create area).

Layout Element ®
B B o Scale 1 1 Fortfactor|  Layou Layer/plot set Al
= 1 Rotation angle 0.000 Text direction O Drawing type Scale definition

X

&
&

2 On the Layout Element Context toolbar, click E Fileset and
select fileset 2, Elevator shaft.
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The drawing file selection is the same as in document edit mode:
drawing files 202 and 203 are switched off.

It is enough if you place the associative views and the
reinforcement model in the layout. Select drawing files 204 and
205 and click OK to confirm the dialog box.

Select Drawing Files ®

Mo. Drawing file name

UL 101 3D floor plan

ULZUI General arrangement - 3D Modeling module

ULZUZ Concrete component

UL 203 General arrangement - Walls, Openings, Components module
£4204  Assodative views

£ 4205 Bar reinforcement with 30 model

Click the Layer/print set box. You can use layers to define
visibility settings for the layout elements:

o The Print set, current setting of the selected print set option
only displays elements on layers of the print set currently
selected.

e When set to Current, always use current layer setting, the

visibility settings you defined using = Select, Set Layers on
the Format menu apply.

o When set to Fixed, save layer setting in layout element, you
can define the visibility setting for each layer individually.
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Element Visibility from Layers in Layout ®
= |L)E
Status Short name Full nz Drawing type: Scale definition =
¥ ARCHITECTURE
v  Achiecture Visibility, saving mode, behavior

AR_GEN Archite Set all to visible, ignore layers in layout element

AR_WALL Wall ) ) ) )
Print set, cument setting of selected print set (dynamic)

*  Shel Current, ahways use current layer setting {dynamic)

SH_GEN Shell.g o )
SH_SHL Shell (®) Fixed, save layer setting in layout element fixed)

¥ Barreinforcement

Bar reir Conterts of list box

(®) List layers in layout element
List entire layer hierarchy

| Show visble layers

+| Show hidden layers

Status

[ visble
[ ]| Hidden

cara

5 Select the Reinforcement drawing drawing type and place the
selected drawing files in the layout.

The next drawing file is now automatically displayed attached to
the crosshairs.

6 Press ESC to finish selecting layout elements.

The finished layouts are saved and can be printed now or later.
When documents have been changed, you need to update the layout
using

e Update Layout (Tools palette, Change area).
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Task 2: printing layouts

The finished layout can now be printed. Before you continue, please
check that the printer has been correctly installed and configured.

To print a layout
1 Click I Print Layouts (Tools palette, Create area).

All the menus and toolbars disappear. The Print Layouts palette
opens and you can see the Printer tab. The representation of the
layout matches that in the printout.

In the Selection area, layout 1 is selected.

Click the Set button to select the elements you want to print. You
can restrict the printout to specific element types only.
Furthermore, you can place the surface elements of each
document in the background.

Leave the settings as they are.

2 Choose the output device (printer/large format printer) and the
paper size (for example, ISO B2) in the Settings area. So that the
layout is printed in its entirety, the printable area (printable area
minus device margins) must be larger than the page.

Note: If you have configured output channels in the Services
application, you can select them using the Allplan vector drivers
option.



274 Exercise 9: assembling and printing layouts Allplan 2014

Print layouts 1 x

Print layouts
Printer || Print profile
Selection

Layout 1

Elements to print Set

Settings

Printer @| \printcenter\oce-2og-entw |~
Allplan raster driver HP-RTL Designjet Lo 2oy | =
Farmat @| | soB2 -

707 % 500 mm
MNumber of copies 1 =
Orientation ‘ |
Print Cancel Close

3 Depending on the selected output device, you can use Allplan
raster drivers. These printer drivers are especially suitable for
printing large-format layouts. Raster drivers speed up the
printing process, improve the quality of printouts and are very
reliable.

If you want to use raster drivers, select the Allplan raster driver
option and open the list box to select a raster driver that can be
used in conjunction with the selected printer.

Note: You can define the properties of the Allplan raster driver

by clicking & Properties beside the selected printer.

Note: The first time you select an output device that can be used
in conjunction with Allplan raster drivers, the following prompt
will appear:

Allplan ®

& The cument printer is probably not part of the device
! families supported. Please check whether you can still
use this raster driver

Would you still like to use the raster driver?

Do not show this message in future

S
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Tip: You can define specific
settings for printing in the
More settings and Output
mode areas and on the Print
profile tab. For more
information please consult
the Allplan help.

If you want to use Allplan raster drivers, click Yes. You have
selected the Allplan raster driver option and chosen an

appropriate raster driver.

4 Do not change the number of copies - 1 - and set the orientation

to Landscape.

Here, too, you can set up the page by clicking the Set button.
Click ¥5 to match the device margins of the selected printer

Crientation

Set up page

Mare settings
Special Settings
Printout of highest quality
Cutput mode

Archiving

Print to file

|L2]]
| Landscape
Set =
Set
Print Cancel Close

To save the settings and print the layout later, click Close.

Click Print to start printing.
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Task 3: layout windows

Tip: Using the polyline entry
tools, you can also define
freeform layout windows or
create layout windows
composed of several
individual polygons.

You can use layout windows to position just portions of drawings in
your layout. This is useful if you want to display just specific areas
or elements that are far from each other in the fileset. In the
following exercise you will create layout windows and display
sections of individual drawing files.

To create layout windows

1

Open an empty layout using Open on a Project-Specific
Basis and specify the format, orientation and margins of the page

using @ Set Up Page.
Click =N Layout Window (Tools palette, Create area).

You will create the window so that you can immediately select
the drawing file you want to display.

Click .. place drawing files as layout elements.

Layout Window @

... place drawing files as layout elements

... and place NDW as layout elements
... of layout elements already placed
.. without layout elements

QK Cancel

Select =1 drawing file 102 and place it in the layout. The
drawing type is set to Reinforcement drawing.

Select =1 drawing file 401 and click within the boundary of the
drawing file already placed.

Press ESC as you do not want to select more drawing files for this
layout window.

Define the size of the layout window by entering two diagonally
opposite points (bottom left and top right points) with the left
mouse button (see below). Then press ESC twice.

Note: Check that & Area detection is not selected in the input
options. Otherwise, the border or boundary of the layout element
placed defines the size of the layout window.
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8 Repeat steps 2 through 7 to create a layout window for drawing
file 204 or 303.

9 Click i Modify Layout Window (Tools palette, Change area)

and select Enter new polygon for layout window to change the
size of the window.

Modify Layout Window [

Add layout elements

Add NDW layout elements

Move layout window elements

Enter new polygon for layout window
List, edit layout window elements

Explode layout window

QK Cancel

10 To change the arrangement of the layout windows, you can use
=l Move (Edit toolbar).
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The result might look like this:

Typical section
herizontal corner reinforcement
placed 4 times

@H g12-10

| E—

425@ @11:\12-1-}

@2212 @22'2

I OF ¥
| (s ‘G'I)”‘s" (2ate

| [ rw =297 /210 (0.06m7) Allpian 2014




Engineering Tutorial Appendix 279

Appendix

If you want to create the project yourself, you can find
useful information and step-by-step instructions on the
following topics:

= Project organization - managing data using
ProjectPilot

= Using layers

= (reating a project
= (Creating filesets

= Defining print sets

The appendix also provides general information on the
palette configuration and on drawing files.

Note: If you want to skip the general sections and start
creating the project at once, continue at Creating the
training project (on page 296).

Note: You can also download the project from the
Internet. See the section entitled Training projects on the
Internet (on page 316).
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Project organization

Project structure, i.e. the way in which you organize your data, is an
essential part of any building design project. An efficient and logical
structure will allow you to locate the data you need without having
to perform tedious searches.

It is worth spending time carefully planning a project’s structure
before even drawing the first line. Consider the time and effort spent
doing this as a good investment - after all, in the long term, it will
save you time and money.

Allplan’s flexible approach allows users to create their own office-
specific structures which, in turn, can be altered to suit the needs of
special projects.
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Managing Data with ProjectPilot

What is ProjectPilot?

You use ProjectPilot to create and structure projects in a simple and
clear manner.

ProjectPilot is a powerful data management tool developed specially
for the data structure of Allplan. ProjectPilot provides tools for
copying, moving, renaming and deleting data (e.g., projects, drawing
files, symbols, etc.).

If you are already familiar with Windows Explorer, then you’ll find
that working with ProjectPilot is just as easy. Most steps can be
accomplished via the shortcut menu and you can move or copy files
by dragging and dropping them.

User interface

3 Projectpilot
Eile  View Help

& %

Tree structure

-Gl <

Office

Projects and Folders

=-E3 Aliplan provider
= @Eijects}

=-@J Architecture Tutorial
=8 Drawing files
E Filesets
[d Layouts
A Text
@ Template project (without the model]
“4 External path

4 Private
@ Default

Contents of "Projects”

A Project name B Owner Created on
@ < > sysadm
@Fﬂ:hrtecture Tutorial sysadm 9/30/2013 1:34:34
= @Template project (without the model) sysadm 9/30/20131:12:39 ..

Press F1 to get Help.
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Left window (A)

The left window shows the projects and folders in a tree structure.
The current project is selected and open. Click the plus sign (+) to
display the levels in a folder. Click the name of a folder to display its
contents in the right window.

You can display the contents of the folder and open it at the same
time by double-clicking.

Right window (B)

The right window shows the folders and documents in the selected
node (in the left window). You can sort the displayed documents by
clicking on the title of a column. Clicking in the background with
the right mouse button lets you display the documents as a list or as
icons.

Preview (C)

A preview of the currently selected document (drawing file, layout) is
displayed in the preview area. To move the preview, click it with the
middle mouse button and drag. To zoom in on an area in the
preview, open a selection rectangle using the left mouse button.
Double-clicking with the middle mouse button restores the preview
to its original size. Alternatively, press the * key on the number pad.

To display in an isometric view: use the number keys on the number
pad. Check that the Num Lock key is active as you do so.
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Common approaches in ProjectPilot

If you are already familiar with Windows Explorer, you will quickly
find your way around the ProjectPilot. Most steps can be
accomplished via the shortcut menu or by dragging and dropping.

Sorting the displayed documents

You can sort the displayed documents by clicking on the title of a
column. The first time you click the column title, the documents are
sorted in ascending order. Clicking the same column title again sorts
the documents in descending order. An arrow is displayed to indicate
which column is being sorted and whether sorting is in ascending or
descending order.

Mame Mumber Size  Type Name Mu.. Size  Type
=51 Basement model 120 294306 Draft [=3 Section A fresult of hidden line image) 1010 58334 Draft
[ Basement siab 12% 58334 Draft =N West elevation fresult of hidden line image) 1000 58334 Draft
EBChimney 3 58334 Draft [=1 Basement slab 129 58334 Draft
=B Clipping path 2 58334 Draft [=1 Basement model 120 294506 Draft
R Grid 1 58334 Draft =1 Upstand - altemative 17 360430 Draft
BB Ground floor camport 101 58334 Draft =11 Upstand 116 58334 Draft
BB Ground floor camport - atemative 108 58334 Draft [=% Masking plane 115 58334 Draft
BN Ground floor mode! 100 815098 Draft &= Roof 12 58334  Draft
E3Ground flocr slab 109 98334 Draft [0 Top floor model 110 425954 Draft
Sorted in ascending order (arrow points Sorted in descending order (arrow points

upwards) and according to drawing name downwards) and according to drawing name
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= gl irchitecture Tutorial
Structure...

+ é Office
+ am Private  Expand Folder

+-f¢ Defaul

MNew Folder
Find

Delete
Rename

Help

Properties

Copy Project to...

Copying and moving with drag and drop

Instead of using the shortcut menu, you can also drag & drop
selected documents in order to move or copy them. Select the
documents, click within the selection with the left mouse button,
keep the mouse button pressed down and then drag. You can tell
whether this is possible by the shape of the cursor when the mouse
pointer is positioned over the destination area.

Cursor Meaning
The document will be copied to the folder that is below the

mouse pointer.

% The document will be moved to the folder that is below
the mouse pointer.

Note: To move documents, hold down the SHIFT key while
dragging the documents.

% A shortcut to the document will be created in the folder
below the mouse pointer (e.g., when assigning drawing
files to a fileset).

@ The document cannot be placed here.

Working with the shortcut menu

Almost all tools available in ProjectPilot can be accessed via the
shortcut menu. Depending on which element you click, a shortcut
menu appropriate to the element opens.

=g Architecture Tutorial
=3 Drawing files
Fiicsets
= LL\\) MNew Falder 3

+AT

+-% External Eind

3 + é Office
+| - gm Private
- Default

Help

Properties

Shortcut menu of a project Shortcut menu of the fileset folder
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Using the preview

A preview of the selected document is displayed in the preview area.
In this view, you can zoom, pan and select isometric views. Click
Preview on the View menu to specify whether and where the
preview is placed.

To switch the preview off: point to Preview on the View menu
and click None.

To zoom: use the left mouse button to open a selection rectangle
around the area you want to view in detail. The cursor changes to
crosshairs.

To pan in the preview: move the view with the middle mouse
button. The cursor changes to a hand. Alternatively, use the
cursor keys.

To restore the full view of the image in the preview: double-
click in the preview are with the middle mouse button, or press
the * key on the number pad.

To display in an isometric view: use the number keys on the
number pad. Check that the Num Lock key and the preview are
active as you do so.

Note: The preview is only available with certain documents (drawing
files, layouts).
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Understanding drawing files

In Allplan, the actual design and data creation process happens in
drawing files. These are the equivalent of the transparencies used in
conventional building design. Drawing files can be used to give
projects a structure. In IT terms, a drawing file is a conventional file
stored on your hard disk. You can display and edit up to 80 drawing
files at once - in other words, you can have several files open
simultaneously. A project can contain up to 9999 drawing files.
When working without layers, the individual building elements (such
as walls, stairs, labeling, etc.) are drawn on different drawing files
and superimposed like transparencies.

9999

In order to edit the drawing files, they have to be activated (opened).
You can do this using the Open on a project-specific basis: drawing
files from fileset/building structure dialog box.
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Tip: You can also use the
shortcut menu to change the
drawing file status. Click an
element in the workspace

Drawing file status

With the drawing file status, you define the drawing file on which
you draw and which drawing files are visible and/or can be
modified.

The following illustration shows the different drawing file statuses.
An explanation is provided in the table below.

> 3

with the rigé;t mouse button | ;

and select lis Change 3

drawing file status on the 4

shortcut menu. 5

5

Number Drawing file status Remark

1 Active The active drawing file is the one on which you draw. There must
always be one active drawing file.

2 Open in edit mode Elements in drawing files open in edit mode are visible and can
be modified. Up to 80 drawing files can be open simultaneously
(regardless of whether they are current, in edit and/or reference
mode).

3 Open in reference mode Elements in drawing files open in reference mode are visible, but
cannot be modified. You can configure the program to use the
same color for all elements in reference drawing files. To do this,
select the % Options, click Desktop environment and open the
Display page. Empty drawing files cannot be opened in reference
mode.

4 Inactive Elements on inactive drawing files are not visible.

5 Empty Empty drawing files have no data type icon.

6 Assigned temporarily The drawing file is assigned temporarily to the fileset; this

assignment is removed when you switch to a different fileset.
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Information on the active drawing file

To get information on the active document, click in the workspace
with the right mouse button and on the shortcut menu, choose
Properties. An information box with all the important information

about the file opens.

Properties @
Memory allocation: [%5] 0.10
Document: DF2032 - General arrangement -
Document type: Draft
Max, size [MByte]: 181
Min. values [m]:
x= -9.08146 y= -030760 z= -4.49000
Max. values [m]:
x= 463521 y= 536969 z= 800000
| Close

Information

Meaning

Memory allocation

Document

Document type

Max. size

Min./Max. values

This shows how much of the memory reserved for a
file has already been allocated (as a percentage).
Background information: a certain amount of
memory is reserved for files.

The number of the current file is displayed here. The
number is also displayed in the title bar of the
Allplan application window.

The file type is displayed here. This corresponds to
the data type icon that is displayed in the status bar.

The maximum amount of memory available for the
file is displayed in Kbytes.

The minimum and maximum coordinates in the file
are displayed here.
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Using layers

Understanding layers

Layers provide an additional means of structuring design entities
within drawing files. You can display exactly the information you
need just by switching the relevant layers on and off. This way, you
can see better what you are doing and proceed quickly.

You can use layers to define the format properties of elements.

Layers are important organizational elements. Their importance
increases the more people are involved in a project and the more a
CAD system is used for the specialist design processes. Layers do not
replace drawing files. Rather, they complement them.

Defining the current layer

When created, each element is given the current layer. The layer
which is used as the current layer is governed by the following
settings:

e When you activate a tool (e.g. line) for the first time, a specific
layer is automatically selected as the current layer (if the Auto-
select layer with tool option is selected in the Layer dialog box).
The layer in question depends on which tool you activate. If the
Auto-select layer with tool option is not selected, the program
automatically uses the layer you selected last.

e The Layers palette shows the current layer. Now you can change
the layer status with just one click.
You can display the entire layer hierarchy, the layers assigned to
the currently selected tool or the layers used in open documents.
To do this, you can use the extensive shortcut menu of the
Layers palette.

e You can use % Select, Set Layers or the Format toolbar to
define a different layer as the current one. This layer will then
automatically be used as the current layer the next time you
activate the tool.

¢ When you save components as styles or favorite files, the layer
currently set is also saved. When you retrieve these components
later, the layer saved is automatically set as the current layer.
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e Normally, openings like recesses in walls and slabs or window
and door openings get the same layer as the element into which

they are inserted. Click the Special button in the X Options -
Components and architecture - Miscellaneous area to specify
whether these openings can be assigned separate, independent
layers.

e As walls can consist of multiple construction layers and each
layer can have different format properties, you can define the
layer for each of the construction layers in a wall or upstand
directly in the Properties dialog box (you usually make these
settings on the Format toolbar).

Setting the format properties of layers

Every layer has pen, line and color properties. In the Layer dialog
box, you can specify that an element is to automatically assume the
properties of the layer on which it is drawn.

The format properties of a layer can also be defined as a line style
and saved under a name of your choice. Elements can then assume
the format properties of this layer.

Layers' format properties (project setting)

= Pen From layer, line style
= Line From layer, line style
\.- Color From layer, line style

When defining line styles, you can specify how they change with
the scale or drawing type. You can define different line styles for
various scale ranges and/or drawing types so that the elements are
displayed and printed differently, depending on the reference scale
or drawing type set. Using line styles, you can work on a scale-
independent basis.

Drawing types define how elements are displayed on screen and in
the printout. The display of the elements varies depending on the
selected drawing type. Requirements: the format properties are taken
from the layer (in a fixed manner) and the use of line styles is
selected.
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Layer access rights

There are different layer access rights. On the one hand, there is the
visibility setting which controls whether a layer is visible or hidden.
On the other hand, there is the edit setting which controls whether a
layer can be edited or not (i.e. it is frozen). You can save visibility
settings in print sets (see "Using print sets” on page 295) and edit
settings in privilege sets. The status of a layer is represented by
icons in the Layer dialog box (Select Layer/Visibility tab) and in the
Layers palette:

Icon Access right Explanation
E Current The layer on which you draw.
|:| Modifiable Elements in this layer are visible and can

be modified.

m Visible, frozen Elements in this layer are visible but
cannot be modified.

|_| Hidden, frozen Elements in this layer are not visible and
cannot be modified.

You can restrict access to layers using the Select Layer/Visibility tab
or the Layers palette. For example, you can change the status of
layers from Modifiable to Visible, frozen.

Layer access rights also depend on the privilege set to which a user
belongs. Therefore, you cannot assign a higher status to layers (for
example, set hidden layers to modifiable) when you belong to a
privilege set that is not granted full access rights to the relevant
layers.
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Setting layer visibility in drawing files

You can set layers so that they are visible or invisible and thus
show/hide the corresponding elements.

This way, you can quickly hide the elements you don’t need during
the current design phase, selectively modify elements in the
displayed layers, check your plan and see whether all the elements
are assigned to the desired layer. For example, you might choose to
hide the slab layer and then view the spatial arrangement of the
building as a hidden line image in perspective view.

Note: Click an element with the right mouse button and, on the
shortcut menu, select Modify Layer Status and then Isolate layer -
set all other layers to hidden to hide all the layers with the
exception of the layer on which the element clicked is located.

If you find that you often require the same combination of visible
and hidden layers (for dimensioning or labeling at certain scales, for
example), then it is best to define what is known as a print set. You
can also use print sets when assembling your layout later on so that
only the visible layers print.

Note: You can choose to Display elements on frozen layers using a
fixed color by selecting this option in the Layer dialog box.



Engineering Tutorial

Appendix 293

Managing layers and layer structures

The management of layers and layer structures is generally the
responsibility of the system administrator. This person defines which
layers are used, sets up the privilege sets and grants access rights.
The designers (architects, engineers, etc.) are assigned to the privilege
sets and thus automatically have the relevant permissions.

When you create a project, you can decide whether you want to use
the layer structure of the office standard or a project-specific layer
structure.

You can name and save layer structures and retrieve these structures
later. If you have assigned line styles to layers, they are saved
together with the layer structure (with the same file name plus the
extension .Sty). When importing a layer structure you saved, you
can decide whether to import the associated line style file, too.

Advantages of data organization using layers

With large projects in particular, organizing data using layers has
significant advantages:

e Associative elements - such as wall dimensions or sill elevation
labels - reside in the same drawing file and yet can still be hidden
from view.

e In order for the interaction between elements to function cleanly,
the components in question have to reside in the same drawing
file. This is also the case for certain analysis and evaluation
operations. With layers, you can meet these requirements easily.

o Easier to assemble layouts thanks to print sets. Print sets are
user-defined compilations of layers. These can also be used when
editing and assembling layouts. When assembling a layout, you
can choose to display only the elements in a specific print set -
switching between 1:50 and 1:100 is thus no problem.

e Exporting drawing files to DXF/DWG layers is easier as you can
assign each layer in a drawing file to a different DXF/DWG layer.
When importing DXF/DWG files, the DXF/DWG layer structure
can be automatically integrated in the layer hierarchy.

e The layer of an element can often be modified more quickly than
the element’s assignment to a drawing file.
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e You can quickly create layers that are not included in your layer
structure and then use these layers in all the drawing files of a
project.

e As a project can contain more layers (approximately 65,000) than
drawing files (9,999), layers allow you to distinguish more
precisely between the individual design entities.

® You can make up to 65,000 layers visible and modifiable at once
(while you can only display and edit up to 80 drawing files at the
same time).

e Layers can be shown and hidden very quickly (using print sets or
favorites).

¢ You can change the format properties of a layer later. All the
elements of this layer that were drawn using the From layer, line
style setting will adapt automatically.This way, you do not need
to modify them separately.

e You can copy format properties including layers by double-
clicking with the right mouse button. This method also works

with wizards. Similarly, you can use & Copy Format (How) to
quickly copy the format properties of an element and apply them
to other elements.

Relationship between layers and drawing files

The use of layers doesn’t mean that drawing files don’t play a role
when it comes to organizing your data. With large project in
particular, a combination of both is essential. With the same
structural depth, the number of drawing files required is far less
when working with layers.

The number of drawing files you need not only depends on the size
of the project, but also on your hardware. Modern, fast computers
with a lot of memory can handle a lot more data per drawing file
without this leading to a noticeable downturn in performance.
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The interplay between layers and drawing files depends on the
following factors:

e The size of the project and the number of designers involved at
any one time.
If several designers are working on one floor, create one drawing
file per area of responsibility (e.g., East Wing, Central Unit, West
Wing, for example.)

e Simultaneous involvement of specialist designers on the project.
Separate drawing files should always be used for the specialist
designs in order to facilitate concurrent activity.

Using privilege sets

Access to layers can be controlled by means of privilege sets.
Privilege sets are generally assigned when there are several people
working on the same project: when working with Workgroup
Manager, you can assign individual users to one or more privilege
sets. As a result, these users can only see and/or edit the layers that
are associated with the relevant privilege set.

Privilege sets not only control who accesses which layers. By
defining privilege sets with a selection of layers that are to be
available while drawing, the entire design process can be facilitated.

When you install the program, the privilege set ALLPLAN is created
automatically. This privilege set has read and write access for all
layers.

Using print sets

A print set is a set of layers that you can select when compiling and
arranging layouts. You can also use print sets to control which
layers are visible/hidden. Only the elements in the selected print set
are displayed in the layout.

For example, you can select a print set for working drawings so that
only the data that is relevant to a working drawing appears in the
final printout.
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Creating the Training Project

Start by creating a project.

To create the project
1 Click @ ProjectPilot on the File menu.
ProjectPilot opens.

2 In ProjectPilot, click New Project... on the File menu.

Mew Project - Spe:ify__Pr%jed Name x

Project name:

Engineering Tutorial

Lbets ] [ cancel | [ tep |

3 Enter Engineering Tutorial for the project name and click
Next >.



Engineering Tutorial

Appendix

297

MNew Project - Additional Settings

Path settings

Pen and line definitions:

Fonts: Office ‘ -
Patterns, hatching styles, area styles: Office \ -
Bar and mesh cross-section catalogs: Office

Layer structures, line styles, drawing type.
Attributes proposed: Office

Urban planning symbals: Drawing symbol regulations ‘ -

CAD-TAI project assignment: CAD-TAI research... "OFF=

Offset coordinates
[Cloffset (m) x: ¥ 7

Project angle for rotated plan view: 0.0000

M ;J@”‘ﬂ sk,

New Project - Additional Settings

roject onganization architecture

roject organization engineering

ice Building 15 Floors with Building Structure
etached Houss with Buiding Structurs
esidential and Office Building with Building Str.
Femplate Detached House with Building Structurs

<Back | th%ﬂ Cancel | [ Heb

4 Check that the path settings for Pen and line definitions and

Layer structures, line styles, drawing types are set to Project

and click Next > to confirm.

5 C(lear the Template - Detached house with building structure

check box and click Finish to confirm the last dialog box.

6 Close ProjectPilot by clicking Exit on the File menu.

You are back in Allplan; the Engineering Tutorial project is

open.

Note: You can also use the 82 New Project, Open Project tool

(Default toolbar) to create new projects.
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Path settings
This defines which pen, line, hatching settings, fonts and material
catalogs are used. In practice, the office standard is generally used.

Office: choose this option if you want different projects within the

same office to use the same settings (for hatching, line types etc.). If
you are working on a network, the office standard is the same on all
computers and can only be changed by users with special privileges.

Project: choose this option if you want the settings, for instance for
patterns and/or hatching styles, to apply to this project only (in
which case they will probably be different to those used as the office
standard).

Setting the scale and unit of length

Tip: Alternatively, you can set
the scale in the status bar:
click to the right of scale and
select 1:100.

Define scale and length settings for the project.
Start by setting the reference scale to 1:100.

To set the reference scale

[
1 On the View menu, click =2 Reference Scale.

Scale @
+[A1X

1.00
5.00
10.00
20,00
25,00
50.00

200,00
500,00
1000.00
2000.00
5000.00
10000.00
25000,00

QK Cancel

2 Click 100.00 in the Scale dialog box.
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Set the unit you want to use to enter values. The values are to be
interpreted in meters.

To set units

1 Click xK Options (Standard toolbar) and select Desktop
environment in the dialog box.

2 Set the Unit of length to m.

Options @
Desktop environment &£ General
Language | English -
nd crosshairs
Selection Unit of length | 'm [ ‘ "
Direct object medification Precision for entries in inches/feet
Paoint snap .
Track tracing Unitofangle | deg =
Animation Inclination as | Angle =
Pen colors Minimum distance between points | 0.010 mm
Import and export
Catalogs Display element properties in palette H Even with left double-click
Smart symbaols and symbols Display sequence [ Sequence defaults
Planes
- e " " Working with large coordinates Optimize
Compaonents and architecture
Rooms Save
Reinforcement Backup copies of drawing files Create
Representation
Format Drawing files and layouts H Save automatically
Label 15 min
. ! Folders for saving Path settings
Label
Views and sections
Terrain
Text
Dimension line
Key
Reports and quantity calculations
Layouts
OK Cancel
Tip: Alternatively, set the unit 3 Click OK to confirm the settings.

of measurement in the status
bar: click to the right of
Length and select m.
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Drawing file structure

Allplan provides two options for structuring drawing files in a
project:

e the E',' fileset structure and

e the g building structure.

You can define these two structures, which you can use in parallel
manner, in the Open on a project-specific basis: drawing files from
fileset/building structure dialog box.

The building structure is particularly useful for applying a logical
structure to a building. In architecture, the advantage of working
with the building structure is that views, sections and building lists
can be generated quickly and easily.

An important difference between the building structure and the
fileset structure is that each drawing file can only be assigned once
in the building structure. However, when it comes to designing
reinforcement, drawing files are multiply used for different
reinforcement drawings. Therefore, we recommend that you work
with filesets.

In this mode, all you need to do is select the relevant fileset and all
associated drawing files are available immediately. To do this in the
building structure, select the relevant drawing files assigned to the
individual structural levels and use the shortcut menu of the project
to save the different status settings as a favorite, which you can
retrieve later.

When working with the building structure, you cannot place
detailing windows in filesets or assemble layouts using filesets.

As the focus of the exercises in this tutorial is to teach you how to
create reinforcement, you will use the fileset structure.

Please refer to the Architecture Tutorial for information on creating a
building structure, which you can also use here. Look in Allplan’s
help for detailed information on the building structure.
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Tip: To display a section of

the drawing at a larger scale,
open a detailing window in a

drawing file or fileset.

Creating filesets

For the exercises in this tutorial, you will create your own project
structure. It is advisable to work with stories and print sets in a real
project. For more information see Tips on project organization (on
page 304).

To create a fileset

1 Select Open on a Project-Specific Basis.

The Fileset structure tab is displayed.

Close the drawing file tree for fileset 0 by clicking the triangle
symbol to the left of <No fileset> in the Open on a project-
specific basis: drawing files from fileset/building structure
dialog box

Or

click = Collapse all entries at top left.

Click Iﬁ‘ Create fileset, enter the fileset name Basement and click
OK to confirm.

Create the filesets Elevator shaft, Standard door lintel, Slab
reinforcement and BAMTEC in the same way.

COpen on a project-specific basis: drawing files from fileset/building structure - B8 x
=l (L 2) @@ (a)kas @ &)
Fileset structurs || Building structure

Fileset number Fileset name No. Drawing file name T No. Drawing file ...

@ Engineering Tutorial

» B 0 =no fiesets

» B 1 Basement

» B 2 FElevator shaft

» B 3 Standard door lintel

» B 4 Slab reinforcement

y B3 5 BAMTEC

D2 o W e - @ oo R

Active fileset: BAMTEC 1 drawing file(s) selected
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Tip: You select the drawing

files as in Windows® Explorer:

Press the CTRL key to select a
series of non-adjacent
drawing files

(e.g., 10, 16 and 28).

Press the SHIFT key to select
a range of adjacent drawing

files (e.g. 10 - 20).

Or open a selection rectangle
around selected drawing files
with the mouse.

5 Click drawing file 101, press and hold down the SHIFT key and
click drawing file 110.

This selects drawing files 101 to 110.

Open on a project-specific basis: drawing files from fileset/building structure - 8 X

%)= 8% & B &% B 88 E & & |

Fileset structure || Building structure

Fileset number Fileset name No. Drawing file name T No Drawing file

g8 Engineering Tutorial 100

(=] 0 <no fiesst- 1m
- 102
103

\ 104

b B3 2 Elevatorshaft

» B 3 Standard door Iintel
» B 4 Slab reinforcement
[ =] 5 BAMTEC

Active fileset: Basement 0 drawing file(s) selected

6 Click within the selection, keep the mouse button pressed down
and drag the drawing files to the fileset Basement. Then release
the mouse button again.

The drawing file tree for the fileset opens. The drawing files are
thus assigned to the fileset.

If you have selected a drawing file too many, you can drag it out
of the list in the same way.

Note: Instead of using drag-and-drop operations, you can also
select the fileset and the drawing files and then click Assign to
current fileset on the shortcut menu.

file name Type No. Drawing file ...

Assign to current fileset L\}
Assign temporarily to current fileset

Select all drawing files
Clear selection

Delete drawing file contents
Rename

Properties



Engineering Tutorial

Appendix

303

Notes:
Use the floor plans of the
basement you created in

exercise 1 for filesets 2 and 4.

You do not need to copy the
basement or create it again.
Just assign drawing files 101
and 102 to filesets 2 and 4,
respectively.

Assign the empty drawing

files 503 and 504 to fileset 5.

You will place the separated
carpet outline in these
drawing files later.

7 Assign drawing files to the other filesets as shown below.

Drawing Drawing Drawing file name
file number
1 101 3D floor plan
102 2D floor plan
103 2D stair
104 Dimensions and labels
105 Hidden line image
110 Key plan
2 101 3D floor plan
201 General arrangement - 3D modeling
module
202 Concrete component
203 General arrangement - walls, openings,
components module
204 Associative views
205 Reinforcement drawing with 3D model
3 301 General arrangement in 2D
302 Reinforcement drawing with 3D model
303 Modified door lintel
4 102 2D floor plan
401 Reinforcement, bottom layer - without
3D model
402 Reinforcement, top layer - without 3D
model
5 501 Structure
502 Carpet outline
503
504

8 Name the drawing files as shown.
Labeling drawing files is covered in the Basics Tutorial.

9 Select a drawing file and click Close.




304 Creating the Training Project Allplan 2014

Tips on project organization

Allplan is a very flexible system that allows you to develop your
own custom solutions for projects and entire offices. The structure
presented here for large-scale projects is intended only as a guide.
You can use the entire structure or just parts of it.

You will probably find this structure useful when you start. As you
progress, you will be in a better position to judge what needs
changing/adding to suit your own needs and requirements. We
would like to emphasize once again that a carefully thought out
project structure will save time for everybody in the long run. The
system has the following structure:

e General project-related information is stored on drawing files 1-
99. This is universally required data (plan layout, axis system
etc.).

e Floor design starts at drawing file 100, starting with the
excavation. Create the design for the key plan in drawing files
300 and higher.

e Use the drawing files starting at number 1000 for general
arrangement drawings and the associated sections. The first digit
indicates the number of the story. The last two digits provide
information on the contents. The sequence in which the drawing
files are named should be identical on each floor.

e Use drawing files 2000 and higher for reinforcement drawings.
Drawing files 2000-2009 can be used for editing and modifying
components. Create precast elements and special components in
the subsequent drawing files.

This example largely reflects the predefined Engineering project
organization, which you can select in the last dialog box when you
create a new project.
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Defining print sets

A print set (see "Using print sets” on page 295) is a saved
combination of visible and hidden layers.

Both when setting up your layouts and when turning layers on and
off, activating a print set is a rapid way of showing/hiding only
those layers that are required for a specific print set. First create and
name the print sets. Then assign layers to these print sets.

To define print sets
1 Click = Select, Set Layers (Format menu).

2 Select the Print Set tab and click Define, modify print set....

Define, modify print set...

Print Set Manager *®

New print set k—] [ OK J Cancel

3 In the Print Set Manager dialog box, click New print set....

4 Enter Key plan for the name of the first print set and click OK to
confirm.
You do not need to define a group.

MNew print set *»

Name: Key plan

Group: T

5 If you are working with Workgroup Manager, assign the user
local to the print set.
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6 Repeat steps 3 to 4 (5) and create more print sets:
- General arrangement drawing
- Reinforcement, bottom layer

- Reinforcement, top layer

7 C(lick OK to confirm the print set manager

Now you need to define which layers are to be visible and which
hidden in each print set.

To define visible and hidden layers for the print sets

o The Layer dialog box is still open. The first print set - Key plan -
is displayed.

1 Click = at top left to collapse the tree structure.

2 As only a few layers are to be visible, start by setting all layers to

Hidden. Select all layer structures, click the selection with the
right mouse button and, on the shortcut menu, choose Hidden.

Layer
Select Layer/\Visibility || Print Set || Privilege Set | | Format Definition | [ Layer Structures
&=L |E Pririt set in list box:

Visibility in prirt set | Short name = Key plan =
» i ARCHITECTURE

ENGINEERING Uisible nodify print set

BUILDING USING | Hidden

PRECASTELEMEN  coject a1l (Ctri-4)

HALLS Cancel selection (Shift=Cirl=A]
STEEL CONSTRUC

TIMBER CONSTRL  Match visibility from print set..,
CAD AUTHORITY BAVARIA

ALLPLAN INTERNAL

rFvvwvwvrwvwrw

3 Expand the Draft, Dimension line and Key plan areas by clicking
the respective triangle symbols. Press the CTRL key and select the
layers which are to be visible in the Key plan print set (see table).

4 Click the selection with the right mouse button and click Visible
on the shortcut menu.
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Make sure that you select individual layers (and not layer

structures or even the entire layer hierarchy!).

Layer

[Select Layer/\isibility || Print Set | Priviege Set | | Fomat Defintion | [Layer Structures |

| Visibiltty in print set | Short name: | Full name
¥ ARCHITECTURE

*  Desig
] DE_GEND1 General 01
O DE GEND2 Genersl0?
| DE_GEND3 General (3
| DE_GEND4 General 04
| DE_GENDS General05
O DE_O_PE Qutdoor facilties. persons
| DE_COMMENT  Comments

»  Surface elements

b Text

¥ Dimension line
O i DL_GEN Dimension line, general
O DL_10 Dimension line 1:10
O DL_20 Dimension line 1:20
| DL_50 Dimension line 1:50
= DL_100 Timension line 1-100
O DL_200 Visible
O DL_500 Hidden |/\\3
O DL_1000

»  Landscaping. utban planning Selectallictizi)

b Architecture LCancel selection [Shift+Ctrl+A}

b Rafter design Match visibility from print set...

»  Room

¥  ENGINEERING

b Shell

»  Reinforcement drawing

¥ Barreinforcement

¥ Mesh reinforcement

»  BAMTEC

¥  Keyplan
= KP_GEN Key plan, general

K KEY Key pian
¥ BUILDING USING EXISTING STRU
(

Prirt set in list box:

(=] Key plan

[ Define, modify prirt set... ]

Modffy status

(=] vstie
(] tidden

0 o
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5 Click Apply to save the current setting.

Tip: For other print sets, you 6 Select the next print set in the Print set in list box area and
can transfer the setting of an define which layers are to be visible and which hidden in this
already defined print set and print set (see table below).
then adapt it as appropriate.

Q General amangement drawing -

[ Key plan

m General arrangement drawin
[ Reinforcement, bottom \ayejk
[ Reinforcement, top layer

Layer
Select Layer/Vishility || Print Set || Privilege Set | | Format Definition | | Layer Structures
&= | L= Print set in list box:

Visibility in print set Short name Full name: (=] Reinforcement, bottom layer =
- 1 ARCHITECTURE

Visible Define, modify print set
Hidden

Select all (Ctrl=A)
Cancel selection (Shift=Ctrl+A)

DE_GENO7 Generald7

Match visibility from print set... L\?
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Category Layer Short Key General Reinforce- Reinforce-
name plan arrangement | ment at ment at top
drawing bottom
Draft General 01 DE_GENO1 v
General 02 DE_GENO02 4 v v
Surface Style area SU_STYL 4
elements
Text General text TX_GEN
Dimension line |Dimension line, | DL_GEN
general
Dimension line | DL_100 4
1:100
Architecture Wall AR_WALL 4
Column AR_COL 4
Slab AR_COL 4
Downstand beam | AR_BEAM 4
Shell Shell, general SH_GEN v v
Shell SH_SHELL v
Bar Bar reinforce- BR_B_B
reinforcement ment at bottom
Bar reinforce- BR_B_T v
ment at top
Mesh Mesh reinforce- |MR_M_B v
reinforcement ment at bottom
Mesh reinforce- |MR_M_T v
ment at top
Key plan Key plan, KP_GEN
general
Key plan KP_MARK

7 When you have assigned layers to all print sets, click Apply and

then OK.
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Palette Configuration

The Palette Configuration is set by default when you install for the
first time.

This configuration displays the Tools, Properties and Wizards
Library, Connect and Layers palettes on the left and the Filter
Assistant and Edit toolbar on the right.

If the Palette Configuration is not set, select it as follows:

To set the palette configuration

e On the View menu, point to Default Configurations and click
Palette Configuration.

Tools 1 x
Toals Properties | Wizards Library Connect Layers
[ JEngineering Lapel
Create @
I L T e O |
= B
3 im
g8 o <)
Change E]
LteBBRIS 2
TG EMEEX
& @ & G

Note:

You can customize the arrangement of the palettes for your needs by
selecting the Customize... tool on the Tools menu and opening the
Palettes tab. As an alternative, open the shortcut menu of a palette
and select Customize....



Engineering Tutorial

Appendix

You can use the first three palettes to access the families, the
modules and their tools, the properties of design entities and the

wizards.

When the Tools tab is open at the top, the following options are available:

Drop-down menu at the top

Tabs on the right

Available tools

Select a family:

Tools

Select a module:

Select a tool in the Create and
Change areas:

Tools

[ JEngineering | -
k Basic

g’Bonus Tools

@Arch\ted:ure

MEngineenng

@ Engineering Views, Details
"} Energy

@Terrain

= Road details

\:lPresentation

£+ Frilo Structural Analyses
aTechnical Building Equipment
EProducts, Manufacturers

s

&I ERIOIHE[E] v

Change

&% 9 @@
g __Sa :l_? Ao
ME & & &
CANGINC I

[ JEngineering

Create

= dh o s
o B @ 1
2
= g8 &
Change

r
lé:a".’:u@mw
Mo X
¥ TG W

(o ﬂ:[:

g O
&H4DEReEELE v

|
2

L,

N

m

ar Rel

Tools 2 x
Tools |[Prop...| [Wiza...|[Library| [Can... | Layers|
[ JEngineering |' p
Create @
= ] Lo
ar ape E
o E=EEE0 8 2
= Av %
=]
3 & <
=5 =
=]
Change @]
09 @@
IS TG
M e & & &
CANGINC N
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When the Properties tab is open at the top, the following options are available:

Drop-down menu at the top

Tools at the top and bottom

Element properties

Select active elements

fn

5 Zoom in on selected
objects:

¥ Filter Step by Step
Match parameters
Load favorite

E])'% Save as a favorite

Properties 1 x

Properties 7 x

Tools || Prop... ||Wiza.. ||Library || Con... || Layers

- QY

All selected (38)

All selected (36) I,\\,
Line (17)
Text (19) [
Line color () 1
Layer ¥ DEFAULT
Pen from layer E
Line from layer #,_3
Color from layer {,
Construction Line .0
Sequence % *varied*
Group Number [] *variea*
~ Geometry

Start point X *varied*
Start point¥  *varied*
Angle *varied*
~ Document
Document

PG -

Tools || Prop.. | Wiza...| | Library || Con... ||Layers

All selected [36) - & Y
+ Format
Penthickness & *varied*
Line type &% 1

Linecolor ) 1 I
Layer £2 DEFAULT
Pen from layer E
Line from layer =
Color from layer

Construction Line

EHETEOU

Sequence *varied*
Group Mumber [ *varied*
- Geometry

start point X *varied®
Start point ¥ *varied*
Angle *varied*
= Document
Document

== -

Modify properties (also possible
for some reinforcement
elements)

Properties 2 x

Tools || Prop.. | Wiza..||Library || Con... || Layers

All selected (36) - R Y
~ Format
Pen thickness 050 ———— |~
Line type =2 .25 1
Line color () 1035 2
Layer £2 [0.50 3
Pen from layer E p.70 4 I/\\»

Line from layer 2% .00 5
Color from layer S [140 em—G
Construction Line [ P13 7

Sequence % pis 8
= 1200 9
Group Mumber % 250 10
Geomet '
T Geom "'St ety P13 1
artpeintX g g 12
Start point ¥ |, 5c 13
Angle |, 35 14
+ Document f.50 15
Document
Pen thickness
Define pen thickness
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When the Wizards tab is open at the top, the following options are available:

Drop-down menu at the top Tabs on the right Available tools

Select a wizard group Select a wizard Select a tool
Wizards 1 x Wizards B x Wizards 1 x
| Tools |'Pmp...'||.lear....||'Libraqr'| |'Cnn.‘. | |'I.a|rer;'| | Toals |'Pmp...'||.WiZar---.||Lmraw'\|'Con... | |'L.a1re:s| | Tools \'Pmp.” ||.WiZEr---||'Lmraw'| |'Can... 'H'Layers]
Allplan | = Allplan | = Allplan_ENG ‘
1 /T 71
24 dlap, E sl b 8 E
- p} - 5 5
5 5 5
— 5 g g
. PR R E E E
o a a
E E E
g g e £
—— e g c -1 E———— £
= =3 =3
e e oo lﬁ ﬁ ﬁ
w wn w
E E E
o o %
— : : Bl
M - 2 5 | 2
s Yoot ol @ P I o | i @ & @
= £ £ £
2 2 Calurin 2
s wp ¥ | ° @ i C
w @
3 z [ @ g g
ok Ao P E 2 F Ol 3
S . 2 A o | 3
= 5 5
] E £
o = @ ]
Amzs n § ._a"sh _g, = =
amaizs 1B ; ?-@.\}_ _r[l}: fﬂ}: Jﬂ};
2 2 2
& - & - & -
X . X L e x L
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The Library palette takes you directly to the Symbols, Smart
symbols and SmartParts library folders. You can select the objects
you want to use. You can also add your own objects to the
corresponding library folders.

Library 1 x

Tools ||Properties| | Wizards | Library | Connect || Layers

4= Library b Symbols » Default &

, [ Artist

Details and standards

: | Exterior

[ Interior

O

Hall construction

Persons

Symbols and pictograms

ooooOo

Unfinished structure
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The Connect palette takes you straight from Allplan to content
provided by Allplan Connect. You can enter the user name and
password directly in the palette or on the Palettes tab of the
Customize... tool on the Tools menu.

Connect 1 x

Tools Properties || Wizards Library Connect Layers

"

Registration ]

Username or email

Password

m

Login
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Using the Layers palette, you can access the layer structure quickly
and easily. The entire layer hierarchy is displayed. You can define
the visibility and status of layers, select the current layer as well as

choose privilege sets and print sets.

O] RO_ROOM
O[] RO_VERSU

¥ Plan del

Room
Vertical surface

Layers I x
Toaols Properties | | Wizards Library Connec Layers
2= @B %)L
Status Short name Full name Format

U@ DEFAULT DEFAULT

* Design
[JO[] DE_GEMOL General0l
[JO[] DE_GEMOZ Generald2 —_—
[1[J[] DE_CUNE Construction lines

¥ Dimension line
] pLioo Dimension line 1:100 ———

¥ Architecture
OO AR waLL wall  —
O] ar_coL Column —_—
CIOC] AR_SLARE Slab  —
O] AR_SMsy Smart window, doo... —————
OO AR_ROOF Roof
O] AR_ROOFC Roof covering e
IO AR_STAIR Stair _
IO AR_LABEL Label _
O] AR_SILLE Sill elevations e

¥ Room
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Training Projects on the Internet

Allplan Connect offers two versions of the same project:

Allplan 2014: Project data for the Engineering Tutorial
(without the model). Thisproject comes with a fileset structure
and assigned drawing files. The project provides four print sets
that control the visibility of different layers. While editing the
project, you will use the different print sets in various places.
You can use this project if you want to start with Unit 1: Basics
and work through the entire Engineering Tutorial.

Allplan 2014: Project data for the Engineering Tutorial (with
the model). This project includes all drawing files with the
complete design as well as drawing files at different levels of
completion so that you can get started wherever you want. For
example, you can immediately start placing the reinforcement.
You can fall back on this project if you do not want to work
through the entire tutorial. The Engineering Tutorial (with
model) project is useful if you want to compare your results with
the finished model.

Downloading the training project

You can download the training data for this tutorial from Allplan
Connect, the international service portal for all Allplan users.

Go to
connect.allplan.com

Use your customer number and email address to register.
Registration is free and not subject to any conditions.

The whole process only takes a few minutes.

In Allplan Connect, you can find the training data for this
tutorial in the Learn - Documents area.

You can find two versions of the project:

Allplan 2014: Project data for the Engineering Tutorial
(without the model). This project includes the fileset structure
and the assigned drawing files with names so that you can
immediately start working.

Allplan 2014: Project data for the Engineering Tutorial
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(including the model). This project contains all the drawing files
at different levels of completion so that you can get started
wherever you want. For example, you do not need to generate
the general arrangement drawing first. Just open the
corresponding drawing file and start creating reinforcement.

e In addition to the training data, you can find the latest version of
this document as a PDF file (Allplan 2014 Tutorial:
Engineering).

e Save the zipped training data in any folder on your computer.

e Extract all the data into any folder, C:\Training data for Allplan
Engineering Tutorial, for example.

Note: Serviceplus customers have access to a variety of step-by-step
guides in the Learn area of Allplan Connect. It usually takes one to
two working days until you can access this restricted area and
download these documents. Please note that this service is available
to Serviceplus customers only.

For general information on Serviceplus, go to
http://www.nemetschek-allplan.de/serviceplus
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A component parameters
column 47
access rights 291 downstand beam, upstand
additional carpet reinforcement beam 50
242 opening 52
additional reinforcement (bar save as favorites 69
reinforcement) 221 slab 68
align wall 28
bar reinforcement placed 139 copy

associative section without
height being delimited 125
associative views 122
attributes
assign attribute values 257
for projects 257
Attributes
match attributes 17

B

BAMTEC 232
basic carpet reinforcement
241
carpet outline 235
enter mounting strips 239
place additional reinforcement
242
placing symbols 245
separate into files 239
bar reinforcement 134
bar shape entry 192, 196, 199
open stirrup 145, 155
stirrup 161
basic carpet reinforcement 241
bending schedule 188
box 87

C

carpet mounting strips 239

checklist 19

column 47

common approaches in
ProjectPilot 283

component axis 31

reinforcing bars placed 144
create BAMTEC file 245
cross-section catalogs 248
cutting diagram 228

D

define reference point, overview
59
door 52
downstand beam 50
drawing file
general 286
status 287
drawing file status 287
drawing file structure 300

E

edge reinforcement
meshes 225
reinforcing bars 218
engineering toolbar 120
Extension
single-tier 32

F

favorites
save 69
fileset
create, new 301
folded 125
full schema 184

H
height
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absolute heights 28
enter parameters 28
help 3
hidden edges 45
hidden line image 45, 59
hidden reinforcement 172

K

key plan 103
modify 110

L

label 270

label bar reinforcement placed
176

label style
create 259

layers 289
access rights 291
advantages 293
assignments 65
Attributes 290
Format Properties 290
general 289
in drawing files 294
line attributes 17
manage 293
pen, line, color 17
print sets 305
select current layer 49
set to visible, frozen 63
settings 17
Troubleshooting 64
visibility 292

layout
definition 266
elements 270
layout window 276
print set 270
printing 273

Layout
print set 305

line attributes for layers 17

line for layer 17

linear placement
along leg 196
along placing line 192

M

mesh reinforcement 213
model
reinforcing with 3D model
(method 1) 121
reinforcing with 3D model
(method 2) 189
reinforcing without 3D model
(method 3) 212
modify mesh cross-section
catalog 248
modifying using palette
mark 208
placement 208
modules
3D modeling 86
associative views 122
BAMTEC 232
bar reinforcement 134
basic

walls, openings,
components 25
draft 75

key plan 103
mesh reinforcement 213

0

observer 125

offset polyline 76

open stirrup
enter manually 135
expanding mode 145

opening
enter 52
output
layout 265
symbols 206
P

palette configuration 310
paste
symbols in catalog 203
Pen
for layer 17
pen thickness
pen for architectural surface
elements 26
place automatically 145, 155,
161
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place bar reinforcement

along leg 196

along placing line 192

automatically 145, 155, 161

hidden 172

in batch 168

manually 139

place in freehand mode 199
place excess mesh 225, 231
place in freehand mode 199
place reinforcement in batch 168
place reinforcement in span

place meshes in polygonal

area 216
place meshes in rectangular
area 214

reinforcing bars 149
place reinforcement in view 179
planar polygonal surface 88
polyline sweep solid 91
print preview 256
printing

layout 273

print set 270

requirements 256

priority 28
Project
create 296

download training project 317
path for settings 296
project attributes 257
Project Organization
tip 304
ProjectPilot
common approaches 283

R

read properties 164
reinforce
with 3D model (method 1)
121
with 3D model (method 2)
189
without 3D model (method 3)
212
reinforce recess 218
reinforcement drawing 115
reinforcement schedule

legend 188

sending to printer 186
reinforcement schema 183
reinforcing bars

modifying using palette 208

place in 3D 145, 155, 161

place in freehand mode 199

placing along leg 196

S

save
component parameters as
favorites 69
save view 46
section
create 130
reshape area 178
standard section 179
settings in the tools palette 12
shell drawing 21
slab 68
slab opening
polygonal 71
solid component 95
sources of information 3
training, coaching and project
support 5
spacer 226
stair 66
standard section 179
starter bars 155
stirrup
enter manually 192
expanding mode 161
support reinforcement
meshes 224
symbols
get from library 206
write to library 203

T

title block
as a label style 259
using label styles 270
toolbar
engineering 120
track tracing 16
training project provided with
Allplan DVD 8
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training projects on the Internet
317
troubleshooting 19

U

upstand beam 50
\'%

view 40
viewports 40

w

wall
offset direction 34
walls
three-dimensional 28
two-dimensional 76
window
three-dimensional 57
two-dimensional 81
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